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Foreword



I have been in publishing for almost 30 years, having held positions such as Publisher, Group Publisher, VP/Group Publisher, VP/Strategic Planning, and Senior VP/Research Publishing. Back then, I had staff to edit, design, and produce publications. But that all changed 10 years ago, when two friends and I started publishing international medical publications. In a small company, you and your partners do it all. Early on, we used Windows-based computers, but 6 - 7 years ago we made the move to Apple iMacs because of what we felt were superior graphics, reliability, and excellent tech support. Of course, one big question was, "What Desktop Publishing (DTP) software should we use?".
We first reviewed the well-known DTP software but felt they would be too complicated and costly to use. They were not intuitive enough, and as I was not a designer by trade, this was all new to me. So, we looked for alternatives and found that Apple's iWork Pages might do the trick. In researching this software, I learned of the author, Alexander Anichkin, who had been publishing successful full-color magazines and guides in Normandy using iWork Pages. When I saw what he was doing, I knew he was someone I had to contact. While he was in Europe and I was in the U.S., the Internet made all things possible, so I e-mailed him. I asked him all kinds of questions and he was very forthcoming. To say he was a big help to us would be an understatement. I credit Alexander with helping me make that leap to iWork Pages in a commercial environment in an extremely short time. Alexander gave me tips and how-to's, and when I had a question, he answered it. He not only saved me time, but in the end, money as well. In all fields there are experts, and in using iWork Pages, that expert is Alexander Anichkin. He knows every little secret, how to push the software to do things that other software costing thousands or more can do. And now, Alexander is sharing that expertise—all those little tricks—with readers of his new book.
I had the distinct pleasure of reviewing this book chapter-by-chapter as it was being written. I found that even though I have been using Pages professionally for a number of years, I was still learning something from this book. I would review a chapter, and often would write this comment to the book editor: "I just learned something I didn't know."
I like the way Alexander creates recipes in his teaching. His technique allows the reader to easily understand, learn, and remember. It is easy to refer back in his step-by-step approach. I found I was going back to the book again and again by using it as a reference and putting what I learned into play.
If you are a small business, an association, an individual designer, or even an agency that needs to create collateral material, newsletters, sales brochures, manuals, or forms, or if you are a small-to-medium publishing company with limited resources and manpower that creates directories, newsletters, magazines, books, guides, newspapers, or marketing material, or even if you are an individual who wants to develop or learn DTP skills, there is no question—you need this book. Like me, you will find Alexander's expertise will save you money and time and will help you polish your DTP skills. If you want a shortcut for your learning curve or even to find out how to get more from Pages, I unequivocally recommend Alexander's book. In my opinion, Alexander is "The Expert" when it comes to using iWork Pages—period!
I think the book flows well and covers all necessary parts in a logical progression. It is visually appealing as well, which further helps the learning process. This book is useful for novice and expert alike. Alexander constantly gives examples and walks you through in a "how-to-do-it" fashion. I give him top marks all the way around. You may not be able to eat the "food" from the recipe book, but you will surely be able to "cook."
Personally, I can't wait for his second book!

Richard Koulbanis
Partner, Group Publisher, and Editor-in-Chief
Congenital Cardiology Today
Neonatology Today
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Preface



I first bought iWork when I launched a glossy magazine for English speakers in Normandy, France, back in 2006. We were working on a shoestring, and the idea was to upgrade to a fancy creative suite as soon as the publication started making money.
Well, the magazine looked great and was a huge success, but I never did replace iWork—I didn't need to! Once I started exploring the creative possibilities of Pages, iWork's graphic and page layout program, as well as the spreadsheet application Numbers and the popular presentation maker Keynote, I discovered iWork could do everything the more expensive design software options offer.
I started jotting down the design tricks and technical solutions I discovered, and when these notes became too numerous to keep track of, I turned them into a blog, I Work in Pages. Soon, I was sharing tips with Mac users all over the world, and eventually I was approached to expand the blog into this book.
It's not a manual. In fact, I don't even think of it as technical. I prefer to call it a "Renaissance exercise". It is for those who, like myself, enjoy discovering that it is possible to do what may have seemed impossible only yesterday—or even a few minutes ago. Just like the great men of the Renaissance did.
Above all, this book concentrates on the design and production of print publications and on using graphic tools in iWork to create sophisticated images. I mostly cover Pages, but the main tools, menus, and techniques are the same for the other two programs in the suite. If you are interested in keeping your quality high but your costs low, this book shows you how.
What this book covers




Chapter 1, Lateral Thinking, discusses the approach to using iWork. In the first recipe, What to do when color options disappear, we will learn how the hardly noticeable button at the top of a document can save us from a moment of panic. In the second recipe, Copying and pasting from Numbers to Pages, we will explore how iWork applications work together, so that you can pick and mix to find the best creative solutions. The third recipe, Stacking photos by using the Bring to Front and Send to Back options to layer photos, shows how images can be layered and that graphic design is easy and accessible to all iWork users. In the fourth recipe, Using Command + F to search long documents when editing, you will discover that the Find function that you may only have used for checking text has a much wider use, and not only within iWork, but also right across your Mac and on the Internet too.
What links the recipes in this chapter is the approach. You will see that trying a few advanced tricks in iWork opens up the creative possibilities that you may not have been aware of.

Chapter 2, Working with Text, gives ideas on how to make your text look more attractive. It includes tips on when to use which tools or menus to change the appearance of text. We will also look at more sophisticated tricks, such as fitting more text on a page than it seems it can hold or making your document appear to have more text than it really does. You will find recipes on creating strong graphic elements for your text, including smudged highlights and drop caps.

Chapter 3, Working Across Platforms and Applications, addresses the compatibility issue. The recipes in this chapter show how Word, Excel, and PowerPoint documents can be imported easily to their corresponding iWork applications—Pages, Numbers, and Keynote—by using a simple drag-and-drop operation. We can do this straightaway from the Internet or through the Share option in iWork.
The Making a good PDF from an iWork document, and CMYK PDFs for professional printing recipe in this chapter gives tips on working with professional print shops.

Chapter 4, Where to Find Shortcuts and How to Remember Them, describes where to find shortcuts and how to train yourself to use them without thinking. Shortcuts offer a quicker and more efficient way of working. We will also look at iWork-specific shortcuts, and why Undo and Redo are probably the two most important of all.

Chapter 5, Working with Photos: Tips and Tricks, covers basics, such as resizing and cropping a photo, and also introduces a more advanced way of using photos, for example, removing and changing backgrounds and making cutouts. Inserting a photo into a document is only the first step towards discovering the numerous inventive ways in which you can use pictures and images in iWork. You will learn how to use masking and Instant Alpha in design and how to use patches to improve the photos in your documents.

Chapter 6, Graphic Design—Working with Clip Art and Making Your Own, discusses where to find clip art on your Mac and how easily you can make your own clip art. Recipes in this chapter show how to make your own photos into clip art. Following a few simple steps, you will learn how to put photos inside letters and customize different shapes to create unique clip art for your own projects—for example, turning a quote bubble into a thought bubble.

Chapter 7, Graphic Design: Making Your Own Logo, shows how to create your own unique logo by using shapes and letters. The recipes in this chapter cover procedures for editing shapes and manipulating widely available fonts to create your own, personalized set of fonts. Using the draw tool, you can create a human shape or a picture of a dog and an advanced technique allows you to trace a photo or a picture to create your own original image to use in a logo.

Chapter 8, PDFs and Professional Printing, offers tips and solutions for meeting the requirements of professional print shops. Mastering PDF production is an essential element in using iWork for professional print purposes. In this chapter, you will see how to make your iWork document into a press-ready PDF, with your settings, and how to deal with situations where you don't have sufficient software or technical knowledge.

Chapter 9, Planning Large, Long-term Projects, describes how to use iWork for creating promotional literature and serious publishing projects beyond the scope of what we normally expect to accomplish with a personal computer. With iWork, we can create beautiful brochures and logos and produce books. In this chapter, we will discuss the basic operations that are necessary to accomplish your dream projects, working with and modifying templates, designing eye-catching titles, and planning and preparing a book.

Chapter 10, Designing from Scratch: Beyond Templates, explains how templates included with iWork provide instant design solutions. Nevertheless, no template can fit all our requirements, and there comes a point when we want to create our own distinct style and a design tailored specifically for our project. In addition to basic layout principles, this chapter describes design techniques that you will need when you are prepared to go beyond the templates. These techniques include editing shapes and lines, using flowing colors, creating your own original brand colors, and storing and classifying them.

Chapter 11, Mastering Numbers: Tips, Techniques, and Fun, gives tips on how to spruce up your spreadsheets. Even if you are unfamiliar with spreadsheets, you will see that Numbers is not only easy to use, but also that it is handy—and fun—for many practical tasks that have little or nothing to do with calculations. In the last recipe, Using clip art and photos in charts—the unbeatable visual effect of Numbers documents, you will see how to add photos to pie charts and incorporate clip-art human figures into sophisticated diagrams.

Chapter 12, Keynote Uncovered: a Few Techniques, covers the basics, such as adding text to Keynote slides and placing and editing photos. Keynote is a much-loved application for its striking graphics and animation effects. We will also look at how adding audio files to slideshows and making QuickTime movies from Keynote slideshows improve your efficiency when working in other iWork applications.
The Free Download Chapter, Building a Team and Working from Different Localities, covers issues arising from working in today's virtual environment, where we have spread our workload across geographical boundaries. The recipes in this chapter cover sharing, sending out, uploading, and publishing iWork documents, as part of a team. This chapter gives recipes on how to organize teamwork, particularly with editors and designers. You can download this chapter at http://www.packtpub.com/sites/default/files/downloads/Building a Team and Working from Different Localities.pdf.


What you need for this book



You need an Apple Macintosh computer with the current OS X (version 10.6.6 or later) and the iWork suite. Apple now sells iWork applications—Pages, Numbers, and Keynote—as standalone products.

Who this book is for



This book is for confident iWork users, small businesses, publishing ventures both local and community, and students.

Conventions



In this book, you will find a number of styles of text that distinguish between different kinds of information. Here are some examples of these styles, and an explanation of their meaning.
Code words in text are shown as follows: "A copy of your document will appear on your desktop in the .doc format."

New terms and important words are shown in bold. Words that you see on the screen, in menus or dialog boxes for example, appear in the text like this: "CMYK
Sliders gives you precise control over the colors in your document when printing in four-color mode—Cyan, Magenta, Yellow, and Black (K for Key)."
Note
Warnings or important notes appear in a box like this.

Tip
Tips and tricks appear like this.


Reader feedback



Feedback from our readers is always welcome. Let us know what you think about this book—what you liked or may have disliked. Reader feedback is important for us to develop titles that you really get the most out of.
To send us general feedback, simply send an e-mail to <feedback@packtpub.com>, and mention the book title via the subject of your message.
If there is a book that you need and would like to see us publish, please send us a note in the SUGGEST A TITLE form on www.packtpub.com or e-mail <suggest@packtpub.com>.
If there is a topic that you have expertise in and you are interested in either writing or contributing to a book, see our author guide on www.packtpub.com/authors.

Customer support



Now that you are the proud owner of a Packt book, we have a number of things to help you to get the most from your purchase.
Errata



Although we have taken every care to ensure the accuracy of our content, mistakes do happen. If you find a mistake in one of our books—maybe a mistake in the text or the code—we would be grateful if you would report this to us. By doing so, you can save other readers from frustration and help us improve subsequent versions of this book. If you find any errata, please report them by visiting http://www.packtpub.com/support, selecting your book, clicking on the errata
submission
form link, and entering the details of your errata. Once your errata are verified, your submission will be accepted and the errata will be uploaded on our website, or added to any list of existing errata, under the Errata section of that title. Any existing errata can be viewed by selecting your title from http://www.packtpub.com/support.

Piracy



Piracy of copyright material on the Internet is an ongoing problem across all media. At Packt, we take the protection of our copyright and licenses very seriously. If you come across any illegal copies of our works, in any form, on the Internet, please provide us with the location address or website name immediately so that we can pursue a remedy.
Please contact us at <copyright@packtpub.com> with a link to the suspected pirated material.
We appreciate your help in protecting our authors, and our ability to bring you valuable content.

Questions



You can contact us at <questions@packtpub.com> if you are having a problem with any aspect of the book, and we will do our best to address it.


Chapter 1. Lateral Thinking



In this chapter we will cover:
	What to do when color options disappear
	Copying and pasting from Numbers to Pages
	Stacking photos by using the Bring to Front and Send to Back options to layer photos
	Using Command + F to search long documents when editing


Introduction



It is all too easy, especially if you are following a traditional manual, to get what we can call application
tunnel
vision. You think Numbers are just for Spreadsheets, or Pages for writing, and the color options are only for professional designers. I want to show you that simply by changing this approach, by learning to think laterally across the full range of iWork applications, and by facing the obstacles from different or unusual angles, you will not only find solutions but will also discover the full potential of iWork and just how cleverly it can work for you.
The beauty of iWork is that it is intuitive—sometimes you may feel that it knows what you want to do before you know yourself and is already pointing to a solution.
The examples in the following sections are taken from across the iWork spectrum, from working with colors, spreadsheets, and photos, to editing text.
And remember, when you get stuck, don't panic!


What to do when color options disappear



Consider this case. The iWork Color Viewer has stopped displaying the icons that give a choice of various controls—color wheel, sliders, or the box of crayons. What do we do?
How to do it...



The solution is as follows:
	Click on the oblong button in the top-right corner of the Colors Viewer (Palette), it opens and closes the View options.[image: How to do it...]

	You will find the same oblong button in many other windows on your Mac. Click on it to display the tools and options available. Click again if you don't need to see them and just want to carry on with your work.
	Trying out iWork may be the first time you've encountered the Colors Viewer. What we should remember is that it is available for many other applications on our Mac, for example, in TextEdit and even Stickies. If you don't see it in the toolbar or can't find it in the menus, try the keyboard shortcut Command + Shift + C.[image: How to do it...]

	The crayon box at the top-right of the Colors Viewer gives a selection of preset colors with fancy names such as Licorice for black or Salmon for pink.
	To create a new color, click on the color wheel in the top left-hand corner and drag the little dot around.
	Click and hold in the rectangular color window (the color well) that now contains your new color, and drag the color down to the color palette at the bottom of the window to store it, if you intend to use it again.
	If you see a color or a color sequence that you like, for instance in one of the templates, store it in the palette to use it in your project.
	If you like a color in a photo, you can save it in the palette:	In the Colors window, click on the color picker that looks like the search tool—the little magnifying glass.
	Click on the color that catches your eye.
	To save, click in the color well and drag the color to the palette.



	If for some reason the palette disappears—this happened to me once—click on the little round handle at the bottom and drag it down. The palette will reopen.



There's more...



What are sliders for? Take for example the CMYK option. CMYK Sliders give you precise control over the colors in your document when printing in four-color mode—Cyan, Magenta, Yellow, and Black (K for Key).
[image: There's more...]
If you are preparing the document for commercial or professional printing, you can, for example, set the color of black text to true black.
To do so, set Cyan, Magenta, and Yellow to zero and Black to 100 percent.
The default black in Pages is a composite color that is a mix of different CMYK colors—it looks good on screen but in print it gets fuzzy. Changing the setting to 100 percent black gives your text crispness. Even if you are not going to print your project commercially, when you make PDFs from Pages, I suggest changing text to true black.
Note
When working in a team, swap CMYK readings of graphic elements in your project with colleagues, so that your colors match exactly.


See also



	The ProducingaCMYK-separatedPDFforaprofessionalprintshop recipe in Chapter 8, PDFsandProfessionalPrinting.




Copying and pasting from Numbers to Pages



In iWork, charts, graphs, and tables can be created in Numbers and Pages.
If you start using iWork with Pages and ignore the other two components of iWork—Keynote (presentations) and Numbers (spreadsheets)—just because you may not need them, it may not even occur to you that they work together, not separately.
[image: Copying and pasting from Numbers to Pages]
How to do it...



Charts can be created without leaving Pages.
	Click on the Charts icon in the toolbar and choose the type of chart you want.
	From Insert, in the top menu of the screen, choose Chart and the type of chart.



How it works



Charts come in either 2D or 3D styles. When you type in data, the chart updates its appearance automatically.
However, the templates and tools included in Numbers may make it easier to create your chart in Numbers and then copy and paste it into your Pages document.
You may only discover this when actually working on your project. In our magazine, there was a feature on local weather patterns. We had created a rather boring spreadsheet in Numbers. But when we added the chart and copied and pasted it into the magazine page—which was being laid out as a Pages document—and then resized and moved it into place, it looked great!
The current version, iWork '09, gives Charts in Pages practically the same tools that you find in Numbers, including the impressive choice of colors and textures. However, you may find it easier to open a Numbers document, create a chart, and then paste it into a Pages project. This way you can avoid clutter and have the advantage of using a more specialized toolbar.

There's more...



A chart created in Numbers and pasted into Pages stays linked to data entered while you were working in Numbers. To update the chart in Pages:
	Go back to Numbers.
	Edit data.
	Save the document.
	Go to Pages and click on the Refresh button. No need to copy and paste the updated chart again.


What is interesting here is that the graphic images created in Numbers files display the same high quality as Pages once they have been converted into press-quality PDFs.
The charts printed on glossy paper in our magazine, the Rendezvous, looked stunning, showcasing the wonderfully mild and stable Normandy climate.
Tip
When working in Numbers, remember about black text. Using 100 percent black instead of composite black Licorice (default text color in many iWork templates) comes out better in CMYK press-quality PDFs.



Stacking photos by using the Bring to Front and Send to Back options to layer photos



We can start learning to use a piece of software by reading through the User's Guide, watching tutorials, or even going on a course. Most of us, however, don't have the time, patience, or money to do so, and want to get going straight away.
Then, we get stuck when we want to try something new—we don't know how to do it or where to look for a solution.
[image: Stacking photos by using the Bring to Front and Send to Back options to layer photos]
For example, you may want to put an image on your photo to mark an occasion or to express support for a cause. If you haven't tried this before, it may look like a difficult task. But by breaking the process into small steps, you'll see that it is, in fact, quite simple—even if a multitude of tricks are involved.
How to do it...



To put a red poppy, the symbol of Remembrance in many countries, on your picture, follow these steps:
	Drop a photo of yourself into a Pages document.You can do this by opening the Media Browser in the toolbar and dragging the photo from there.  Click on the Photos tab and find your picture in iPhoto, or open iPhoto and drag the photo to the Pages document. If the photo is on the Desktop, drag it from there.

	Next, insert a photo of the red poppy.[image: How to do it...]

	In this photo, which was taken in a nearby field, there are many poppies. In order to leave just one, put a mask over the picture.The Mask option is under the Format menu. Alternatively, you can add Mask to the toolbar (View | Customize Toolbar), and when needed, just click on the Mask icon.

	Next, remove the green foliage around the flower with the Instant Alpha tool. Now, only the red poppy is visible. In Mac OS 10.7, the Alpha tool is also included in Preview. You can prepare the image there and then paste it into Pages.
	Resize and position the poppy over your photo, so that it looks the way you want it to.
	Take a screenshot, print to PDF or JPEG, and use this as a profile picture, avatar, favicon, for example.



There's more...



If you want the poppy to look like a badge or a pin, insert an Oval from the Shapes drop-down menu in the toolbar, or navigate to Insert | Shapes | Oval in the screen-top menu.
[image: There's more...]
Give the oval a contrasting color, white for example, and then resize it. Now, you can instinctively slide your oval under the poppy, but you will find that you can't do this. This is because, when you move the oval to your poppy, it will go over the poppy, because each new image we add to a document in iWork is stacked on top of the previous one. So, to make the white badge go under the poppy, you need to use the Send Backward function under the Arrange menu. Alternatively, select the poppy and choose Arrange | Bring to Front.
Here, we've stacked three images to create a new one. The same method can be used to make collages, mosaics, and jigsaw puzzles, and to create frames.
When you work with multiple-layered images, you can add all the four functions—Bring Forward or Bring to Front and Send Backward or Send to Back—to the toolbar. Click on the icon to move the image layer by layer.
[image: There's more...]
You can also use the keyboard shortcuts for these functions:
	Bring to Front: Command + Shift + F
	Bring Forward: Command + Option + Shift + F
	Send to Back: Command + Shift + B
	Send Backward: Command + Option + Shift + F[image: There's more...]



This way, you can move an image backwards or forwards without the distraction of looking at the menu—and you can watch it as it slides into position.


Using Command + F to search long documents when editing



The Find function is indispensable when working on large chunks of text.
How to do it...



Press Command and type F to open the Find window.
If you are not familiar with the term, the Command key is the wider one in the bottom row of the keyboard.
Then, type the word, word combination, or part of a word in the window, and presto! You can scan a very large text—hundreds of pages—in seconds, to find what you are looking for.
Take, for instance, a situation when you edit—or just read—a book and notice that a female character is described as having shiny auburn hair on page 187. You definitely remember that she was a redhead earlier in the text. But on what page?
Type redhead and click on Previous to find the relevant passage.
And there she is, a redhead, on page 23. Of course, sometimes people do change their hair color. But it's also true that even the best writers can sometimes forget how they described their characters, for example, in Tolstoy's War
and
Peace, Prince Andrei has grey eyes in one chapter and blue in another.
Click on Next to scan forward and see if the error appears further on in the text.
Or, you might notice that a name or a particular word is spelt in different ways. Is it a mistake? Should it be corrected? Do you need a cross-reference?
Take the word "kabuki", a form of traditional Japanese theatre. Is it "kabuki" or "cabuki" or "kobuki"? Check the word in the dictionary and then click on Find and Replace to scan the text and substitute the correct spelling throughout.
Or the word "czar", which originally means an East European absolutist monarch, but in modern political usage is also used to describe a specially created official position with authority to deal with a particular problem. The word can be spelled, correctly, "tzar" or "tsar"—reflecting the phonetics of the original Russian word—or even "czar", a spelling that incorporates the Roman-Byzantine etymology of Caesar.
Choose either the one you prefer or the most commonly used spelling, and correct throughout, by using Next or Find and Replace.
This will avoid inconsistencies in your text and will make indexing and referencing clear.

There's more...



The Find function works practically everywhere that we deal with text. Here are some examples.
Using Command + F for proofing



If you work with a particular style, the Find function can also help you here. For instance, you have a text where there is a double space after each full stop but your company's house style demands only a single space after each sentence. In such a case, follow the ensuing steps:
	Open the Find window, and type . (dot) and two spaces.
	In the Replace window, type . (dot) and one space.
	Then, click on Replace All and the job is almost done.


Finally, run the same task for sentences ending in exclamation (!) and question (?) marks to make sure you have picked up all your double spaces!

Using Command + F in other applications



In iWork, this function may be most useful in Pages. But remember that it also works in other text editors and many other applications. For instance, in the Dictionary, the article on the word "put" is very long, but you only want to check the meaning of "put up".
In such a case, type Command + F and type in put up to see all the meanings.

Using Command + F in internet browsers




Command + F works in most internet browsers. Many users just don't realize this. Suppose you searched for something in Google and found a long article on the subject.
To find the relevant passage in the article, press Command + F to open the search window (it's at the top in Safari and Chrome and at the bottom in Firefox), and then type what you are looking for.
The browser will give you the number of instances and guide you to the relevant word or phrase.
This function is also ideal for finding quotes in their context. If you have a quote or part of it, just copy and paste it into the Find window, and the computer will take you to the relevant passage. For example, to find out who said We
have
nothing
to
fear,
but
fear
itself, type it in the browser window and the Internet search will bring you a number of sites mentioning the quote. Go to the site that looks most trustworthy, press Command + F and type fear in the Search window. Then, click on arrows to go to the place where the original, slightly different quote by Franklin D. Roosevelt, The
only
thing
we
have
to
fear
is
fear
itself, is mentioned.



Chapter 2. Working with Text



In this chapter we will cover:
	Changing font (typeface) using toolbar, menus, and Font Panel—when to use which
	Blank paragraphs versus spaces after paragraphs
	Fitting more text on a page than it can hold
	Using tabs to stop text sticking to the edges of a colored background
	Creating smudged highlights for text
	Creating drop caps with the Custom Image bullets


Introduction



This chapter explores tricks and techniques with word processing and text formatting. Often, there are several ways to do the same job, so which do you choose? The User's Manual and Help pages will tell you what the applications can do, but not necessarily all their uses. The recipes here show easy ways to achieve some common text formatting tasks as well as unexpected solutions to add flair to your documents.


Changing font (typeface) using toolbar, menus, or Font Panel—when to use which



This recipe describes how to change the appearance of text in iWork. Some operations are basic, but there are some tricks that can make our life easier and more productive.
Getting ready



Fonts are stored in the application called Font
Book
. This is also the place to install new fonts.
The word font
 means a set of types of one particular face and size, while typeface
 means a particular design of type. They are used interchangeably, so don't be confused. In layman's 
terms, they mean the same thing—what our text looks like.

How to do it...



When we work with text, we can use menus, keyboard shortcuts, Font Panel, and Text Inspector. So, let's see what each of these can do for us.
Menus



There 
are three basic styles of text—regular, bold, and italic. Select (highlight) text, click on the Format menu, navigate to Font, and select one of these:
[image: Menus]
I would recommend using this menu when you begin to familiarize yourself with iWork. It shouldn't
 take long, because if you have used a Mac word processor before, you will already know these basic operations. If you are switching from Windows, the only major difference is that the Command key takes the place of the Ctrl key.
As Mac users like to point out, "Where Windows users are under Control, Mac users are in Command".

Shortcuts



The next natural step is to use shortcuts instead of menus:
	Bold: Command + B
	Italic: Command + I
	Underline: Command + UTip
If you touch-type, use your thumbs to press the Command key and then type B, I, or U.




Usually, we style text after typing. Select text and then change its appearance. But if we know beforehand how a particular part of text should be styled, we can do it as we type. For example, when using italic style for book or movie titles, or names of newspapers and magazines, we can press Command + I before the beginning of the text and then use the same shortcut after the styled text to switch back to regular.

Toolbar



The main 
iWork menu is at the top of the screen. At the top of each document, you will see the toolbar, and underneath it, the format bar.
The bold, italic, and underline functions are in the middle of the format bar. Select text and click on an icon to change style. Click on that icon again to undo.
The format bar offers a quick way to change the look of the text in a document.
Click on the Font Family tab (it displays the name of the font that is currently in use) to choose from a variety of fonts. All fonts are sorted alphabetically. The separate small group above the thin grey line shows the ones that you have used recently, and the full list is below that grey line.
Some popular
 font families, for example Helvetica Neue and Myriad Pro, have more typeface variations than just regular, bold, and italic. There may be variations such as light, ultralight, condensed, and black. This offers a greater design advantage for more sophisticated projects, such as brochures, magazines, and posters. To choose a style, click on the Typeface tab to the right of the Font tab and choose a typeface from the drop-down menu.
Tip
You can hide/show the toolbar and format bar via the View menu.


Font Panel



The Font Panel
 or Font Window is the real control center for doing anything with fonts and typefaces in a document. To open it, you can choose from the following options:
	Navigating to Format | Font | Show Fonts
	Clicking on Fonts in the toolbar
	Using the shortcut key Command + T[image: Font Panel]



The shortcut is easy to remember if you think of T as representing Text.
The Font Panel shows not only the available fonts, but also additional features and productivity tools, such as multiple underlines and strikethroughs, controls for the color of underlines, and the use of font collections.
To give a 
portion of the text a double underline, select a passage, click on the first icon, and select Double.
To give a color to the underline, select a passage, click on the first icon, select Color, and when the Colors window opens, choose the color you want.
On the left of the Fonts Panel, you will find the Collections window that shows the various font families. The Collections window has more uses than just to show us what fonts are available:
	If you are still just preparing for a new project, follow these steps:	Open the Fonts Panel.
	Click on All Fonts, and by moving the slider button up and down, find the font that you'd like to use in your project.
	Click on the picture of the action wheel at the bottom of the panel, and in the drop-down menu, choose Add to Favorites.



	If you have already decided which fonts to use in your project and want to have them handy, follow these steps:	Click on Favorites in the Font Panel.
	In your text, click on a word typed in the font that you want to use throughout the project.
	Then click on the action wheel and choose Add to Favorites. The font will appear in the Favorites folder.


[image: Font Panel]





There's more...



Special characters, such as technical symbols, arrows, mathematical signs, non-Latin scripts, and musical and zodiac signs are stored in the Character palette. From the screen-top menu, navigate to Edit | Special Characters, to open the palette.
You can also open it through the Fonts Panel. Click on the action wheel at the bottom and choose Characters. If you often need special characters, navigate to System Preferences | International | Input Menu and check Character Palette. It will become available from the screen-top menu, in the top-right corner.


Blank paragraphs versus spaces after paragraphs



A paragraph
 is a distinct section of text, usually dealing with a single idea and indicated by a new line, indentation, or numbering. An indentation
 is an empty space between the left margin and the beginning of the text, usually one tab space.
These days, it has 
become more common to begin paragraphs without the indentation and to separate paragraphs by a blank paragraph or two carriage returns—on our keyboards, we just hit the Enter key twice.
However, we don't really need to do this—there are other more efficient ways of separating paragraphs.
How to do it...



Open an iWork Pages document and then open the Text Inspector. Click on Inspector in the toolbar or press Command + Option + I
.
In Spacing, click in the After Paragraph window and type a size in points (points
 are the traditional typographical measure of the size of letters and other typography signs, 0.351 mm in the US and Britain and 0.376 mm in Europe). Alternatively, use the up and down arrows next to the window to increase or decrease the spacing.
If you use a 12-point font and set the After Paragraph size at 12, the space between paragraphs will be roughly equal to one line of text—and you won't need to remember to type blank paragraphs.
Once you've set the space between the first two paragraphs, subsequent paragraphs will have the same spacing.
When starting a new section or chapter in the document, we can increase the paragraph spacing manually. Click on the arrows or type in a new size. Likewise, when signing a letter or a memo, instead of putting in a blank paragraph, increase the spacing.
This may seem 
like more work than just hitting the Return key twice, but take for example a situation when you want to fit the contents of your document, a resume or a letter, onto a single page without leaving a small overflow—sometimes just your signature—on the next page. That's when spacing is invaluable, as you can set it at, say, 11 or 10 instead of 12, until your text fits.
It's easy to train yourself to use paragraph spacing instead of typing blank paragraphs. Apart from giving us more flexibility with formatting the text, it also saves time—we don't have to think about adding blank paragraphs.

There's more...



Indented paragraphs still look attractive in long articles and books. When we want indented paragraphs, we can set the indentation via Text Inspector.
[image: There's more...]
Click on 

Tabs, and in the First Line window, click on the arrows, or click in the window and type an indentation size. A 16- to 17-point indent roughly equals five spaces and it is the paragraph indent used in many typographical styles.
There are several measurement options—inches, centimeters, picas, and points. If you are unfamiliar with the default unit, change it to the one with which you feel more at ease. Under the Pages menu, open Preferences, click on Rulers, and then choose your preferred unit from the drop-down menu.
We can also set left and right indentation for the whole of the paragraph, not just the first line. This can be useful for making a quotation, a fact-sheet, a list of instructions, or a piece of poetry, stand out from the main body of text.
Here is how the nursery rhyme For Want Of A Nail would look with indented lines—to help indicate the rhythm:
[image: There's more...]


Fitting more text on a page than it can hold



Every so often, the 
text just refuses to fit on a page. There is not enough room for everything we want to say in a one-page letter, or our work experience is just too long for a one-page resume.
How to do it...



Let's assume we have a finished text—such as a letter, a resume, or a small advertisement—that we have to fit in an allocated space, say a page or a text box.
Letter or resume



Let's see if reducing the font size helps in letters

 and resumes:
	Select all text (the shortcut key is Command + A).
	Press Command and type - (minus). This reduces the size of all selected text by one point.


The next method is navigating to the Text Inspector and reducing the spacing between paragraphs:
[image: Letter or resume]
If you've used blank 


paragraphs (hitting the Return key twice) to separate the paragraphs in the text, remove them and navigate to Spacing | After paragraph, to set a shorter break between paragraphs. Select the entire text and use a slider to increase or decrease the spacing, or set a size by clicking in the window and typing a size. For example, if you use a 10-point font, set the After Paragraph space at 10 points—it will be roughly equal to one line of text. Then, reduce this spacing until your text fits onto the page.
If only a few lines of your text overflow on the next page, this usually does the trick.
Or finally, try this. Select all text and reduce the line spacing, using the Line slider. This will also make the text 


shrink. Don't overdo this, however, otherwise your text will look cramped.

Small advertisement



When we design a small advertisement the 
space is very constrained. We cannot make the font too small, otherwise it will be difficult to read.
[image: Small advertisement]
In this real estate advertisement, with dimensions 1.83 inches x 1.89 inches (4.66 cm x 4.8 cm), I've used the Spacing features available in the Text Inspector:
	Using the Character slider, reduce the character spacing to -2%, which makes the second paragraph fit onto two lines instead of three.
	Using the Line slider, reduce the line spacing to 0.9 lines instead of 1 line, which allows both landline and cell phone numbers to fit in the box.


With these tricks, I managed to add 11 words that didn't originally fit in the box.


There's more...



When fitting 


text into a text box or a shape, remember the Inset Margin—the space between the text and the margins of a shape. Reducing the Inset Margin value also allows more text inside.
Reducing the character spacing by using the Character slider is a useful feature for fitting headings and captions on one line. Again, don't overdo it.
And of course, remember about editing—weed out unnecessary words and phrases, leave only what is essential.
Use the same tricks in reverse—increase spacing between characters, lines, and paragraphs to beef up a heading or make it look as though there is more text on the page than there really is!


Using tabs to stop text sticking to the edges of a colored background



In MS Word and Open Office Writer, there is a highlight feature in the toolbar. In iWork Pages, the same effect is achieved via the Text Inspector. Look under the More tab for the Background Fills options, Character and Paragraph.
In this recipe, 
we will look at how to highlight the text and also what to do when text sticks to the border of the colored highlight, making it look untidy.
How to do it...



Open the Text Inspector (Command + Option + I) and click on the T icon to open the Text window. This is where most text formatting operations are carried out.
Highlighting in iWork is done in the same way as changing the color of your text. Click on the color well and choose or create a color in the Colors window. In this case, however, we are adding a background color rather than coloring the text itself.
[image: How to do it...]
Follow the these steps:
	In Text Inspector, click on the More tab.
	Select the text you want to highlight and tick the Character checkbox under the Background Fills section.
	Click on the Color Well tab, and when the Colors window opens, choose a color.


Highlighting or color backgrounds can also be added via the format bar. Select text and click on the rectangle with the small letter "a", then choose a color from the Colors window.
[image: How to do it...]
The Background Fills options offer a choice of Character and Paragraph fills. In fact, when the Character fill is employed, you can select any part in the body of text—words, parts of words, sentences, and even spaces. When the background is added to the paragraph (Paragraph fill), the color band goes across the whole page, to the edge of your layout margins.
Doing this sounds
 nice and easy, but there is a small problem. The text may stick to the edges of the background color. We can leave it as it is, or we can try to improve the look by finding a way of pushing the text inside the color band.
When you use paragraph highlighting, click on Tabs in Text Inspector and increase the First
Line indent by several points, fractions of an inch, or a centimeter. In the following example, the nursery rhyme A
Star, the heading is highlighted by using the paragraph fill. The second heading is indented by four points and looks better inside the colored background.
[image: How to do it...]
Tip
If you don't want the colored background to go across the whole page, put the highlighted body of text into a Text Box. The color band will stay inside the box. The nursery rhyme here is in a Text Box.

When you use character highlighting, simply type one or two spaces just before and immediately after the highlighted text. In the following example, with the nursery rhyme Birds
Of
A
Feather, the second heading has one space before and after the text. In both headings, character fill is used.
[image: How to do it...]

There's more...



Highlighting can be 
applied not only to headings, but also to words or phrases within a body of text. Remember that contrasting colors should be used for highlighting—dark text on a light background and lighter text on a dark background.
Tip
If you want the background color to extend above and below the highlighted paragraph, increase the spacing before and after the paragraph. Spacing options are under the Text tab in Text Inspector.
If you find it annoying when you have to switch from one Inspector to another to perform different types of operations, remember that you can have more than one Inspector windows open at the same time. Under the View menu, choose New Inspector, and set, say one for Text and another for Graphic.



Creating smudged highlights for text



Let's see how 
highlights for text, which look like the smudged strokes of a felt-tip marker or a paintbrush, can be created in a few simple steps.
Getting ready



Simple highlighting in iWork is not included in the toolbar as a separate option like in MS Word or Open Office. You may have noticed that Apple generally avoids bloating—putting too many features in toolbars and menus. To use simple highlighting, go to Text Inspector, click on the More tab, and use Background Fills for Character or the whole Paragraph.
To highlight a character, word, or phrase, check the respective checkbox and click on the Color tab to open the Colors window. From there, choose a color with which to highlight the text.

How to do it...



Let's try something more exciting. Here's how to change a simple line or a rectangular shape into a colored smudged highlight for text.
Creating a highlight with a line



To create a
 highlight with a line, follow the next steps:
	Insert the shape—a line—from the Shapes drop-down menu in the toolbar. By default, the line is 2 points thick, the kind of thickness that may be required for column dividers or for separating images or text boxes.
	Switch to the Graphic Inspector and increase the thickness to about 2 points more than the font size of the text to be highlighted. If you use an 11-point font, set the thickness of the line to 13.[image: Creating a highlight with a line]

	Click on the styles tab under Stroke | Line, and choose a style from the drop-down menu, as shown in the following screenshot. Try different ones to see which style suits your project better.[image: Creating a highlight with a line]

	Click on the Color tab and choose a color from the Colors window.
	Switch to the Wrap Inspector (shown in the following screenshot). Select In background and check the Background objects are selectable checkbox. These settings will make the shape go behind the text, but you will still be able to select it for moving and modifying.[image: Creating a highlight with a line]

	Drag the smudged highlight line behind the text that you want highlighted. Drag to extend and cover the entire text lengthwise. If needed, add thickness in the Graphic Inspector.
	Here is how the result might look with the nursery rhyme Robin-A-Bobbin. The heading is set to 28 points and the highlight is set to 50 points.[image: Creating a highlight with a line]
Tip
Remember to 
use contrasting colors. For black text, use pale colors. If you choose a dark, intense color for the highlight, change text to white or another light color.





Creating a highlight with a rectangle



To create a 
highlight with a rectangle, follow the ensuing steps:
	Insert a shape—Rectangle. By default, the starting shape for a rectangle is a square, with a solid color fill and a 1-point black frame (Stroke).
	Drag the shape to the part of the text you want to highlight and resize to cover the text.
	Click on the Graphic Inspector. Choose color in the Color fill. Click in the color well to open the Colors window and click on a color in the crayon box or create a color by moving the sliders. In this example, the color is Lemon from the crayon box.
	Then, click on the bar under Stroke to open a drop-down menu, choose Line and click on the line styles tab below it to choose from a number of outlines (frames) to give the shape a smudged look—as though it's a stroke of a painter's brush. Click on the color bar next to the style chooser and select a color. The outside frame color should be darker than the color fill. In my example, it is Cantaloupe.
	Adjust the thickness of the smudged outline to create your desired effect by clicking on the arrows or setting the value in the Thickness window.
	As an option, add shadow to give a stronger contrasting effect to the new shape.
	Switch to the Wrap Inspector. Select In background and check the Background objects are selectable checkbox. These settings will make the shape go behind the text, but you will still be able to select it for moving and modifying.
	Drag the smudged highlight line behind the text that you want to highlight. Drag to extend and cover the entire text lengthwise. If desired, add thickness to the frame.
	Here is what the result looks like, with the nursery rhyme Three Blind Mice having the heading highlighted (shown in the following screenshot):[image: Creating a highlight with a rectangle]





There's more...



Try these additional features:
	Flip the highlight horizontally if you want to change the direction in which the thickness of the smudge recedes. In the Metrics Inspector, click on the Flip arrows in the bottom right corner.[image: There's more...]

	To curve the smudged line, select the shape, then go to Format | Shape | MakeEditable, and after that, navigate to Format | Shape | SmoothPath. The shape will show red editing points. When you click on one, it shows propellers—editing handles. Drag and rotate them to give the shape curving contours.


These highlights have more to do with graphic design than with text formatting. Their great advantage over simple highlights is not just the striking effect, but also their flexibility. We can store them separately to re-use and create our own unique styles. They can be used for branding and creating business logos.
However, compared to simple highlights, one disadvantage of using shapes is that they won't move with the text when you edit it.
But there is a way to work around this:
	Put the text into a Text Box. In the Wrap Inspector, uncheck Object causes wrap.
	Put the shape in another Text Box—simply cut and paste inside the box.
	Move the box with the text over the box with the highlight.
	Select both boxes. Click on them while pressing the Shift key.
	Under the Arrange menu, choose Group.
	The result will look as it does in the following screenshot with the The Black Hen nursery rhyme, but text and highlight will move together.[image: There's more...]





Creating drop caps with the Custom Image bullets



A drop
cap
 is a large capital letter at the beginning of a body of text. It is as deep as several lines of text and sometimes has additional graphic elements so that it looks more like an illustration than part of the text itself. It is a popular, if somewhat dated, feature, and many design programs and word processors offer the drop cap option as a separate function.
In Pages, the iWork word processing and layout application, drop cap does not feature as a separate option, which has led to much grumbling on user forums. However, there are several easy ways to create drop caps, with both text and graphic elements.
Getting ready



Open a new iWork Pages document with filler text, for example lorem ipsum, to try out the recipe. You can also use any of the letter templates. Under the Format menu, go to Advanced, and uncheck Define as Placeholder text.
The filler text used in this recipe is as follows:

Lorem ipsum dolor sit amet, consectetur adipiscing elit, set eiusmod tempor incidunt et labore et dolore magna aliquam. Ut enim ad minim veniam, quis nostrud exerc. Irure dolor in reprehend incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat. Duis aute irure dolor in reprehenderit in voluptate velit esse molestaie cillum. Tia non ob ea soluad incom dereud facilis est er expedit distinct. Nam liber te conscient to factor tum poen legum odioque civiuda et tam. Neque pecun modut est neque nonor et imper ned libidig met, consectetur adipiscing elit, sed ut labore et dolore magna aliquam is nostrud exercitation ullam mmodo consequet. Duis aute in voluptate velit esse cillum dolore eu fugiat nulla pariatur.


How to do it...



The following sections describe how to create a drop cap:
Using Text Bullets



This is probably the easiest way to make a drop cap.
To make a drop cap 
using Text Bullets, follow the next steps:
	Click in the loremipsum text and open the Text Inspector.
	Click on the List tab and select Text Bullets:[image: Using Text Bullets]

	In the Bullets window, you will see a simple round black bullet. Double-click in the window and type a capital L, for the lorem ipsum, or the first letter of the text that you are using. Hit Return or simply click in your text once again.
	Delete the letter "L" that begins the text.
	Next, increase the size of the drop cap so that it looks much bigger than the rest of the text. To increase the size, click in the Size window and type 500. You can also click on the up and down arrows to change the size gradually.
	Then, adjust the alignment of the drop cap. Click on the down arrow next to the Align window and make the big letter sink inside the body of text. In my example, the indent is at 15 points.
	At this point, the text doesn't flow around the drop cap, but goes over it. To make it flow around the big letter, increase text indent. Click in the indent window and set a size or click on the up and down arrows. If the units are set in inches or centimeters, we may find it difficult to set the desired indent. Go to Preferences | Rulers and choose Points as a unit in the drop-down menu. In my example, the indent is set at 32 points.
	Now, the indent affects the whole paragraph—the text doesn't wrap around the drop cap. To make it roll under the drop cap, insert a paragraph after the last word in the line at the bottom edge of the drop cap. If a paragraph spacing is set, change it to 0. Click on the Text tab and set the After paragraph value to 0.
	The next inserted paragraph will repeat the style of the previous one by including the drop cap. Remove it by choosing No Bullets under the List tab. Then, set the text indent back to nil. Here's the result, a perfect drop cap:[image: Using Text Bullets]



If this sounds like too much to do to make a drop cap, remember that this is a feature that we only use occasionally, once for each large section or chapter. Plus, if we want, we can save all the described steps as a paragraph style. Here's how to do it:
	Select a paragraph with the drop cap.
	Click on View in the screen-top menu or in the toolbar and open Styles Drawer.
	In the Paragraph Styles section, click on the little red arrow next to Body and choose Create New Paragraph Style from Selection. Give it a name, for example, Drop Cap Paragraph.


Next time you want a drop cap, select a paragraph, open Styles Drawer, and click on Drop Cap Paragraph. Then, type a new drop cap letter in the Text Bullets window.

Using screenshots of letters or custom images for drop caps



This method gives more exciting design possibilities than using Text Bullets. All the steps are the same as mentioned in the preceding section, except that instead of Text Bullets we use the Custom Image option.
This option 
allows us to use any image on our computer as a bullet. We can type the opening letter of the paragraph in a very large font, take a screenshot of it, and use it as a drop cap. We can also draw a letter with the iWork draw tool, make it into an image, and use it as a drop cap.
To draw a letter follow these steps:
	Click on the shapes icon in the toolbar and choose the Draw tool.[image: Using screenshots of letters or custom images for drop caps]

	Click three times to make the shape of L and double-click on the last dot.
	In the Graphic Inspector, give the letter an attractive color and outline—see the options available under Stroke.
	Make a screenshot of the letter.
	Then, in the Text Inspector, click on List and choose Custom Image. Click on Choose, find the screenshot of the L, and click on Open. Repeat adjustments described for Text Bullets, and you will have a beautiful graphic drop cap.[image: Using screenshots of letters or custom images for drop caps]





There's more...



For a big project where drop caps will be used regularly, we can prepare a set of drawn letters following a particular style—even the whole alphabet! Then, we can store them in a dedicated folder. This folder can be added to the Media Browser. Click on the Media icon in the toolbar, click on the Photos tab, and drag your folder to the Media Browser. Then, in the Text Inspector, click on List, and choose the Custom Image option from the Bullets and Numbering drop-down menu. Click on Choose under the Image window. When the dialog window opens, find Media | Photos in the side pane and click on it. Find the letters folder, select a letter, and add as a drop cap.
[image: There's more...]
We should be careful with 
using drop caps. They are a powerful formatting and design feature, and if used in excess, can spoil the overall effect of the finished document.
Another consideration with modern sans-serif fonts is that drop caps may look out of place because some letters, I for example, are hard to recognize immediately as letters that are part of the text.


Chapter 3. Working Across Platforms and Applications



In this chapter we will cover:
	Dragging a Word file onto the Pages icon to open it
	Opening the Excel documents in Numbers, editing them, and exporting them back into Excel
	Keynote and PowerPoint—working together
	Using screenshots and PNG files—shortcuts, options, and tricks
	Fitting files of other formats into iWork documents
	Making JPEG images from iWork documents
	Making a good PDF from an iWork document, and CMYK PDFs for professional printing
	Dragging and dropping files from one application to another


Introduction



Using iWork efficiently helps us to understand how iWork can interact with other programs and formats. This chapter describes how files created in applications and common formats can be imported into iWork documents and how iWork documents can be exported into other applications and formats.
Apart from the fact that combining programs can give you even greater flexibility and creativity in your own work, you may also find yourself working with partners who use Word, Excel, and PowerPoint, but don't have iWork. They may use different software, operating systems, and hardware.
Popular applications such as Word, Excel, and PowerPoint can all be opened in iWork's corresponding programs—Pages, Numbers, and Keynote—and vice versa; documents created in iWork can be exported to Word, Excel, and PowerPoint.
In this chapter, we will explore how screenshots in JPEG and PDF formats work across platforms and applications. Recipes in this chapter will show how they can be used with iWork—how to create them from iWork documents and how to fit them into iWork projects. PDFs are especially important for professional, high-quality printing.


Dragging a Word file onto the Pages icon to open it



Compatibility is one issue that still seems to concern iWork users. It shouldn't, however, because the current version of iWork is widely compatible with most formats and programs through the easiest possible method—drag-and-drop.
How to do it...



Here is a 
fast and reliable method of transferring Word documents to a Pages project:
Drag-and-drop the Word document onto the Pages icon in the Dock.
The Word document opens in Pages with most formatting, including objects (photos, graphs, and so on) accessible with the Pages tools.
By default, iWork documents display a warnings message with a list of items that have been changed while opening a document created with a different program. Usually, there is nothing crucial—a missing font can be substituted with a different one or frames can be changed to boxes.
Tip
For quick access to frequently used programs, Mac has the Dock. It is a strip of program and file icons, usually at the bottom of the screen. You can change the position to the left or the right of the screen via the Apple screen-top menu. Go to Dock and choose your preferred position. The Dock has a set of default icons, but any program that you use frequently can be added to the Dock. Click on Desktop, and from the Go menu, choose Applications. In the Applications folder—where programs are stored—find the iWork folder, open it, click on Pages, Numbers, or Keynote, and drag it to the Dock. Next time you open an iWork document, just drag it onto the icon in the Dock. It launches the program and opens the document in one go. If there is a program that you don't have much use for, drag its icon off the Dock—it will disappear in an animated puff of smoke. Don't worry, it's only an alias; the application itself will still be in the Applications folder.

If you want to check that nothing has been lost in transfer and that visuals look the same in Pages, open the Word document in MS Office or in OpenOffice and check.
In the Pages document, adjust/change fonts, sizes, and graphic effects, and remove or add formatting.
The 
following trick is handy when you need only one element from the original Word document (for example, a picture, chart, graph, or text box).
When you open the Word document in Pages, you can see how it is formatted. Then, you can copy and paste only what you need for the project.
Quite often, your clients and co-workers will send their files in Word format. Copying and pasting directly from Word doesn't always work well. Graphs and tables pasted directly from Word can be difficult to resize, and there is often a risk of losing part of the artwork. For instance, a panel or a small graphic feature that is created as a separate object in Word can be missed when copying and pasting.
But dropping the Word document onto the Pages icon gives us a synchronized Pages file—we can immediately see all the formatting as we would in a Pages project. For example, a small advertisement text box may not have the required dimensions in Word. Instead of changing the box in Word, we can modify or recreate it easily in Pages with the required formatting. A picture pasted from Word can be resized, masked, or moved around the Pages document, which is easier than doing it first in Word and then adjusting it again in Pages.

There's more...



Remember that you don't need MS Office or Word to open MS Office documents, if you have iWork. Just drag-and-drop the Office documents onto the iWork icons. Excel spreadsheets will open in Numbers, and PowerPoint presentations in Keynote. In fact, on a Mac computer, Word files can be opened by TextEdit, the lighter, simpler word processor that comes with every Mac computer. Just drop the Word document onto the TextEdit (simple text) icon, and it opens fine.
[image: There's more...]
There is also a reverse route: 
	To make a copy of a Pages document in the .doc format, choose Save As... from the File menu (the shortcut key is Command + Shift + S), and when the dialog box opens, check the Save copy as checkbox and choose Word from the drop-down menu. A copy of your document will appear on your desktop in the .doc format.
	To make a copy of a Numbers document as an Excel spreadsheet, open the Save As dialog box and choose Excel in the drop-down menu.
	To make a copy of a Keynote presentation in PowerPoint, choose Save copy as PowerPoint in the Save As dialog box.


In fact, you can try opening any file by dragging its icon onto an icon in the Dock. If it turns dark and shows its name, this means that the program is ready to take the file. This trick can be useful when you want to open a file in a particular program other than the one that opens that file by default; for example, if you want to open a PDF document in Acrobat, instead of Preview, in order to use Acrobat tools rather than Preview tools.


Opening the Excel documents in Numbers, editing them, and exporting them back into Excel



The iWork spreadsheet application is Numbers. All basic operations, such as entering and editing data, applying formulas and functions, moving, adding and deleting cells, and selecting and hiding rows and columns, are virtually the same as in Excel, with just a few minor differences specific to how Mac operates. So, if you are already comfortable with using spreadsheets in MS Office or Open Office, you can go straight to Numbers and start using this application.
Let's see how Numbers can open Excel sheets and how Excel users can work with spreadsheets created in Numbers.
How to do it...



To open 
an Excel (or Open Office) document in Numbers, perform the following steps:
	Click on the Excel document and drag-and-drop onto the Numbers icon in the Dock.The icon bounces while the program is being launched, and then the Excel spreadsheet opens as an iWork Numbers document.
Tip
To add a Numbers alias to the Dock, go to the Applications folder, open the iWork folder, click on the Numbers icon, and drag it to the Dock. Having the icon in the Dock allows quick direct access to a program that you use often. If you no longer use it often, click-and-drag it off the Dock. The alias disappears in a puff of simulated smoke, but the program itself stays in the Applications folder.


	Edit the spreadsheet in Numbers—add and change data, add, delete, or hide columns and rows, and apply functions. Once you have finished, save and send the document to your co-worker. If it has to be in Excel, you have several options:	Under the Share menu, choose Send via Mail and choose Excel. The Mail application creates a new mail message with the Excel document already attached to it. Add the address, write a note, and send.[image: How to do it...]

	Under Share, there is also an Export... option. This will create a new document in Excel, PDF, or CSV, that you can keep for backup and send to co-workers.You can also find the Export option under the File menu, where it has been traditionally placed since the beginning of iWork. Click on it and choose Excel to create a backup copy of your Numbers spreadsheet in Excel or other formats.



[image: How to do it...]

	Also, under the File menu, there is the usual Save As... option (the keyboard shortcut is Command + Shift + S). When the dialog window opens, check the Save copy as checkbox and choose Excel Document from the drop-down menu. Click on Save to get a duplicate of your Numbers spreadsheet in Excel format. Remember to save your document first in Numbers, otherwise it will be replaced by Excel.[image: How to do it...]




There's more...



In Numbers, tables and charts are separate objects placed on a canvas—which is a blank space—where they float and can be moved around with text boxes and graphic objects, which are added to create a very sophisticated document. When a Numbers document is exported to Excel, each of the objects is placed on a separate worksheet—if there are more than one. This doesn't affect your work; it's just something to get used to.
Excel users 
often comment that the icons in the Numbers toolbar are very small. If this bothers you, customize the toolbar to make the icons bigger.
[image: There's more...]
To do this, choose Customize Toolbar... under the View menu, and uncheck Use Small Size at the bottom of the viewing options. Then, click on Done.


Keynote and PowerPoint—working together



It may sound strange, but people often use iWork for word processing (Pages), while carrying on using PowerPoint for presentations, without realizing that iWork is a suite of applications that covers different productivity needs. Pages, Keynote, and Numbers complement each other. While each application has a different purpose, they have the same basic set of tools, similar style, and overlapping possibilities, so your life will be much easier if you write your presentation in Keynote rather than in PowerPoint.
How to do it...



Don't make a 
presentation in PowerPoint—do it straightaway in Keynote. But if you already have PowerPoint documents or someone sends you one to use or review, you can import it into Keynote:
	Click on the PowerPoint document and hold.
	Drag it onto the Keynote icon in the Dock, and when the icon darkens and the name of the application appears above it, let go.The icon bounces for a few moments and then Keynote opens the PowerPoint presentation.

	Adjust formatting and settings, perhaps add a few features from your Keynote options, and then save.[image: How to do it...]



Keynote projects can be exported to PowerPoint. For example, when you want to send it to someone for reviewing, or when you know you will have to use PowerPoint at a location where they don't have the hardware to project Keynote, you can perform the following steps:
	Under the Share menu, choose Export.
	When the dialog opens, click on PPT (PowerPoint), choose your settings, and click on Next....
	Choose title and location, say, Desktop, and then click on Export.
	The Export option can also be found under the File menu. From here, it works in the same way as from Share.


Remember that PowerPoint doesn't have some Keynote features. For instance, bulleted formatting may be lost and Alpha graphics don't transfer to PowerPoint. If you want to use images with the background removed (cutouts), you may have to create them separately and then import to the Keynote presentation as a JPEG or a PDF. The current version of Preview, 5.5.1, has tools for creating Alpha images.
When you send a Keynote document by e-mail, you can first save or export it and then attach it to your e-mail, but the Share menu also allows a one-step mailing route:
	Under the Share menu, choose Send via Mail..., and choose from Keynote, PowerPoint, or PDF.[image: How to do it...]

	Mail opens a new message with the presentation already converted into the chosen format and attached to the mail. Fill in the address, subject, and your covering note, and then send.



There's more...



Remember that presentations can be exported as PDFs. Exported PDFs can then be used as slides for your presentation. Indeed, in certain circumstances, you may prefer the PDF format because of its ability to retain the appearance and high definition of the original document, irrespective of the software or hardware.
Keynote, PowerPoint, and Open Office presentations can also be printed to iPhoto and then played as a slideshow:
	Open the Print dialog window (Command + P).
	Click on the PDF drop-down menu and choose Save PDF to iPhoto.
	Choose themes, music, and other settings after iPhoto has imported the slides, and then play your presentation.


Along with iPhoto, Keynote can also be shared (exported) to iDVD, iTunes, iWeb, and YouTube. 
[image: There's more...]
For some of these services, YouTube for example, you may have to set up an account and log in before exporting.


Using screenshots and PNG files—shortcuts, options, and tricks



Screenshots are photos of your computer screen. You often see them illustrating manuals or articles on the Internet, but they are incredibly easy to create yourself.
You may not have much use for screenshots until you start a big project, for example, producing a glossy magazine. Then you will quickly discover how useful they are. First, ask the printshop technician to make a screenshot of the PDF settings they need for the files that you prepare for them. Use the screenshot as a memo to adjust the settings on your computer. Then, a designer with whom you may be developing the look of the magazine may ask you to send the CMYK reading for brand colors. Instead of copying them out, just make a screenshot of the Colors window with the reading displayed, and send it to the designer. Soon you may find yourself using screenshots all the time.
In this recipe, we will learn how to make screenshots and where else we may find them useful.
How to do it...



The basic 
keyboard shortcut for screenshots is Command + Shift + 4.
Press the Shift and Command keys together and type 4. The cursor turns into crosshairs, like those in a sniper's telescopic sight. Drag them over the area of the screen that you want captured and let go. There is a camera shutter sound and a graphic file with a .png extension appears on the desktop.

PNG
 stands for Portable
Network
Graphics. PNG files are usually small in size, which makes them very quick to upload/download to or from the Internet and to send via e-mail. This makes .png screenshots a very useful feature for displaying or swapping information when working as part of a team.
Screenshots of menus, windows, whole screens, stages in workflow, or of any particular problem can easily be posted on websites or Internet forums to show what you mean, instead of describing it in words.
Additional screenshot shortcuts:

	Command + Shift + 3: Screenshot of the whole computer screen as it is, with everything that is on it at that moment.
	Command + Shift + 4 and hit Space instead of dragging the crosshairs: The crosshairs turn into a little photo camera icon, and the single window—or menu, or icon, or palette—that is behind the camera is highlighted in blue. Click to take a snapshot of just the one item over which the camera cursor is positioned. This way, you don't need to drag the crosshairs to select an area. This additional option is very useful when you want to show multiple complex settings for graphic images or text formatting.


If you like working with clipboard, these two may be for you:
	Command + Control + Shift + 3: Copies a picture of the whole screen to the clipboard.
	Command + Control + Shift + 4: Drag crosshairs to copy selected area to the clipboard.


The copied image can then be pasted into the document you are working on or as a new file in Preview (File | New from Clipboard).
If you change your mind about making the screenshot, or if your crosshairs didn't catch the area you wanted, hit Escape to get out of the screenshot mode.

There's more...



There is a list of keyboard shortcuts under System Preferences | Keyboard and Mouse | Keyboard Shortcuts. To activate or deactivate shortcuts, tick the respective checkboxes. Another list of shortcuts for iWork is under the Help menu. And, of course, when you click on menus, make a note of any shortcuts available for operations that you use often.
Here are some 
situations where you may find screenshots useful:
	To show stages of work, step by step
	To show invisible formatting and layout grids
	To capture settings to swap with colleagues or to reply to queries
	To show open menus and formatting palettes, for example, the Inspector or Colors windows
	To upload small graphic files to websites and forums
	To capture scenes in movies (good for storyboards)
	To capture a detail of large pictures, photos, or any graphic image




Fitting files of other formats into iWork documents



What do 
we do in a situation where our document is created in iWork, but we have to work with someone else who uses a different software? First, remember that whatever other design programs people use, the result can be converted into one of the popular graphics file types, and Pages, Keynote, and Numbers can take most popular file formats. You can import graphics in the following formats:
	PDF
	JPEG
	PNG
	PSD
	PICT
	EPS
	GIF


What this means is that you don't need to worry about compatibility. A whole page or only a small graphic element can be fitted into an iWork project.
How to do it...



Here is one example: a co-worker designs crosswords and Sudokus and submits them in Word. They have to be fitted into a particular space in the magazine—the puzzles on one page with wide columns, and the solutions on another with very narrow columns. If you were to copy and paste the puzzle and solution grids, designed as tables, from Word and then make them sit in the layout grid, you would have to resize them, change the font size, and 
make a number of other adjustments.
[image: How to do it...]
Instead, we can use a different method, as follows:
	Print the whole Word document to PDF.
	Import the whole PDF document into the iWork document.
	Mask the PDF, leaving only the portion of the PDF that is needed on the page—puzzle on one, solution on the other.


This is much quicker and doesn't affect the final result.
With masking, we avoid cropping PDFs or other graphic images before importing them into our iWork document—masking works like cropping, but within the actual project you are working on.
A mask can be applied to a selected object from the Format menu, or with the keyboard shortcut Command + Shift + M, or by clicking on the Mask icon in the toolbar. If the icon is not displayed, you can add it through View | Customize Toolbar.
[image: How to do it...]
Many users shy away from masking, thinking that it is too much hassle. In fact, masking is a powerful tool and it is worth investing some time to get comfortable using it. After masking is activated, it works in the same way as when you resize any other object, except that you have a choice between several objects.
	To resize the mask itself, drag the handles of the mask. Click on Edit Mask when finished.
	To move the image within the mask, so that only the desired part is visible, just the puzzle grid, for example, click on the image visible inside the mask, and drag it around. Click on Edit Mask when finished.
	To resize the image that appears within the mask, drag the slider that appears in the Edit Mask window when masking is applied.
	When you finish editing the mask, the masked area of the image will not be visible. Move and resize the masked image like an ordinary, unmasked object.Tip
Use the snap to grid function when you are fitting graphics into a layout. When you drag the mask borders, they snap to the columns of the page layout. In iWork, this function, which may be familiar to users of other programs, is called Alignment
Guides
.




To activate the Alignment Guides function:
	Open Preferences under the menu for Pages, Keynote, or Numbers, and click on Rulers.
	Under Alignment Guides, tick the checkboxes against Show guides at object center or Show guides at object edges, or both.[image: How to do it...]
Tip
In the example with 
Sudokus, the mask snaps to the narrow column and all there is to do is to resize and move around the graphic image inside, leaving only the solution grid visible.





There's more...



In this recipe, we used unused PDF format as an example, but any other graphics file types compatible with iWork can be used in the same way—JPEG, PSD, PNG, and so on.
This is invaluable when you have to split a large project into chunks of work. Several design features for our magazine were created in Illustrator by an independent designer. We only had to put them in place as graphics. Several whole pages for graphics-rich sections of the publication were entirely laid out in InDesign, so that they only had to be slotted as PDFs into the magazine format.
It works the other way round, too. In a project where someone else puts separate chunks together for the final look, do your bits in iWork, transfer them to a file type that can be used as a jigsaw piece—and that's that. You can lay out pages for another magazine that can be then inserted into their format.
Tip
Masks can be rotated and even edited like any other shapes in iWork. By default, a mask is rectangular, but under the Format menu, there is the Mask with Shape option, 
which allows you to use other predesigned shapes as masks. The Draw tool cannot be used as a mask. To give the mask a free shape, make it editable. Navigate to Format | Shape | Make Editable, and then modify it with editing points. This technique can be used to make cutouts from photos.



Making JPEG images from iWork documents



This format is
 one of the most commonly used in graphics, especially for digital photographs. It is used for storing and transmitting photos on the Internet. One of the reasons for this is that the format allows varying degrees of compression with little loss of quality. This is what makes JPEGs so attractive for web use. For iWork projects, you may want to make your finished work—a poster, a card, a logo, a flyer, or simply a collage of snapshots from the family holiday—into a JPEG. This recipe shows how to do this.
How to do it...



When you finish working on an iWork project—in Pages, for example—with its wide choice of templates, do the following:
	Choose Print from the File menu, or press Command and type P.
	When the Print dialog opens, click on the PDF drop-down menu in the bottom-left corner.
	Choose Save PDF to iPhoto.[image: How to do it...]



The workflow 
starts, and after a few seconds iPhoto launches and imports your iWork document as JPEG. In iPhoto, you can edit it, add effects, and store it in albums and folders. From iPhoto, the new JPEG file can be sent as a mail attachment.
Click on the Email button and the computer will compose a draft e-mail message with compression (size) options, from small to actual size, for your image.
This simple method gives a quick and easy way to send out the Pages documents. Directly from iPhoto, you can share images on popular social networks, such as Facebook. If you have a blog or a website, these JPEGs are ready for uploading too.
Printing to iPhoto is probably the easiest and quickest way of making JPEGs from iWork.
[image: How to do it...]
There is another 
method via Preview, which gives more flexibility when creating a JPEG file than simply printing to iPhoto:
	Press Command + P to open the print dialog.
	Click on the Preview button and then click in the bottom of the dialog.
	When a preview of the document opens, check that it looks the way you want your finished document to look, and choose Save As... from the File menu (alternatively use the keyboard shortcut Command + Shift + S).
	When the Save As dialog opens, click on the Format drop-down menu and choose JPEG (or whatever format you wish to use). When you choose JPEG, additional options appear. These options allow you to set the quality and resolution of the JPEG. Choose the quality from the drop-down menu and set the resolution by typing the size in the window.



There's more...



Preview, with its unassuming name, is a powerful but often overlooked application, pre-installed on Mac computers. It reads and makes PDFs, and it allows you to change file formats from one to another. If you already have a PDF or a PNG file created from an iWork document, open it in Preview and save it as a JPEG.
Current versions of Macintosh OS have an added set of tools for Preview, including Alpha and free-draw cropping tools. With these, you can remove the background in photos and make cut-outs. These are powerful graphic design features.


Making a good PDF from an iWork document, and CMYK PDFs for professional printing




PDF
 stands for Portable
Document
Format. This format was developed to allow a document to be opened and viewed on any computer, irrespective of software, hardware, or operating system, in exactly the way you created it. It could be a one-page text document, a manual containing several hundred pages, a graphics-rich document, a poster, or a photo album.
PDF documents can be opened by the freely distributed Adobe Reader. By default, Mac opens PDFs in Preview, so with a Macintosh computer you don't even need Adobe Reader. The PDFs' wide accessibility make them extremely popular, so the ability to produce them is an essential requirement for a productivity software.
If your project is for commercial printing, PDF format is what printers will ask for. iWork/Pages includes dozens of beautifully designed templates, but to use them for professional commercial printing, they must be converted into PDFs.
Let's see how to turn iWork documents into PDFs.
How to do it...



There are several ways to make
 PDFs from iWork documents:
	Navigating to File | Export...:After the Export Options window opens, choose PDF and tick the settings you require for the exported document.
[image: How to do it...]

	Navigating to File | Print | Preview:In the Print dialog, click on the Preview button. When a preview of the document opens, choose Save
As... from the File menu (or use the keyboard shortcut Command + Shift + S). This opens a dialog with saving options. Click on the Format drop-down menu and select PDF. Then, click on Save.
[image: How to do it...]
Tip
Don't be 
confused about what Preview is. First, it is a way of viewing a document before it is opened, printed, or saved. But it is also a Mac application that allows you to view documents in many different graphic formats and to change their formats. Also, it is the Mac's own PDF-making machine. So, when you see Preview
 at the top of your screen, remember that your active window is in the application called Preview.
[image: How to do it...]


	Navigating to File | Print | PDF:Choose 

Print to open the Print dialog and click on the PDF button in the bottom-left corner. From the drop-down menu, choose Open PDF in Preview, and when the preview opens, save it.

	Navigating to iWork | PostScript | PDF:In the Print dialog window, click on PDF and choose Save as PostScript....
[image: How to do it...]



A file with the .ps extension will be saved to the desktop or a folder of your choice. This file can then be opened in Preview or with the full version of Adobe Acrobat, which should include Adobe Distiller.
Adobe Distiller produces 
PDF documents with four-color separation, CMYK, and other typographical features that make them suitable for professional (commercial) printing in high quality.
The PostScript option turns iWork from a home-based desktop productivity suite to a highly versatile, simple, but powerful program that is suitable for professional work. You can use it to produce glossy magazines, catalogs, brochures, cards, posters, and many other high-end publications. Our publishing company designed the magazine in iWork/Pages, then made press-ready PDFs and delivered them—ready to go—to our professional printers.
A PDF that has been produced via Export or through Preview cannot usually be converted to CMYK four-color mode by commercial printers. Professional print shops need CMYK PDFs for large printing presses. That is where the PostScript stage in preparing a PDF is needed. PostScript is a computer language for page description that was specifically developed to allow high-end desktop publishing. The PDF format is largely based on PostScript.
To recap, the three steps to professional PDFs are as follows:
	Print file to PostScript:Under the File menu, click on Print. When the Print dialog window opens, click on the PDF drop-down menu and choose Save as PostScript. As this will be a temporary work file, save it to the desktop.

	Launch Acrobat and process the PostScript file via Distiller:In Distiller, use the required quality settings. If you don't know what settings to use, ask your printer.

	Save your PDF document:Use Acrobat tools to check that your PDF is a CMYK press-ready document.



In current 
versions of Mac OS, you can set iWork with the Save as Adobe PDF option in the Print dialog, skipping the .ps stage. This gives press-quality files to Adobe PDF straight from iWork documents.
Tip
In Acrobat, you can open your .ps file under the File menu, or navigate to the Create PDF... | From File option. A quicker, one-step way to do this is to put the Acrobat icon in the Dock and drag-and-drop the .ps file onto the Acrobat icon. Distiller launches automatically and produces the PDFs. In fact, a whole batch of .ps files can be distilled in one go. Press Shift and click on all .ps files you want to convert to PDF, one by one, and drag them all onto the Acrobat icon.


There's more...



The need to have a full professional version of Adobe Acrobat/Distiller may be disappointing, but if you are planning to build a business, you may want to consider making some investments. Even if you have to buy Acrobat, the cost stays reasonably low compared to buying a much more expensive professional design program. Also, take into account the ease of learning and using iWork.
However, if you are not ready to invest in Acrobat, you can simply take your iWork files saved as PostScript to a printer—most will process them for you for a small additional fee. Or you can even go to a friend who has Acrobat to prepare PDFs from PostScript.
Remember that PDFs can be produced in the same way as described in this recipe, not just from iWork, but also from other text and graphics applications, including TextEdit, MS Office, and Open Office.


Dragging and dropping files from one application to another



You can 
drag-and-drop images, for example, in JPEG, PNG, or TIFF format, straight into your iWork documents without first downloading them to your hard disk. The image will be stored in your iWork document, and you can extract it easily as a separate file any time you want to.
How to do it...



When you find an image that you want on the Internet, click on it and hold, then drag it from an open browser window, such as Safari, Explorer, Firefox, or Chrome, to an open iWork document.
When the iWork document is ready to receive the image, it shows this in two ways:
	A green button with a plus sign appears attached to the cursor. That's when the image will simply plop as a floating object exactly where the cursor is hovering.
	A blue outline will appear in the iWork document.


The blue contour indicates the shape, in the document, that will be filled by the image. If the blue border appears along the margins of the page, the image will just land on it. Or, you can place it inside a shape that you have already created in your Pages document—the shape will show itself with a blue border—or in an image that is defined as media holder (Format | Advanced | Define as Media Placeholder). In Numbers, it might be a segment in a pie chart, and in Keynote, it could be an image in one of the slides.
Of course, there are other ways of downloading images from the Internet that you may already be familiar with. I am describing the drag-and-drop method here as it is perhaps the quickest and most efficient. With this method, we don't overload our computers with downloads that we may not need for anything other than the one particular project.

There's more...



It is easy to 
copy a photo from one iWork document and paste it into another. But sometimes, you will need the original JPG or TIFF file, to change format, send it to someone, or edit it in some other application. But you can't just drag it back from iWork to your desktop. Annoying, isn't it? 
The photo sits in Pages, you don't know how to get it back, and your old files containing the original have all been dumped long since or stored on a disk in a dust-covered pile at the back of the shelf and it's too much trouble to look for it.
Instead, when you need to get the original image, you can easily extract a copy from an iWork document. This can be done as follows:
	Select the image that you want to extract.
	Open Inspector and click on Metrics (with the little ruler icon). In the File Info window, you will see a small icon with the name of the file and its type (as shown in the following screenshot):[image: There's more...]

	Click on it and drag it to the desktop or wherever you want to put it—iPhoto or a dedicated folder.


It may seem like an obvious trick, but it's only so when you know how to do it. Also, it saves a lot of time, because most of us are more likely to remember the document where we last used a particular photo than which folder or iPhoto album we stored the original in.
It is particularly 
worth recommending these two techniques—dragging images from the Internet and extracting them from iWork documents—to Windows switchers. Mac users know that many operations on Macs can be done by dragging and dropping.
Tip

A note on copyright

Look for public-domain (free) images on Wikipedia or similar sites, or ask for permission to use an image. Remember that just because a photo or a design is on a publicly accessible website, it doesn't mean it is copyright-free.



Chapter 4. Where to Find Shortcuts and How to Remember Them



In this chapter we will cover: 
	Shortcuts for opening new documents, new folders, and duplicates
	Saving and autosaving—don't just rely on Auto Save
	Send to Back and Bring to Front—iWork-specific shortcuts
	Grouping and ungrouping—making multiple elements into one
	Undo and Redo—the two most important shortcuts 


Introduction



Shortcuts are keyboard combinations for doing operations that you use frequently. They are so called, because they offer a quicker and more efficient way of working. With shortcuts, you use both hands to operate the computer rather than holding the mouse with one. Learning shortcuts that are useful for your work can greatly improve your efficiency. 
There are three good reasons for using keyboard shortcuts whenever possible. Shortcuts
 are:
	Moreefficient: Generally, it is quicker to perform most operations with keyboard shortcuts rather than with the mouse. Provided, of course, that you have sufficient keyboard skills.
	Healthier: Using both hands reduces the stress on the mouse-hand. In extreme cases, if you work for long hours dragging and clicking, repetitivestraininjury (RSI) may develop. This is painful and takes a long time to heal. Keeping your hands busy on the keyboard is also healthier because you are less likely to pick up snacks, drinks or cigarettes, where they are still allowed.
	Safer: Again, when both hands are busy, accidents such as water, tea, or coffee spills—a major cause of computer damage—are less likely.


There is no point in trying to memorize lists of shortcuts before you start using them. We should pick up shortcuts as we go. When you work on the computer, make a mental note of what you do most frequently, especially operations where you most often go to menus to accomplish a task. Check if there is a shortcut or a sequence of shortcuts for that particular task and if there is, practice it repeatedly until you remember it.
Everybody has their own favorite shortcuts. So, try out different ones to find out which suits you best. Some may seem awkward at first, but once you've developed a habit, you stop thinking "how do I do this?" and hit shortcuts in the same automatic way as you tie your shoelaces or button your shirt.
	Keyboard shortcuts, where available, are shown next to menu items
	The iWork Help menu has a separate item—KeyboardShortcuts[image: Introduction]

	You can find many other shortcut keys under SystemPreferences | Keyboard&Mouse:[image: Introduction]



Wikipedia has an article on keyboard shortcuts that includes comparison tables showing which Windows shortcuts correspond to which Macintosh ones. You can find this article at en.wikipedia.org/wiki/Table_of_keyboard_shortcuts.


Shortcuts for opening new documents, new folders, and duplicates



Some of the most basic and frequently used operations are opening a new document, creating a new folder, and creating a duplicate (making a copy) of a document. Yet, many of us often still perform them through the File menu instead of using shortcuts.
How to do it...



Let's see what remembering to use keyboard shortcuts instead of menus can give us in terms of efficiency.
Creating a new document, using Command + N



Starting a new project 
by opening a new document may seem obvious. We are not in a hurry and can build or write a document at our own pace. But consider, for example, a situation when you are in the middle of your work and suddenly, as often happens, a bright new idea hits you, something not connected with your current work but that you want to develop later. Before it flies away, you want to scribble it down quickly. How can you do that? Left thumb on Command, right index finger on N, and without looking at menus, you have a new page where you can jot down a few keywords. Save and leave for later.
Or take these other situations when quickly opening a new document saves time and avoids distraction.
Doing graphics in a separate document



Instead of editing a photo, designing a graphic image, or building a chart within your document, you can open a new document, copy-paste the graphic into it, work on it, and then copy-paste it back into the main document and adjust.

Text Box



If a boxed piece of text—a list, a tip, a datasheet, or questions and answers—doesn't fit in with the page layout, you may want to remove it temporarily and decide what to do with it later. Select the box and cut it (the shortcut key is Command + X). The box goes onto the clipboard, but if you copy or cut something else it will be deleted. Press Command + N and paste the box into the new document. When you decide what to do with the box, you can copy-paste it back into the main document, throw it away by closing the temporary document without saving, or save it for future use.

Photos and graphics



Cut and paste a graphic image or several images into the new document to edit or modify them separately. This way, you can enlarge the graphics to work on the finer details. When the work is finished, copy-paste the image back into the main document. Afterwards, you can discard the file or keep it separately for repeated use. This is a good way to build a set of repeating 
graphic elements, as you go. Very soon, you will have a graphic images library.
Tip
By default, when you open a new document, iWork opens the Template Chooser with a blank document highlighted in it. Hit Return (Enter) or click on the Choose button, or double-click the template icon to open the document.
If you don't want to see the Template Chooser every time you start a new document, go to the application menu (Pages, Numbers, or Keynote), choose Preferences, and click on the button next to For
New
Documents to deactivate this option. Click again to activate. If you have a favorite template, perhaps one that you have created yourself, check the Use
Template checkbox.

[image: Photos and graphics]
When Template Chooser is disabled, you can still open a new document via the Chooser. Under the File menu, after New there is the New
from
Template
Chooser option. On the keyboard, simply add Shift to the shortcut—Shift + Command + N.


Making a new folder, using Command + Shift + N



A very long 
time ago, in a computer class, we were learning Mac basics, including opening new documents and folders—the instructors were saying creating instead of opening. For someone who was just learning about computers, it was incredibly hard to understand the difference between the Finder or desktop, and the active application. Many of us were going to the File menu, choosing New, and getting endless New
Folders on the desktop.
When you see Finder in the top left corner of the screen, it means you are on the desktop. On a Mac computer, Desktop is actually one of the many folders of your computer. When you are in a program, the name of that program is at the top left of the screen. iWork is a suite of applications, so you see Pages, Keynote, or Numbers.
Next to the name of the program, there is the same File menu, where New is for new documents in that application.
We can click on Desktop and then choose New
Folder from File or we can use the shortcut key Command + Shift + N.
Quickly opening a 
new folder can be very useful in the following situations:
	When planning a complex project, you may have created several folders for each stage, for example, Draft, Proof, 2nd Draft, and Finished. While working, you may discover that an additional stage should be added, so quickly create a new folder—for example, 3rd Draft—and drop the relevant documents in it.
	When researching a project, save links, articles, images, and clippings to Desktop, then open a new folder, give it a name, and scoop up all the files from your research work and drag them to the folder. To select the files, click on the Desktop, click again and, while pressing the mouse button drag the cursor over the file icons.
	After finishing work on a project, you may have notes, links, images, and so on, left lying on the desktop and cluttering it. Open a new folder and name it, say, myprojectnotes, scoop up the files, and drop them in the folder.


Tip
To zap between active applications, press Command and hit the Tab key. When you press Tab once, a semi-opaque strip of all currently active applications opens on the screen. Keep pressing Command and hit Tab again—a dark-gray rectangle will highlight the application that you can jump to. Using the Command + Tab shortcut key is very useful when you use several applications alternately, for example, one of the iWork programs and Preview.


Creating a duplicate, using Command + D



In Finder, and in 
all other folder windows, this command is under the File menu. To duplicate a file, click on its icon, press Command, and type D to get a copy. The word "copy" is added to the name of the file. In iWork applications, it is under Edit. Click on an object—a shape, a photo, or a text box—and duplicate it.
What's the point in multiplying files or objects?
With files, duplicating is an essential operation when you work on a periodic publication, a magazine, or a newsletter. Having finished with the current issue, select all files containing pages, sections, or inserts, duplicate them, to get a ready template for the next issue. Change the issue number, date, and a few other items that need updating and you can start filling the publication with new content by pasting over the old one and by removing and fitting new graphics.
In graphic 
design, the "duplicate" function helps when we have a project that uses many similar objects, for example arrows. Design one arrow with curves, colors, and shadows, and then, duplicate it— now it is ready to use in several different places. Move into place, rotate, resize, or edit, if needed. When an arrow has to point in the opposite direction, just flip it horizontally or vertically to make the arrow point left or right, up or down. The Flip function is in the Metrics Inspector or under the Arrange menu. If you use flip often, you can add it to the toolbar. Under the View menu, go to Customize
Toolbar..., drag the Flip icons to the toolbar, and click on Done.
[image: Creating a duplicate, using Command + D]
Tip
When you need to select several files in a folder, press Shift while clicking on them. Then, you can move them all together. When the folder is set to show files as a list or in columns, you can select adjacent files by pressing Shift. But if you click on files separated by other files, the whole range in between will also be selected. To select only the files you want, press Command while clicking on the file.



There's more...



When you've mastered touch-typing, you can type without looking at the keyboard—your fingers find the necessary keys all on their own. Much like you push pedals in the car without looking down.
[image: There's more...]
Why is it important to learn touch-typing (blind typing)? With so much around us operated through keyboards, it may be considered a basic life skill. At first, you may find that touch-typing slows you down, but the more you practice, the more you find it liberating to see the text as it is appearing on screen.
To learn touch typing, there are numerous courses and resources available on the web. Have a look at the BBC site, designed primarily for youngsters but content-wise good for anyone—bbc.co.uk/schools/typing/levels/level1.shtml.
But it is not at all difficult to learn touch-typing just by practicing.
Here is how to start. First, learn the home position of your hands. The F and J keys in both QWERTY and AZERTY layouts usually have little knobs or bumps—that's where your index fingers should rest in the basic position. Thumbs should rest on the Space bar. Move the left index finger to the right to type G and right finger to the left to type H. On QWERTY, put the little finger of your left hand on A and the little finger of your right hand on the ; key. The remaining fingers will find their position on the same row. If a word finishes with a letter in the left-hand segment of the keyboard, hit space with your right thumb, if it's on the right, use your left thumb.
From here, learn where all the other keys are, relative to the basic position. Start with the basic position and progress to all fingers touch-typing.
The rest is practice.


Saving and autosaving—don't rely on Auto Save



The new versions of Apple's operating system, OS 10.7 Lion and OS 10.8 Mountain Lion, have introduced Auto Save. It is a long-awaited feature. For years, iWork users complained that there was no Auto Save function. The revolutionary new approach to Auto Save by Apple is that it is not for each separate application, but now covers a whole range of frequently used 
applications that come preinstalled on every Mac, including TextEdit and Preview. It also includes iWork.
For most users, Auto Save is a blessing rather than a threat, but be careful what you do or write, especially if you are on a local network (refer to the following sections).
How to do it...



In current OS Lion and in previous operating systems, the Save shortcut is easy to remember.
	Save by using Command + S: The Save option is also available under the File menu. For those who are trying to master touch-typing, this mnemonic technique can be useful. Press Command with your left thumb by moving it slightly to the left and find S under your ring-finger. In 10.7 Lion, the old Save function activates the new Versions function that creates a version of your project when you save it manually.
	SaveAs by using Command + Shift + S: One easy way to use SaveAs... is by pressing Command with the left thumb, then finding the Shift key with a semi-circular movement of the little finger and typing S with the middle finger.
Save
As... shouldn't be seen as just another way of making copies but as a more powerful tool. When you open the Save
As... dialog in iWork, it has the option of saving the iWork document in DOC format, for example, which gives more flexibility when working across different applications.




There's more...



Lion has introduced several new saving and back-up options. If you are set in the old ways, don't worry—nothing has changed radically except Auto Save. But to take full advantage of the new features, it is worth having a quick look at them.
Auto Save allows you to revert to the previous (last saved) version of your project. Along with Auto Save, Lion also has the Duplicate and Lock functions.
Duplicate turns your existing document into a template, and Lock is a clever feature that prevents accidental, unwanted changes to a finished project. This happens! When you open an old file just to have a quick look, you might make a few unintentional changes, delete words or an image without noticing, but Lock stops this from happening.
Versions, another new function, shows snapshots of all previously saved stages of your work. From the drop-down menu, choose Browse
All
Versions... and get a stack of views of your project step-by-step, as you have been working on it. If there is something you want to put back into your current version, click on it and copy-paste.
In addition to Versions, you can also use the 
Undo function. You can choose it under the Edit menu, or you can use the shortcut Command + Z. While you work on a document, you can trace back all your changes by typing Command + Z—undo—repeatedly. Again, to come back to where you were, type Command + Shift + Z—redo (it's easy to type with a thumb, little finger, and index finger).
Even so, beware of Auto Save. Consider, for example, the following situation. You are in a breezy mood and put all sorts of light-hearted or rude comments on your boss's memo. Of course, you will delete them later and work on the document in a serious manner. But someone calls you, you walk off to get a glass of water, or a colleague asks you to help... And horror of horrors, your comments are automatically saved and the boss sees them, over LAN for example. Disaster!
It is much easier to train yourself to press Command + S to save as you go along. You never work on a document from start to finish without taking natural breaks—to stretch, look at your document to see if you are satisfied so far, or to decide what to do next. This is the point when you should save your draft as a Version by yourself, rather than letting the machine do it at set intervals.


Send to Back and Bring to Front—iWork-specific shortcuts



There are general shortcuts that work for anything we do on the computer, and there are application-specific shortcuts, the ones for specific operations in a particular program. For example, in iWork we have a set of shortcuts for moving objects from layer to layer.
To understand how it works, imagine having a stack of notes, magazine clippings, and photos on your desk. To arrange them in a logical fashion, you bring one note to the front, put a clipping at the back, and attach a note to the photo. That's what the 

Send
to
Back, Bring


to
Front, 

Send
Backward, and 

Bring
Forward functions do when you arrange Text Boxes and graphic objects in your iWork project.
How to do it...



There are four options under the Arrange menu. Send
to
Back puts the object into the last layer, Bring
to
Front places it in the first, and the Bring
Forward and Send
Backward options move the object forward and backward by one layer at a time, respectively.
[image: How to do it...]
If you have a project where you are often moving objects from layer to layer, you can do these operations through icons in the toolbar. Under View, choose Customize
Toolbar..., and when the dialog opens, drag the icons to the toolbar. Click on Done. To move an object, select it and click on the appropriate icon.
The shortcuts for layering objects are as follows:
	BringtoFront: Command + Shift + F
	SendtoBack: Command+ Shift + B


When moving the object by one layer at a time:
	BringForward: Command + Option + Shift + F
	SendBackward: Command + Option + Shift + B


Using three 






and four fingers for a shortcut may seem off-putting, but the advantage is that you can watch the objects moving into position as it happens, without being distracted by glancing at menus or icons in the toolbar. Try this combination of fingers—index finger on Command, middle finger on Option, and ring finger on Shift. Then, hit F or B with a finger on the other hand.

How it works...



Here is a simple example of how it works.
First, create a copy of Malevich's famous avant-garde painting, the Black
Square, and put it on another object, the white square with a picture frame:
[image: How it works...]
Then, you decide that you want a third, dark-colored frame. Add a dark red rectangle:
[image: How it works...]
Type Command + Shift + B
and see the red rectangle slipping behind the Black Square and its white frame:
[image: How it works...]
Note that the red square is still selected. Move it so that it appears to look like a frame:
[image: How it works...]
This is a relatively simple example with only three objects in the arrangement. When you put together a complex graphic image, for example a collage with multiple photos, lines, and colored shapes, you will have to use these functions a lot.
Tip
The Send
to
Back function
 is also one easy way to add background to a document. For example, if you want to have a colored page, not white, insert a colored rectangle, enlarge it so that it is slightly bigger than the page, and use the Send
to
Back function. Remember that it has to be a floating object without a wrap. Or, if after creating a graphic image, you decide that you want to use it as background, choose Send
Objects
to
Background, under the Arrange menu, or click on the In
Background button in the Wrap Inspector.


There's more...



There are some little-known tricks where using the Bring
to
Front or Send
to
Back functions can help.
Here is one example.
When you put a photo in a document and make text flow around it at a certain distance, it is called 
wrapping. Wrapping distances and other ways to flow text around graphics are set in the Wrap Inspector. If you use Text Box to add the caption to a photo, the photo's wrapping may push this text out of the box.
Reducing the wrapping count of the photo will bring the text back inside the box. But the rest of the text on the page will also stick closer to the photo and spoil your design.
One easy way to solve the problem is to bring the Text Box to the front. To do so, select the Text Box and choose the Bring
to
Front option under the Arrange menu, or use the following keyboard shortcut:
[image: There's more...]


Grouping and ungrouping—making multiple elements into one



The Group function makes several or many separate elements of the project into one. It is another of the iWork-specific commands and shortcuts. This allows us to construct a complex project with graphics and text.
How to do it...



The Group function is under the Arrange menu, as is the reverse function, Ungroup.
If your work involves frequent use of grouping/ungrouping, you can put the icons for them into the toolbar. Under the View menu, choose Customize
Toolbar..., and drag the icons to the toolbar; then, click on Done.
When you want to group several objects, select them and click on the icon.
Even with this 
one-click option, we still have to look at the toolbar to find the Group icon and move the cursor away to click on it.
With the keyboard shortcut, you don't need to do this. Select the objects and type Command + Option + G.
If an object is in fact a grouped number of elements, you will see that the Group option under the Arrange menu is gray (unavailable), but Ungroup is black (active). To ungroup, choose it from the Arrange menu or type Command + Option + Shift + G. Here, the three-finger combination may seem difficult, but when you put the left thumb on Command, you will find that it is easy to put the middle finger on Option and the little finger on Shift. Then, hit G with your other hand.
Here is a simple example of grouping two objects.
[image: How to do it...]
After importing 
this picture, In
the
Morning by Zinaida
Serebryakova, and adding a white frame in the Graphic Inspector, we want to add another, more striking frame to it. Insert a close-up photo of a lichen-covered stone wall and select the Send
to
Back option (Command + Shift + B). The photo of a lichen-covered stone wall will slide under the portrait of the woman. Resize, press Shift, and click on the portrait to select both objects. Then, type Command + Option + G to get a grouped object that you can move around the document. Resize, rotate, and 
copy-paste into another document.
[image: How to do it...]

There's more...



Even when several objects are grouped, you can select one individual object inside the group without ungrouping the whole composition. You may need, for example, to change its dimensions or add a shadow. Click on the grouped object once, and then click again to select one separate element. If clicking doesn't select the one you want, click again until you get to the object you need.
Tip
To group multiple floating graphic objects, click on one to select it, and then type the shortcut Command + A (A for all). Then, group them with Command + Option + G. This saves clicking many times. If you accidentally select something you don't want, a Text Box for example, press Shift and click on it to deselect.



Undo and Redo—the most important shortcuts



The Undo function allows you to backtrack on all the changes that you have made in a document or if you accidentally delete all.
To me, this shortcut also has a philosophical meaning. It is somewhere between the magic time machine and the red stop button, with which—in my opinion—all automatic devices, experimental projects, and human brains should be equipped. Whatever you do on your computer, or in life, check first that there is an Undo (Command + Z) option and/or a red stop button. You will never regret having checked this!
How to do it...



We will discuss the Undo and Redo options in the following sections.
Undo—Command + Z



The 
Undo option is available across all Mac applications under the Edit menu, and the keyboard shortcut is Command + Z. It is easy to master. I mostly use the left thumb to press Command and the middle finger to type Z, in the bottom left of the QWERTY keyboard. Of course, it depends on one's typing skill and habits. Occasionally, I glide down the keyboard with my right fourth finger and it naturally stops on the right-hand Command key, then glide down one row on the keyboard with the left ring-finger and it stops on the Z key.
The reverse option, 
Redo, is also very useful.

Redo—Command + Shift + Z



Zapping to and fro between the current and previous versions of your project, you can quickly evaluate the work in progress, self-approve, or get approval from the supervisor (or client) looking over your shoulder—or discard your changes.
On the keyboard, you just add Shift to the Undo combination—Command + Shift + Z. I got used to doing it this way: left-thumb Command, then let my little finger find Shift, after which the middle finger naturally places itself on Z. This works when you type with all ten fingers, using thumbs for hitting the space bar, four left fingers on A, S, D, and F, and four right fingers on J, K, L, and ;.
After a little practice, these two keyboard operations become as easy as mopping your brow.


There's more...



In iWork, these commands are particularly useful. As you work on a layout or a design, you sometimes follow a blind path—you make change after change after change and end up hating what you've done. To go back to the last version you were happy with, press Command + Z continuously, until you find the point where you want to start again.
When you work on a long text document, you may suddenly realize that you have deleted an important passage, or after editing a phrase, you decide you preferred it as it was. Undo continuously to retrieve all your words.
To put it simply, when you mess something up, quickly undo the mess with Command + Z.
In OS 10.7 Lion, Versions backs up your document in multiple stages, allowing you to go to previous stages of your project and even copy-paste elements from them into the current version. However, because Versions makes backups after certain periods of time, some stages can still be lost. With Undo, you can go back change-by-change, without missing anything.


Chapter 5. Working with Photos: Tips and Tricks



In this chapter, we will cover:
	Placing, cropping, editing, moving, and resizing photos
	Masking photos, and the magnifying glass trick
	Masking versus Image Fill—when Image Fill is easier than Masking
	Background images—setting a photo as the background and finding suitable photos
	Removing and changing the background in photos with Instant Alpha
	Using "patches" to improve photos 
	Making cutouts with edited masks


Introduction



Inserting a photo into a document is only the first step towards discovering the numerous—almost endless—inventive ways that we can use pictures and graphic images in iWork projects.
In this chapter, we will explore a few simple techniques for making photos look great in our projects. In just a couple of steps, an ordinary snapshot can be made to stand out and make our iWork document striking.
The recipes in this chapter cover the basics, such as resizing and cropping a photo, and also introduce a more advanced way of using photos, for example, removing and changing backgrounds and making cutouts. There is, of course, much more.


Placing, cropping, editing, moving, and resizing photos



The first simple step to master when working with photos is to learn how to insert one into your document. Then, because photos rarely come out in perfect composition, we may want to crop them, leaving only the most interesting details. Next, a few small adjustments can enhance the graphic impact of the original photo. In this recipe, we look at these basic techniques.
Getting ready



First, open a blank iWork document and find a photo with several objects in it, but with one that is clearly the focal, central point of the composition. Put the photo into an easily accessible place, for example on the Desktop, in iPhoto, or in a folder created for this purpose.
There are three basic ways in which a photo
 is positioned in the document:
	An inline photo is "anchored" in the text. As you add or delete text, the photo moves with the text. If the bit of text where the photo is anchored is deleted, so is the photo.
	A floating photo, on the other hand, stays where you put it and the text flows around it as though the picture is glued to a sheet of paper and you are writing around it.
	Photos in the background sit behind the text, at the back of the document—imagine writing an inscription across your portrait or on a postcard.



How to do it...



As usual, there are several ways to do the same operation, so choose the one that suits you best. The following are the options to insert photos:
	Go to the Insert menu at the top of the screen and slide down to Choose... (Command+ Shift+ V). When the dialog opens, find the photo, click on it, and then click on Open. Or you can simply double-click the photo.
	If your photo is in iPhoto, Photo Booth, or any folder that you've added to the browser, click on the Media icon in the toolbar to open the media browser, and click on the Photos tab to find the photo. Click on the photo and drag it to the document.
	To add a folder, select it and drag to the open Media Browser window.
	And—the easiest way—you can find the photo wherever it is on your computer, on the local network, or even on the Internet, and drag to the iWork document.[image: How to do it...]



The following steps describe how cropping photos works with the Masking and 
Image Fill tools.
Usingthe Masking tool to crop photos:
	Insert a photo. Here we have a picture of red apples.
	Under the Format menu choose Mask.[image: How to do it...]

	When the mask is applied, it shows as a rectangular shape with a dotted outline. It has the same handles as any other object. Click on the handles and drag to resize the mask and show just the details that you want.
	The dark control panel that appears with the mask has a slider with two—one small and one large—portrait icons. Drag the slider button from left to right in order to change the size of the photo inside the mask.
	When you are done, click on the Edit Mask button, and the rest of the photo will become invisible. 
	Move and resize the masked photo as an object.


Using the Image Fill tool to crop photos:
	Insert a shape from the Shapes menu. It could be a rectangle or any other shape.
	Open the GraphicInspector; in the Fill drop-down menu choose Image Fill.
	Click on the Choose... button and find the photo of the apples. Then click on Open.
	Next, click on the Scaling tab and choose Scale to fill from the drop-down menu. With this option, the photographic image will always fill all the space inside the shape no matter how you resize or change it. 
	Drag the handles to achieve the result that satisfies you. Here, the apple sits within an oval shape stretched horizontally.[image: How to do it...]



Editing photos



Now, for editing photos, we will be talking about more than just Photoshop. A few tools in iWork that can change the way a photo looks include Adjust Image, Tinted Image Fill, and Opacity.
Follow these steps to Adjust Image: 
	Under View, click on Show Adjust Image, and a control panel similar to the one in iPhoto opens.
	Drag the Brightness slider to make a darkish photo lighter. 
	The Sharpness option can add a "soft focus" effect to a portrait. 
	The Temperature control can make a gray day in the picture brighter. Do not overdo it, though, otherwise the photo may look unnatural.[image: Editing photos]



Follow these steps to use Tinted Image Fill: 
	Open Graphic Inspector|Fill.
	From the Fill menu, choose the Tinted Image Fill option. It puts a colored "veil" over the photo.[image: Editing photos]

	Click on the color well that appears when you choose Tinted Image Fill. When the Colors Viewer opens, change and mix the color of the veil. 
	At the bottom of the ColorsViewer window, you will find the Opacity slider. Drag the button from left to right in order to make the colored veil more or less transparent and the image more or less visible.


The following steps describe 
how to edit photos with the Opacity function.
	Select the photo and open Graphic Inspector. Opacity is at the bottom.
	Drag the slider button or click on the up and down arrows to change the photo's transparency. 




How it works...



Let's discuss Masking. If you often apply masking, memorize the shortcut—Command + Shift + M (it's easy to remember—M for masking)—or add the Mask icon to the toolbar (under the View menu choose Customize Toolbar, drag the Mask icon there, and then click on Done).
You can always remove a mask if you don't like the result; use the shortcut Command + Shift + M again or click on the Unmask icon in the toolbar. It changes from Mask to Unmask after masking is applied. 

Opacity
 is especially useful when a large photo is used as the background for a whole page or even a complete document. Where there are other elements—text, pictures, or maps—you don't want the background to be too dominant. Reducing the opacity to around 40 or 50 percent will make the photo less obtrusive, yet still visible. To make text stand out against the photographic background, reduce the photo's opacity. In GraphicInspector, move the Opacity slider to achieve the desired effect.
If reducing opacity doesn't work well, consider putting the text onto a semi-opaque color background, for example inside a Text Box with fill color. Reduce the opacity of the color by moving the slider in the Graphics Inspector, so that the photo is discernible. 
Photos can be resized as follows:
	To resize an inline photo, click on one of the black handles (little squares in the corners and the middle of each side) and drag to enlarge or to make smaller. You can't drag blue handles.
	To resize a floating photo, drag its handles—they are all "draggable".Tip
Press Shift when resizing to retain the photo's proportions.




Photos can be moved as follows:
	The inline photos can be dragged to a new place within the text—click-and-drag, watching the anchor point as you do this. When the anchor is where you want the photo to be, let go.However, some iWork users find this method too cumbersome and slow. Another, quicker, way of moving the inline photo is to cut and paste it. Click on the photo and press Command + X to cut. Then, click on the text where you want the photo to go and press Command + V to paste.  

	To move a floating photo, click on it and drag it to a new position. Floating photos can be moved with keyboard arrows. Each hit on an arrow moves the photo by one point. Press continuously and the image will leapfrog into position.
To make the photo leap by ten points at a time, press Shift and then hit the keyboard arrow.

	To change photo placement from inline to floating and vice versa, select the photo. In Wrap Inspector, click on the Floating button, or in the Format Bar, click on the Floating tab.[image: How it works...]




There's more...



There are some other tasks, which can be performed on photos.
Cropping photos



Strictly speaking, Masking and Image Fill aren't cropping in the sense that the photo stays there in its entirety. We have only hidden parts of it from view.
To crop the photo itself, use the cropping tools in iPhoto or Preview and import the image into the iWork document.
If you crop the image in iPhoto, make a copy of it before cropping. Select the photo and duplicate it with Command + D. Otherwise, you may lose the original image. 
Remember that on your Mac you can edit photos in iPhoto, Preview, and Photo Booth. They all have additional editing tools and a choice of effects. Edit the photo there and then import it into the iWork project.

Wrapping inline photos



When you import the photo as an inline object, it will sit slightly above the text where it is anchored. To make text flow around the photo, use the wrap function. Select the photo, open the Wrap Inspector, check the 
Object causes wrap option, and then click on one of the icons showing the way that text will flow around the image—left, right, center, and so on.
[image: Wrapping inline photos]
Wrapping options can also be accessed through the Format Bar—click on the wrap icon to open the drop-down menu and choose one.
[image: Wrapping inline photos]


Using the Metrics Inspector to move floating photos




The quickest way of moving a photo into a desired position is to 
set coordinates. In the Metrics Inspector, Position shows X (horizontal) and Y (vertical) coordinates of the object. Click on the arrows to move the photo.
Alternatively, if you want to place the photo in the exact same position in another page or project, note down the coordinates there and type them in the X and Y co-ordinate fields. Hit Return, or click in the document. 
This technique is very useful when you have a multi-page project with repeating graphic elements. Write down the coordinates shown in Metrics Inspector. 


See also... 



	The Fitting files of other formats into iWork documents recipe in Chapter 3, Working Across Platforms and Applications, describes more tricks with masking
	The Masking photos, and the magnifying glass trick recipe
	The Masking versus Image Fill—when Image Fill is easier than Masking recipe
	The Stacking photos, using Bring to Front, Send to Back options to layer photos recipe in Chapter 1, Lateral Thinking




Masking photos, and the magnifying glass trick



Some iWork users don't feel comfortable with masking, thinking that it takes too much effort. But masking is a powerful design function that lets us achieve exciting effects.
This recipe describes how to use masking to show a detail of a large image as though it were being seen through a magnifying glass.
Getting ready



Let's take the photographic image of the painting Surrender of Lord Cornwallis with George Washington in the background.
[image: Getting ready]
We will use the magnifying glass
 to show him in greater detail.
[image: Getting ready]

How to do it...



Here is how to show the 

details of the painting with Washington:
	Drop the image into an iWork (Pages) document.
	Next, insert the magnifying glass.
	Activate the Instant Alpha tool—Format|Instant Alpha.
	Remove the background in the photo by dragging the cursor over the background. [image: How to do it...]

	Click on the painting again and duplicate it: Press Command + D.
	Mask the second photo with an oval shape: Format|Mask with Shape|Oval. You will see part of the picture inside the oval shape, and the rest will be visible through a semi-opaque veil.
	Next, enlarge the image inside the mask.[image: How to do it...]

	Move, resize, and rotate the magnifying glass so that it looks as though it is being held by a researcher studying the picture. To rotate, press Command and drag one of the handles of the glass.
	Move the masked detail with Washington's image over the magnifying glass, and resize it to make it look as though you see it through the glass.
	Select both the detail and the glass, and Group them using the Arrange menu, or use the shortcut Command + Option + G. When grouped, you can move them together as one object, over the main picture, to find the right place in the composition. At this point, you can change the dimensions of the main picture and the glass with the masked image, again.[image: How to do it...]

	Finally, give both the glass and the handle a shadow. Offset the shadow enough to give the magnifying glass a "floating above the image" effect. To add a shadow and manipulate it, in Graphic Inspector, click on Shadow.



How it works...



In this recipe, we discussed using following functions and tools.
Instant Alpha



The photo of the magnifying glass has an opaque background. To remove it, we apply Instant Alpha. When Alpha is applied, the cursor turns into a cross and a dark panel with instructions for using Alpha appears in the document. Drag the cross over the background several times to rub it out then and hit Return.

Step sequence



Do steps 1 to 5 in this sequence, in order to layer images so that the general view of the picture is at the back, and the magnifying glass and the copy of the painting is at the front. Then, put the image of Washington inside the glass.

Masking



In the Format menu, go to Mask with Shape and choose Oval from the drop-down menu. You will see part of the picture inside the oval shape and the rest will be visible through a semi-opaque veil. Make sure that the "oval" mask stays as a circle and doesn't turn into an ellipse when you resize it. To do this, put a tick in the checkbox next to Constrain Proportions in the Metrics Inspector.
To understand how masking works, keep in mind that you are dealing with two objects at the same time—one is the mask, another is the image being masked. When you first apply masking, the mask will show handles, the little squares used to resize it, just as with any other shape. To move the mask, hit or press continuously the keyboard arrows in order—in this case—to move the mask over the figure of Washington.
To enlarge the image inside the mask, first click on it and then drag its handles. Remember, the image must be selected, otherwise only the handles of the mask and not of the image show. Don't worry if the image goes over the edges of the document, use Metrics Inspector to continue enlarging—click continuously on the up arrows next to Size. The size of the image inside the mask can also be changed by dragging the slider in the masking control panel, but you may find that using arrows in the Metrics Inspector is easier.
As you 

enlarge the image, Washington will move out of the mask. To move him back, click inside the mask to select the second of the two objects we are dealing with when masking—the picture. The cursor will turn into a little white hand. When you click and hold, the hand makes an animated "grab" movement—that's when the image inside the mask can be dragged. When the photo inside a mask is selected, you can also move it with the keyboard arrows.
Stop when the details inside the mask are clearly visible and substantially bigger than they are in the main picture. Click on the Edit Mask button in the control panel to save the result.
Tip
Watch out for pixelation—the image file should have a high enough resolution to allow considerable enlargement, otherwise the detail may blur.



See also...



	The Fitting files of other formats into iWork documents recipe in Chapter 3, Working Across Platforms and Applications




Masking versus Image Fill—when Image Fill is easier than Masking



Some iWork users prefer Masking, while others prefer Image Fill. This depends on individual experience and habits. This recipe shows situations where Image Fill definitely has a design advantage over Masking.
Getting ready



In the iWork/Pages set of 
templates, under Brochures, find Catalog and take the photo of champagne glasses there. To get the photo as a separate file, copy it and paste as New from Clipboard in Preview, or open the Metrics Inspector, click on the file icon in the File Info window, and then drag it to the Desktop.
[image: Getting ready]

How to do it...




Image Fill is one 
of the ways we can import a photo into an iWork document. Here is how it works: 
	Insert a shape from the Shapes menu. It could be a rectangle or any other shape. 
	Open the Graphic Inspector, and in the Fill drop-down menu, choose Image Fill. Then, click on the Choose button and find the photo of champagne glasses on the Desktop. Click on Open.
	Next, click on the Scaling tab and choose Scale to fill from the drop-down menu. With this option, the photographic image will always fill all the space inside the shape no matter how you resize or change it. 



How it works...



With Image Fill
|
Scale to Fill, parts of the photo will go outside the shape, but the inside will be completely filled with the image. Drag the handles of the shape to see how the image adjusts to the changing size and proportions of the space and until you find a result that satisfies you. Here, the glass sits within a rectangular shape stretched horizontally.
[image: How it works...]
One big 
advantage of using Image Fill with the Scale to Fill option is that you can quickly fill the space that you have available in the grid of your layout. When you work on a magazine or a reference book with narrow columns where text items may be added or deleted at very short notice, for example small ads, you need to have adjustable fillers. If you have to fill empty space in a column, drag the handles of the shape to fill it and the photo will adjust automatically to new dimensions. If a last-minute ad arrives, you can slot it in the column and shrink your shape to compensate.
[image: How it works...]
If you suddenly realize that there is too much empty space in your report, you can drag the handles to enlarge the shape; or shrink it and add a few lines in response to the reviewer's comments.
What has to be taken into account is that the photo must have elements that are easily recognizable even when they are severely clipped. In the first picture, champagne glasses are resized to banner proportions but the glass and the bubbles are clearly visible. In the second, the photo is stretched vertically to fill a narrow magazine column.
In situations 
like these, you may find Image Fill easier to work with than Masking. Build a library of photos that can be used with Image Fill and have them handy, perhaps in a dedicated folder or album in iPhoto.

There's more...



Note that neither Mask nor Alpha tools work with photos that sit inside shapes. If you want to use Alpha to remove background, place photos in your project as objects in themselves, then apply Alpha or Mask.
Another useful feature you may want to try is filling different shapes with images. Any shape available in the Shapes menu can be filled with an image in the way described in this recipe. And any shape can be edited so that its contours are not predefined geometrical figures but free shapes suited to your project.


Background images—setting a photo as the background and finding suitable photos



Background photos are great for complex documents. They make the design more attractive, add mood, or give more power to the message. This recipe describes how to put photos in the background, and related techniques.
How to do it...



In iWork we have several ways to 
put a photo in the background. 
	Send to Back: Arrange|Send to Back
	Arrange|Send Object to Background
	Wrap Inspector has an option for placing the photo In Background


Having an image in the background greatly enhances the document, but the photo must not interfere with our text and other objects. Here are a few techniques describing how to use the opacity function to avoid situations where background photos may make it difficult to read our text.
To use the 
Fading out the photo with Opacity function, follow these steps:
[image: How to do it...]
This image of a 
blossoming meadow is by the Normandy photographer Francesca Bostock.
	Import the photo and select Send to Back.
	Create a Text Box and type in your message. Give the box a white frame—in GraphicsInspector under Line, click on the color well to select color.
	Next, click on the background photo to select it. At the bottom of Graphic Inspector, drag the Opacity slider and fade out the photo to find the right balance between the background and the message. It is usually best between 60 to 80 percent.[image: How to do it...]



Here is 
how it will look:
[image: How to do it...]
Or, try using boxes with 

Color Fill, where we leave the background photo in full "force" but use semi-transparent shapes for the text.
	Drop the photo into your iWork document and use Send to Back or Send Object to Background, both under the Arrange menu. 
	Create a Shape (a text box, or a rectangle), and in Graphic Inspector, choose Color Fill. Pick your chosen color (here it is Silver) from the box of crayons in the Colors Viewer. Don't type in your text yet. 
	Next, reduce the Opacity of the Color Fill to around 75 percent, so that the photo is visible through the box.
	Then, insert a second Text Box—don't give it a frame or a color fill. Type and format your text, say an invitation to a Fourth of July barbecue, or to Bastille fireworks or a Remembrance ceremony. The photo suits many purposes.[image: How to do it...]




How it works...



The Send to Back function is under the Arrange menu. It puts the photo in the bottom layer of the document, behind everything else, effectively turning it into its background. The keyboard shortcut for this is Command + Shift + B (it's easy to remember—B for "back").
If you often move 
photos from layer to layer, put one-click icons for this function into the Toolbar. Under the View menu, choose Customize Toolbar and drag the Front, Back, Forward, and Backward icons to the Toolbar.
The Send Object to Background option automatically makes the background photo un-selectable. Move the cursor over the photo, click on it, and nothing happens. To make it selectable again, under the Arrange menu choose Make Background Objects Selectable. After this, when you slide the cursor over the photo, it turns into a white arrow. The white color of the cursor signals that the photo (and any other object) is in the background. When moved over photos that are not placed in the background, the cursor appears as a black arrow. When background objects are unselectable, we can carry on with the rest of the project without accidentally moving or deleting the background.
What may be inconvenient with this quick function is that after putting the photo in the background you may decide to resize, move or otherwise manipulate the photo. So you will have to backtrack—make it selectable, work on the photo, and then send it to the background again. It may make more sense to send the photo to back, where it stays selectable, change it to suit the project design and then change the placement to "background".
There are no shortcuts for this option.
Select the photo, open the Wrap Inspector, and put a tick against In Background. One advantage of using the Wrap Inspector is that it has background objects as selectable options. Check the box if you want to have the background photo selectable to do some additional manipulations. Then uncheck to make it unselectable.
If you think the text
 still doesn't stand out enough, use Solid Color Fill for the second box with text. Using two boxes retains the impression of transparency while the main box makes the text stand out on a solid color background so that it is clearly visible.
We need a separate box for text because when we reduce opacity of an object, the text in it also becomes transparent.

There's more...



These are simple tricks that add a striking effect to our designs. If you design the cover for a magazine or a brochure with a large photo that covers the entire page and goes over the edges (bleeds), this is a good way to make strap lines
 (headings) on the cover clear and visible. For print publications, including posters and cards, these techniques are very important—passersby or people browsing at a news stand need to instantly see what's in the magazine or what the card is about.
The same methods apply to business projects. We can put logos and company watermarks in the background. If needed, they can be made less obtrusive by reducing the opacity of the images.
Where to find photos for backgrounds? First of all, look at what you already have on your Mac. Open Hard Disc
|
Library
|
Desktop Pictures. There are dozens of photos that can be used as backgrounds, akin to selecting and setting something new as our Desktop background.
However, these may not be suitable for high-end print projects where very high definitions are required. For high resolution photos, check websites that upload public domain (free to reuse) photos, for example Wikipedia/Wikimedia. Check their copyright status on the website; many are completely free or only ask that the author be credited.
But better still, build your own library of suitable photos. You know best what may be useful for your work. Keep your camera with you or use your cell phone to snap landscapes, sky, sea, sand, fields and meadows, flowers and fruit, thick foliage in garden hedges, or even town sidewalks and walls of buildings. People will stare as you crouch to take a macro shot at ground level, but who cares!
Here is a macro shot of the lichen-covered wall of the 11th Century Bayeux cathedral in France, with a text box over it.
[image: There's more...]


Removing and changing the background in photos with Instant Alpha



This is a popular 


graphic design trick. You take a picture of a person, remove the background and put the person in front, for example, of a famous landmark.
Getting ready



Here is a photo of the monument to the American Navy at Utah Beach in Normandy, France.
[image: Getting ready]
We can use the Instant 


Alpha tool to replace the peaceful blue sky and instead put in a real documentary photo of American forces landing at Utah Beach on D-day in 1944.
[image: Getting ready]

How to do it...



	Remove the sky in the photo of the monument with Alpha.
	Move the 1944 photo behind the first one and resize so that the pictures are flush.[image: How to do it...]




How it works...



The Alpha tool removes 


background in photos. Apply Instant Alpha from under the Format menu. When Alpha is active, the cursor turns into a little cross and a dark panel with instructions for using Alpha appears in the document. Drag the cross over the background to rub it out, several times if necessary, and then hit Return. The sky in this photo has light blue and white colors, contrasting with the dark texture of the monument. This is why Alpha easily picks out and deletes the background. It is more difficult to apply to photos where the background has colors similar to the ones of the main figure. Be careful not to rub out chunks of the object that you want to keep in the picture.

Alignment Guides
will help two photos to "snap" together. Position the second, background photo against the monument, so that the dark figures in it are set apart from the central sculpture of the Navy commander. The black-and-white photo can be masked, and the mask is set to have the same width as the main photo.
Now the composition gives a symbolic link between the present day and history.
If you had a 


wedding photo or a snapshot of a beach party on a day when the sky was gray, you could "improve" it by replacing it with a picture of the sky on a bright sunny day.
[image: How it works...]

There's more...



The same technique can be applied to many other tasks, such as:
	To prepare clipart
	To make cutouts
	To place a figure in a photo in front of the text, for example to partially obscure the title of the publication or the heading of an article, a popular design trick on magazine and newspaper covers and in advertising


In recent versions of Mac OS X, Alpha is included as a tool in Preview. You can prepare images without their background, separately, for use across all applications on your Mac.


Using "patches" to improve photos



This recipe 
describes a relatively simple but efficient method of dimming details in a photo. Even a perfectly composed beautiful photo may not quite fit your design, especially when text is placed over the photo. This is where the "patchwork" method is useful.
Getting ready



The cover photo of the magazine shows a newly married couple sitting on a WWII vintage Willys Jeep, white strap lines (text) fitted nicely over the olive green jeep body. 
[image: Getting ready]
But the white markings on the car body were clashing with the white text, as seen in this detail, until a simple trick was applied to mute them.
[image: Getting ready]

How to do it...



The following steps 
describe how to do it: 
	Insert a rectangular shape with rounded corners into the document. In the Insert|Shape drop-down menu, the shape is called Rounded Rectangle.
	Open the Graphic Inspector, choose Color Fill, and pick the color of the Jeep with the color picker.[image: How to do it...]

	Using Arrange|Send Backward (Command + Option + Shift + B), move the shape behind the Text Box with the straplines (headings), and position it to cover the markings on the Jeep.
	Adjust the size of the shape and rotate it slightly.
	At the bottom of Graphic Inspector and in Colors Viewer, there is an Opacity slider. Drag it in either Graphic Inspector or Colors Viewer, to reduce the opacity of the shape. At around 75 percent, the markings are visible but dimmed.[image: How to do it...]




How it works...



Color picker is used to copy colors of graphic objects. Click on the color well in GraphicInspector. When the Colors Viewer opens, click on the color picker (the small icon of a magnifying glass next to the color well). Your cursor turns into a "magnifying glass"—the color picker. Move it over the Jeep and click on it to pick its exact shade of green for the Rounded Rectangle.
With the Opacity of
 the rounded rectangle reduced, our white straplines stand out on the cover while the patch leaves the photo clearly visible and barely obscured by the text. The photo is by the British photographer Mike Forster (www.imagesofnormandy.com).

There's more...



The same technique can be used to hide unwanted details in the photo, for example, if you want to hide the number plates on a car, for privacy reasons. Just make the color fill in the "patch" solid, not transparent. 
To rotate, press Command and drag the shape's handles, or for finer rotating movement, click on the  rotating arrows in Metrics Inspector. The shape must cover the white markings completely.


Making cutouts with edited masks



This is a
 cutout from a photo of my dog, Strelka the Golden Retriever.
[image: Making cutouts with edited masks]
You must have seen large, life-size cutouts of human figures used for advertising purposes. Such cutouts can also be used as logos, topical markers in brochures, or on websites, as elements of larger designs, for example in an ad for a dog kennel, a vet practice, or a pet food supplier, or as a stand-alone illustration on a page where text flows around an irregular shape/image. Newspapers and magazines love using cutouts on their fashion pages. A model walking down the catwalk is shown without the audience or podium—the background is removed completely.
The cutout of this dog was made with iWork tools. This recipe describes how to use them.
Getting ready 



Make sure 
that the photo shows all of the object that you will be cutting out. There shouldn't be any other objects that go over or obscure it, such as the dog's bowl or someone's hand.
Another step worth taking before starting a cutout is to deactivate the "snap to grid" function in iWork. When you move or edit objects, "snap to grid" makes them "jump" to cling to the layout grid or to align with other objects on the page. It is very useful when you want to place photos or other objects quickly within a layout. But when you are doing a complex graphic task, it may start driving you crazy.
[image: Getting ready]
To deactivate "snap to grid", under the application menu, say for Pages, open Preferences, click on Rulers, and then click in the checkboxes next to Alignment Guides to deactivate them. The text here says Show guides... but in fact the function is for activating or deactivating the guides, and with them the "snap to grid" function. To recap, here is the
 path:
Pages
|
Preferences
|
Rulers
|
Alignment Guides. 

How to do it...



Now, select the photo and mask it with a shape. 
	Under the Format menu, go to Mask with Shape, and choose a shape from the drop-down menu.[image: How to do it...]

	We can start with any shape, rectangle or oval; it doesn't matter at this point. Move and resize the mask so that the dog (or the object of your choice) is fully within the mask. 
	Under the Format menu, make the mask editable: Format|Shape|Make Editable.
	 Now the key point: add as many editing points as needed to make the mask "cling" to the contours of the cutout. Editing points are the little red dots that appear when you've made the shape editable. To add an editing point, press the Option (⌥) key as you move the cursor over the outline of the mask. When the little pen with a plus sign appears—click—and get an additional editing point.[image: How to do it...]

	Move each new editing point as close to the dog as possible, just barely touching it. To move an editing point, click to select; when the red dot turns white inside, you can move it by dragging with the mouse or hitting the keyboard arrow keys. 
	To avoid having to deal with a multitude of dots, you can use the curving function. To activate it go to the Format menu, slide to Shape, and choose Smooth Path. Click on curving handles and drag them to make the mask cling to the outline of the cutout. [image: How to do it...]

	When you have finished moving dots and curving the shape, click on the Edit Maskbutton in the masking control panel to get the cutout.[image: How to do it...]




How it works...



In this recipe, we discussed the following operations.
Making the mask editable



Under the Format menu, make the mask editable—Format
|
Shape
|
Make Editable.
All shapes in iWork, predesigned and drawn with the Draw tool, can be edited with Format
|
Shape
|
Make Editable. A triangle can be given the shape of a heart and a quote bubble can be turned into a thought bubble. What iWork users often overlook is that masks behave in the same way as shapes—the Make Editable function works with them too.
Move each 
new editing point as close to the dog as possible, just touching it. To move an editing point, click to select; when the red dot turns white inside, you can move it by dragging with the mouse or hitting the keyboard arrow keys. If we hadn't deactivated Alignment Guides at the beginning, the dots would have been jumping to align themselves with other dots, driving us to despair!
We can add dozens of editing points and move them to the cutout. If you feel you've added one too many, you can always delete them. To delete, click on the editing point to select it and hit Delete or Backspace. 
If the dark masking control panel gets in your way, click on it and drag it aside.

Curving the Mask



In the Format menu, select Shape and then Smooth Path. This will give the mask flowing, curving lines and each dot, when you click on it, will show two "propellers"—the handles that control the way the shape curves. Click on an editing point, click on one of the points at the end of the propeller, and drag them to make the mask cling to the outline of the cutout. Pull the propellers out or push them in, until you achieve the perfect "cling".
If you drag one "blade" of the propeller, another one also moves. To move them independently from one another, press Command while dragging. This trick allows us to make a really tight "cling" in awkward bits of the cutout, for example, near the ears or around the tail. 
Another useful trick is to change a smooth curve into a sharp corner, for example, to make the outline go around the locks sticking out of the dog's fur. To change the editing point from curving to cornered, double-click it.
Tip
If you start your cutout with an oval mask, the Smooth Path function will be activated as soon as you make the Shape (mask) editable. So, if at the beginning you see that your cutout has lots of curving contour lines, choose oval to mask it.

Depending on your project, the work should take about 15 to 30 minutes for a simple cutout or up to two hours for a more sophisticated design (not including photo research). 


There's more...



You can use Alpha images in iWork projects or elsewhere, for example in Word. In OS 10.7 Lion, Preview has the Alpha tool to remove background. If you need your cutout as a separate alpha image, save it as a PDF, open it in Preview, and remove the white background.
Using masking with a shape may sound like tricky business. It takes some time to master it. One alternative technique is the Alpha tool. It will only work, however, if the background is of a consistent solid color that is different from the color of the object, a black dog sitting on a white sheet for example. When using ordinary snapshots, Alpha may not achieve a cutout effect.
Here is what happens with this photo when Alpha is applied to it: 
[image: There's more...]
There are simply too many bits to rub out, and when you do try to rub them out, Alpha also tears out bits of the dog's coat. Just see which method suits you best.
This masking with shape technique can be used to "separate" people or objects from the background in the photo and put them in front of the text. It allows us to achieve a dramatic effect, for example on magazine covers or posters. In this magazine cover, the man's head is in front of the coverlines.
[image: There's more...]

See also...



	The Fitting files of other formats into iWork documents recipe in Chapter 3, Working Across Platforms and Applications
	The Making your own images by tracing photos and other images: drawing a Robin recipe in Chapter 7, Graphic Design: Making Your Own Logo




Chapter 6. Graphic Design—Working with Clip Art and Making Your Own



In this chapter we will cover:
	Making symbols from Character Palette into clip art—where to find clip art for iWork
	Using elements of iWork templates as clip art—clipping a photo to a hand-written note
	Making your digital photos into a piece of clip art
	Putting images inside letters—filling letters with photos and other graphic images
	Turning a star into a thought bubble—how to edit shapes


Introduction



A constant complaint on Internet forums is that iWork doesn't have clip art. No, there isn't a dedicated folder with predrawn images to add to our designs. But this doesn't mean that there is no clip art for iWork on our Mac computers.
In this chapter, we will see where to find clip art and how to make our own original images that can be used as clip art. With a few adjustments, or even without them, elements of iWork templates can also become clip art.
The recipes in this chapter will show a number of design techniques that anyone with a basic knowledge of iWork can first try—and then master—to achieve excellent results.


Making symbols from Character Palette into clip art—where to find clip art for iWork




Clip

art is the collective name for predrawn images, pictures, and symbols that can be quickly added to documents. In standalone products, a separate Clip Art folder is often added to the package. iWork doesn't have one—this has been the subject of numerous complaints on the Internet forums.
However, 


even though there is no clip art folder as such in iWork, there are hundreds of clip-art images on Mac computers that come as part of our computers. Unlike MS Office or Open Office that are separate Universes on your machine, iWork (even though we buy it separately) is an integral part of the Mac. It complements and works with applications that are already there, such as iLife (iPhoto), Mail, Preview, Address Book, Dictionaries, and Spotlight.
Getting ready



So, where is the clip art for iWork?
First, elements of the Pages templates can be used as clip art—just copy and paste them.
[image: Getting ready]
Look at this wrought iron fence post from the Collector Newsletter template. It is used there as a column divider. Select and copy-paste it into your project, set the image placement to Floating, and move it in between the columns or text boxes. The Collector Newsletter template also has a paper clip, a price tag, and several images of slightly rumpled and yellowed sheets of paper that can be used as backgrounds.
[image: Getting ready]
Images with little 


grey houses and house keys from the Real Estate Newsletter template are good to use with any project related to property. The index card image from the Back Page of the Green Grocery Newsletter template can be used for designing a cooking recipe, and the background image of a yellowing piece of paper from the Musical Concert poster would make a good background for an article on history.
Clip art in many templates is editable and easy to resize or modify. Some of the images are locked or grouped. Under the Arrange menu, select the Unlock and Ungroup options, to use those images as separate graphic elements. Many of the clip-art images are easy to recreate with iWork tools.
Bear in mind, however, that some of the images have low resolution and should only be used with small dimensions.
You will find various clip-art images in the following locations:
	A dozen or so attractive clip-art images are in Image Bullets, under the Bullets drop-down menu:Open the Text Inspector, click on the List tab, and choose Image Bullets from the Bullets & Numbering drop-down menu.
[image: Getting ready]
There, you will find checkboxes and other images. Silver and gold pearls look very attractive, but any of your own original images can also be made into bullets. In Bullets, choose Custom Image | Choose and import your own image.
[image: Getting ready]
Note
Note that images with shadows may distort the surrounding text. Use them with care or avoid applying shadows.


	Navigate to Macintosh HD | Library | Desktop Pictures:Double-click on the hard disk icon on your desktop and go to Library | Desktop Pictures. There are several dozen images including the dew drop and the lady bug. These are large files, good enough for using as background images. They are not, strictly speaking, clip art but are worth keeping in mind.
[image: Getting ready]

	Navigate to Home| Pictures | iChat Icons (or HD | Library | Application Support | Apple | iChat Icons):The Home folder icon (a little house) is available in the side panel of any folder on your Mac. This is where documents associated with your account are stored on your computer. It has a Pictures folder with a dozen very small images sitting in the folder called iChat
Icons.
National flags are stored here as button-like images. The apple image can be found in the Fruit folder.
[image: Getting ready]
The gems icons, such as the ruby heart, from this folder look attractive as bullets.
[image: Getting ready]

	Navigate to HD | Library | User Pictures:You can find 


animals, flowers, nature, sports, and other clip-art images in this folder. These are small TIFF files that can be used as icons when a personal account is set up on a Mac. But of course, they can be used as clip art. The Sports folder has a selection of balls, but not a cricket ball, even though cricket may have the biggest following in the world (Britain, South Africa, Australia, India, Pakistan, Bangladesh, Sri Lanka, and many Caribbean countries). But, a free image of the cricket ball from Wikipedia/Wikimedia can easily be made into clip art.
Note
There may be several Libraries on your Mac. The main Library is on your hard drive; don't move or rename any folders here. Duplicate images from this folder and use copies. Your personal library (it is created for each account on your machine) is in the Home folder. This may sound a bit confusing, but you don't have to wade through endless folders to find what you want, just use Spotlight to find relevant images on your computer, in the same way that you would use Google to search on the Internet.


	Character Palette has hundreds of very useful clip-art-like characters and symbols.You can find the Character Palette via Edit | Special Characters. Alternatively, open System Preferences | International | Input Menu. Check the Character Palette and Show input menu in menu bar boxes:
[image: Getting ready]
Now, you will be able to open the Character Palette from the screen-top menu. Character Palette can also be accessed through Font
Panel. Open it with the Command + T keyboard shortcut. Click on the action wheel at the bottom of the panel and choose Characters... to open the Character Palette.
Check the 



Character Palette box to find what you need. Images here range from the familiar Command symbol on the Mac keyboard to zodiac symbols, to chess pieces and cards icons, to mathematical and musical signs, various daily life shapes, including icons of telephones, pens and pencils, scissors, airplanes, and so on. And there are Greek letters that can be used in scientific papers (for instance, the letter π).
To import the Character Palette symbols into an iWork document, just click-and-drag them into your project.
The beauty of the Character Palette characters is that they behave like letters. You can change the color and font size in the Format bar and add shadows and other effects in the Graphics Inspector or via the Font Panel.
To use the Character Palette characters as clip art, we need to turn them into images in PDF, JPEG, or some other format.




How to do it...



Let's see how a character can be turned into a piece of clip art. This applies to both letters and symbols from the Character Palette.
	Open Character Palette | Symbols | Miscellaneous Symbols.In this folder, we have a selection of scissors that can be used to show, with a dotted line, where to cut out coupons or forms from brochures, flyers, posters, and other marketing material.  

	Click on the scissors symbol with a snapped off blade and drag it into an iWork document.Select the symbol in the same way as you would select a letter, and enlarge it substantially. To enlarge, click on the Font Size drop-down menu in the Format bar and select a bigger size, or use the shortcut key Command + plus sign (hit the plus key several times).
[image: How to do it...]

	Next, turn the scissors into an image.Make a screenshot (Command + Shift + 4)  or use the Print dialog to make a PDF or a JPEG. You can crop the image in iPhoto or Preview before using it in iWork, or you can import it straight into your iWork project and remove the white background with the Alpha tool. If Alpha is not in your toolbar, you can find it under Format |Instant Alpha.

	Move the scissors onto the dotted line of your coupon.

[image: How to do it...]


Now, the blade that is snapped in half appears to be cutting through the dotted line. Remember that you can rotate the clip art image to put scissors either on the horizontal or on the vertical sides of the coupon.
Use other 


scissors symbols from the Character Palette, if they are more suitable for your project.
Store the "scissors" clip art in iPhoto or another folder for future use if you are likely to need it again.




There's more...



There are other easily accessible sources of clip art.
MS Office clip art is compatible



If you have kept your old copy of MS Office, nothing is simpler than copy-pasting or dragging-and-dropping clip art from the Office folder right into your iWork project.
When using 
clip art, it's worth remembering that some predrawn images quickly become dated. For example, if you put a clip art image of an incandescent lamp in your marketing documents for electric works, it may give an impression that you are not familiar with more modern and economic lighting technologies. Likewise, a clip art image of an old-fashioned computer with a CRT display put on your promotional literature for computer services can send the wrong message, because
 modern machines use flat-screen displays.

Wikipedia/Wikimedia



Look on Wikipedia for free generic images. Search for articles about tools, domestic appliances, furniture, houses, and various other objects. Most articles have downloadable images with no copyright 

restrictions for re-use. They can easily be made into clip art. This image of a hammer from Wikipedia can be used for any articles about DIY (do-it-yourself) projects.
[image: Wikipedia/Wikimedia]

Create your own clip art



Above all, it is fun to create your own clip art in iWork. For example, take a few snapshots with your digital camera or cell phone, put them in one of iWork's shapes, and get an original piece of clip art. It could be a nice way to involve children in your project.


See also



	The Removing and changing background in photos with Instant Alpha recipe in Chapter 5, Working with Photos: Tips and Tricks
	The Using screenshots and PNG files—shortcuts, options, and tricks recipe in Chapter 3, Working across Platforms and Applications




Using elements of iWork templates as clip art—clipping a photo to a hand-written note



This recipe shows how to 

put together a project that uses elements of iWork templates as clip art. Here, we will make a hand-written note and clip an old picture to it.
[image: Using elements of iWork templates as clip art—clipping a photo to a hand-written note]
How to do it...



For using elements of iWork templates as clip art, follow these steps:
	Open a blank document in Pages, and then open the Collector Newsletter template.
	Copy-paste the image of a sheet of old notepaper.
	Then import the photo.Here, we will be using a portrait of the English writer Charlotte Brontë, the author of Jane Eyre.

	Go to the template again and copy the image of the paper clip. Paste it into your document.Importing elements in this sequence puts them one on top of another in layers—the sheet of paper in the background, then the photo, and finally the clip.

	Next, move the photo to a corner of the sheet of notepaper and give it a picture frame.In the Graphics Inspector, under Stroke, click on the drop-down menu. Choose Picture Frame, and click on the icon that gives the image a white frame and an angled shadow that creates an effect of an old photo with slightly bent edges. The size of the frame and the shadow can be altered by dragging the scale slider. In this example, it is set at 57%:
[image: How to do it...]

	Click on the clip and move it over the photo so that it looks as if it has been clipped to the piece of paper.
	Then, click on the Text Box icon in the toolbar and type your text. Here, we have two Text Boxes—one next to the portrait and another one below it. Make sure that the boxes don't have frames, color fills, or shadows; we only want the writing to be seen.If you add shadows, make sure they all go in the same direction. Rotate the shadow wheel in the Graphic Inspector to align shadows.

	To create a genuine handwriting effect, choose a font that mimics human handwriting.[image: How to do it...]
Here, we use Handwriting 
Dakota, but there are numerous other fonts that offer a handwriting effect. Click on the font family drop-down menu to the left in the Format bar and find one using font previews—the name of the font appears in the same way as it looks in the document. The Font menu only appears in the Format bar when you are inside the text box with the cursor blinking within the text. When a graphic image is selected, the Format bar only shows options for working with graphic objects, not text.
If the Font


menu doesn't show previews, activate this function under Preferences. Under the application menu—Pages, Keynote, or Numbers—go to Preferences | General. In the General preferences check the box against Show font preview in Format Bar font menu. If you are in too much of a hurry to fiddle with preferences, just press the Option key while clicking on the Font menu—previews will be shown temporarily.
[image: How to do it...]

	Move the text box over the sheet of paper, so that it looks as though the writing is actually on the paper, not in the text box. Resize the box, align it with the photo above it, and change the size and color of the text. We can, for example, use a dark blue color to make it look like fountain pen ink.
	Select all elements and choose the Group option under the Arrange menu. The composition can now be moved, resized, and copy-pasted as a single object.
	To create the effect of it lying on a desk as though being examined by someone, rotate it slightly to the left: press Command and drag one of the handles.



There's more...



Check out other templates in 

iWork to find clip art that suits your project. Think creatively; even though templates suggest particular fields of activity, their elements can be used for something completely different. A catering brochure, for example, has index cards that could also be used on a research paper for data boxes and squiggly lines that can serve as dividers in a collection of poetry or on a page with quizzes and puzzles.
Try modifying editable clip-art images from templates. In the catering brochure, the images of the knife, fork, and spoon are editable. Click on the image once, then click on it again and it will show red dots—editing points. Moving them with the mouse or keyboard arrows can turn them into something different—a tool or a human figure.
But do check clip art images for resolution. Some of them pixelate when enlarged.


Making your digital photos into a piece of clip art



On Internet forums, many iWork users are asking where they can find clip art to use with their projects. While there are dozens of websites that allow free downloads of clip art and the elements of iWork's own templates can also be used as clip-art images, it can still be difficult to find high definition images of exactly what you want, especially if you don't want to spend time registering, logging in, or paying download fees.
So, where can 

we find objects suitable for making into clip art?
Look around your house— cell phones, pencils, toys, mugs, kitchen utensils, furniture, DIY tools, even electric plugs—anything can be turned into clip art. Look in the garden or walk in the park and you will find that a leaf of ivy, a twig from a holly bush or from a frosted fir tree are all material for clip art.
Here is a pile of supermarket chocolate coins, which we could use as clip art for an article on the financial crisis:
[image: Making your digital photos into a piece of clip art]
How to do it...



To make your 

digital photos into a clip art, follow these steps:
	Set your digital camera to macro. Cell-phone cameras sometimes have macro settings too.Take a photo of the object you want to make into clip art. Make sure that the object is placed against a background with a solid color, which contrasts with the main colors of the object itself. Here, a pile of chocolate coins is on a sheet of white paper. A lighter object can be put on a black t-shirt. Another great background is blue sky—hold your object against the sky and take a snapshot.
[image: How to do it...]

	Import your photo into an iWork document.
	Remove the background with Instant Alpha.The 

Alpha tool is under the Format menu or in the toolbar. If it isn't already in the toolbar and you often work with images, put the Alpha icon in the toolbar. Under the View menu go to Customize Toolbar, and drag the icon to the toolbar.
[image: How to do it...]
When you activate 

Alpha, the cursor turns into a little cross. Move it over the background to rub out the background. Do this several times, rubbing out the background in several goes. Be careful not to scratch out bits of the object itself. If you accidentally scratch out some of the object, press Command + Z to undo the last operation. Or, remove Alpha—this radical option is under the Format menu. When you finish, hit Return.




There's more...



If you later find that you only want part of the image, you can use a mask to crop the photo—the rest of it will be hidden. The Masking function is under the Format menu.
[image: There's more...]
Clip art made 

with this technique can also be used as bullets within our text. Open the Text Inspector, click on the List tab, and then on Bullets. From the Bullets drop-down menu, choose Custom Image and click on Choose. Find your clip art image and open.
If you want to use the Alpha image, that you have created, in other iWork projects, copy-paste it from your document. You can also make a screenshot (Command + Shift + 4) and keep it as a separate file.
The current version of Mac OS, Mountain Lion, has Alpha in Preview. Open your photo in Preview, remove the background with Alpha, and save, for using in iWork or other applications.
If you need to reduce the size of the image, for example to use on your website, use the Save
as... dialog window to make it smaller.
Note
If you are uncomfortable with using Alpha, try making a cutout of the image in your photo with an edited mask.


See also



	The Making cutouts with edited masks recipe in Chapter 5, Working with Photos: Tips and Tricks




Putting images inside letters—filling letters with photos and other graphic images



Transparent letters with images showing through them can be used to create a striking design effect. It is very attractive for a range of design purposes, such as magazine covers, flyers, posters, logos, cards, and clip art.
While there isn't a 




straightforward tool to put an image inside letters, it can be done in iWork in just a few simple steps.
How to do it...



The following is a beautiful panorama of Manhattan (photo by Daniel Schwen):
[image: How to do it...]
Let's put it inside New York's famous promotional slogan shown in the following screenshot, where a clip-art image of a heart replaces the word love.
[image: How to do it...]
	Create a text box and type the text shown in the following screenshot:[image: How to do it...]
The heart shape is available in Character Palette | Symbols | Miscellaneous. If you haven't used Character Palette before, you can find it under System Preferences | International | Input Menu. Tick the checkbox here to activate the Character Palette. Also, check the checkbox at the bottom of the window to show the palette as an option in the screen-top menu.
Make the text bold and enlarge it. Choose the richest, thickest font or font variation. We will need this so that the images are clearly visible within our letters. Here, Myriad
Pro
Bold is used, but Helvetica, Verdana, and many other font families also have bold and condensed variations. Impact font is very thick.
Make the text as large as your page allows. Here, the size is 177 points. Reduce character spacing (it is also called kerning
) to squash text, so that the letters are nearly touching one another—but don't overdo it; make sure the word(s) are still easy to read. Character spacing can be adjusted  by using the Character slider under the Spacing section in the Text Inspector. In this example, it is set at -5%.

	Turn the text into an image.We 




can make a screenshot of the text. Press Command + Shift + 4 and drag the crosshairs over the text. A PNG file will appear on our desktop. Or we can make a PDF or JPEG of the page and crop it later.

	Import the photo into a blank iWork document.We can, of course, import the photo into the document that we've already created, but it can be easier to work in a new document, with the text box out of the way.
Choose a horizontal (landscape) page setup, because the photo itself has a horizontal composition.

	Import the image of your letters and move it over the photo.Position the image with the black text on a white background in the center of the composition.
[image: How to do it...]

	Remove the black text with Alpha.You can find Instant Alpha under the Format menu or in the toolbar. When you activate it, the cursor changes its shape to a cross, which—as you move it over the image—rubs out the colors.
Click on 




each of the black letters and drag the cursor across them—as the color is rubbed out, you begin to see the photo appearing inside the letters.
[image: How to do it...]

	Resize and move the photo around.To achieve the best results, it is important to position the image inside the letters in such a way that its elements can be recognized. In the panorama of Manhattan, for example, we obviously want the Empire State Building to be visible, as it is such an important New York City landmark. Select the photo, move it around, and resize to find the ideal position.

	Save the iWork document.We can export 




our design to PDF, JPEG, PNG, and other formats, depending on how we plan to use it. For printing on cards or mugs, the high-resolution PDF is preferable. JPEGs and PNGs can be used on the Internet.
[image: How to do it...]




There's more...



This technique may seem complicated but in fact doesn't take longer than 15 to 30 minutes. It is ideal for magazines, book titles, logos, and other promotional material. Designs like this can be transferred to billboards, t-shirts, and mugs.
Not just one, but several, photos can be put inside the lettering. Choose different landmarks, make a collage, and then place the text over it.
In this example, we've used 




black letters on a white background, but of course it could be white letters on a colored background. Alpha tool will rub out white as well as black.


Turning a star into a thought bubble—how to edit shapes



There are



 thousands of websites offering downloadable clip art. One of the popular items is the thought bubble, which is used in comics, photos, and other graphic images. Quote and thought bubbles are also widely used in advertising and logos.
iWork has an oval and a rectangular quote bubble. In an open document, click on the Shapes menu in the toolbar and select one of those.
But what about the thought bubble? In this recipe, we will see how to make a thought bubble out of a star shape, which is also available in the Shapes menu. Furthermore, we will give it our own original style.
Here is the finished picture of my cat Vaska lying half-asleep on the dining table.
[image: Turning a star into a thought bubble—how to edit shapes]
How to do it...



Follow these steps to 



make a thought bubble:
	Insert a star shape from the Shapes toolbar menu.The star appears with a small control panel that allows us to increase or decrease the number of points. Here, we leave the star with five points.
There is also one editing point in the star. Drag it to change the star to either spiky with sharper and thinner points, or chunky with a fuller body and less protruding points. Let's choose a chunky shape, which is closer to our target.
[image: How to do it...]

	Under Format, choose Shape | Make Editable.The shape will show little red dots—editing points.

	Next, again under Format | Shape, choose Smooth Path.
	Change Color.At this point, you may want to change the default color of the shape to the one that you want to give to the thought bubble. Here, we will use a light shade of blue.
[image: How to do it...]

	Curve the points of the star.When we make the shape smooth, its contours become curvy and when we select a red editing point, it shows propellers—two handles with small circles at the end. Click on one and hold, then drag it around, and pull out or push inside to change the curve. With the star shape, one advantage is that we need very little curving.
But only curve the outer points!
If you want, add editing points to give the future bubble more curves. To add, press the Option key and move the cursor to hover over the outline of the shape. When it turns into a little pen with a plus sign, click on it. The shape must be selected and must show editing points.
If you accidentally deselect the star, click on it once, pause, and click again—the editing points will reappear.

	Double-click on the editing points that are closer to the center of the star, one by one.This removes the smoothness from the curve. The lines coming out of the editing points that we have clicked now form an angle, not a rounded curve. The shape begins to look like a five-petal flower.
[image: How to do it...]

	Next, move the inner, angled points slightly outward, so that the shape looks like a cloud rather than a flower.To move an editing point, click on it to select and drag or hit the keyboard arrows. When we drag an editing point, it may suddenly jump and align itself with other dots. This means that the Alignment Guides snap to grid function is active. To disable it while working on the design, press Command when you start dragging.

	Leave the bubble and add a few oval shapes.Give them the same color as the bubble, resize them so that they are progressively smaller than the bubble, and form a train of thought going to the thinking character in your design.

	Double click in the main shape and type in your text.[image: How to do it...]
If your text is too long to fit inside the shape, you may find it easier to put it in a Text Box and format and resize it separately from the bubble.

	If you don't like the train of thought bubbles but want a spike-shaped callout going to the thinking character, add two editing points to the left and to the right of one of the angled points.[image: How to do it...]

	Then, click on the editing point in between the two new ones and drag it outside, towards the character in your picture. It will become a spike pointing at the thinker. Use the propellers to make the spike curving.
	We can design the thought bubble right over the photo, or do it separately in another document and then select all the elements and copy-paste them into the project where the bubble is to be used. Then, we can also make a few final adjustments.Note
Remember that for the outer contours of the bubble, you can use different line styles and add shadows. Both lines and shadows can have different colors. In the Graphic Inspector, add the line that looks like a ribbon and give it a light gray color and a shadow of the same color—the thinking effect becomes stunning as you can see in the picture at the beginning of this recipe.





There's more...



iWork has predrawn quote bubbles in the Shapes toolbar menu, and oval and rounded rectangle shapes are available under Insert | Shape. Both already have editing points to change the width and direction of the spike and also the corners of the rectangle.
Using the same technique as we've used with the star, we can turn these quote bubbles into thought bubbles. However, because the star shape already has a number of points that can easily be curved into a cloud, you may find it easier to transform a star into a thought bubble.


Chapter 7. Graphic Design: Making Your Own Logo



In this chapter, we will cover:
	Editing basic shapes to create a logo
	Adding or deleting editing points to create a heart shape
	Drawing logos with the free draw tool: Picasso's dog
	Rectangle, oval, and arrow: stacking, editing, and finding the right color
	Drawing a human shape and turning it into a logo
	Making your own images by tracing photos and other images: drawing a Robin
	Writing letters for your logo with the draw tool: the principles of a good logo


Introduction



Logos are graphic images used to promote groups, companies and organizations. They are put on products, advertisements, stationery, websites, and e-mails.
Making a distinct, instantly recognizable logo is crucial for success in marketing or public relations campaigns, in business, or even for individuals who want to make it easier for friends and co-workers to find their work.
Big organizations spend huge amounts of money on simple, striking images and on promoting them. But making a good logo needn't be expensive. With patience and creativity, anyone can make one.
Recipes in this chapter show how to create a unique logo with iWork tools, using shapes and letters. They cover editing shapes and manipulating widely available fonts to give your logo an original look.


Editing basic shapes to create a logo



In this recipe, we learn how to edit basic shapes to create unique logos.
Getting ready



There is a Shapes

drop-down menu in iWork's toolbar. Click on it to get a selection of predrawn shapes. Each can easily be made into an original logo with just a few changes. Knowing how to edit these standard shapes is the first step towards creating original logos. We only need a few customizations to make them our own.

How to do it...



Firstly, 
resizing, simple as it is, gives the shape a one-off, branded look.
	To resize a shape, select it and drag the handles—the small white squares in the corners and in the middle of each side of the shape—until you get your required look.
	If the shape refuses to be stretched or squashed, this means that it has its proportions constrained. Go to Metrics Inspector and uncheck the Constrain Proportions box. In the following image, an oval and a diamond from the Shapes menu are squashed into a more horizontal shape.[image: How to do it...]


[image: How to do it...]



	Double-click in the shape and type your initials or the name of your organization to get a basic logo.


Changing the color fill, the thickness of the shape's outline (borders) and the color of the outline can be done in Graphic Inspector or with the options in the Format Bar under the main iWork document Toolbar. This image shows a triangle, from the Shapes menu, that has been stretched upwards. Follow these steps to work on the triangle through the Graphic Inspector: 
[image: How to do it...]
	To change the color, click on the drop-down menu under Fill, and choose Color Fill.
	Click on the color well to open the Colors Viewer and choose a light blue color called Sky, in the box of crayons.
	Under Stroke|Line, click in the color well, and in the Colors Viewer choose the dark blue color called Midnight.
	Click on the up arrow next to the line width window and set it at 5 points.
	Next, we can double-click inside the shape and type a large letter—your initial or a letter that represents your organization—to get a simple logo.


Some 
of the pre-drawn shapes in the Shapes menu have additional editing features. Besides resizing and changing colors and thickness, you can change the way the shape looks by dragging the blue editing handles. The rounded rectangle, arrow, double arrow, quote bubbles, and the star have editing handles. The star and the polygon have control panels with sliders that change the number of points in the star and the number of sides in the polygon. Follow these steps to change the look of the star:
	Insert the star from the Shapes menu
	Drag the slider left to change the number of points from five to four.
	Drag the blue editing handle to change the points, giving them a thinner, sharper shape.[image: How to do it...]



Making shapes editable is 
another powerful editing feature. Use the following steps to see how to edit a triangle.
	Insert a triangle from the Shapes drop-down menu in the Toolbar of your document or from Insert|Shapes|Triangle.
	Make the triangle editable, thus: Format|Shape|Make Editable.
	Double-click on the upper editing point on the triangle to curve it.
	When the top becomes curved, it shows "propellers"—curved handles. Click on the tips of the propeller blades and hold, drag up and down, left or right, and extend or push in to adjust the curves, making them more or less rounded.
	Now that we have a shape that looks like a shelter or a tent, double-click inside it and type the name of your camp site or refuge, and get a logo![image: How to do it...]




How it works...



Shapes with 

corners retain their angular shape after being made editable. Rounded shapes like the oval and the rounded quote bubble, when made editable, show curved handles when you select an editing point—they are like two-blade propellers. When you rotate the propeller it changes the flow of the curve, allowing us to create shapes with unusual contours.
For shapes that have already been made editable, Format
|
Shape Path has two more options: Smooth Path and Sharpen Path. Go to Format
|
Shape
|
Smooth Path, and an angular shape will become rounded. Go to Format
|
Shape
|
Sharpen Path, and a rounded shape will become angular. For example, if we insert an oval from the Shapes menu, make it editable and then choose Sharpen Path; it will turn into a square.
This is not all. Each 
editing point can be turned separately from angular to rounded, and vice versa. Double-click on a red editing point and a curved line will become angular, with the red dot showing the top of the angle.

There's more...



The same editing technique can be used for more complex designs where several shapes are combined to create an image.
[image: There's more...]
The eyes in this image are triangles that have been made editable and have had one angle rounded.
Tip
You don't need to draw the second eye from scratch. Just duplicate the shape—Command + D—and change it slightly for symmetry or to give the face more expression. This applies not just to the two eyes, but to the heart shape as well. The cloud of little "dreamy hearts" are duplicates of the main heart shape.



Adding or deleting editing points to create a heart shape



A stylized heart shape is a familiar symbol. It can signify love and also a range of services and businesses—health and fitness, medical and pharmaceutical, caring, and match making.
In iWork, we can create an original heart shape in a few steps, beginning with a triangle, one of the basic geometric shapes.
How to do it...



The following steps describe how to turn a 
triangle into a heart.
	Choose a triangle from the Shapes drop-down menu.
	In the Graphic Inspector, click on the Fill drop-down menu and choose Color Fill. Click in the color well and choose a shade of red in the Colors Viewer to change the default color of the triangle.
	Make the triangle editable. Go to Format|Shape|Make Editable.[image: How to do it...]

	The editable triangle shows red dots—editing points. Double-click the lower two editing points. They become rounded, and when selected, each shows two gray propeller-like handles. Click and hold on the propeller tip, and rotate and extend it to change the curves of the shape.
	Repeat this with the second propeller blade.
	Next, click to select the second editing point and rotate its propellers to give a symmetrical curve to the other side of the shape.[image: How to do it...]

	Add an editing point in the middle of the lower side of the shape to make a dip. Press the Option key and move the cursor to the outline of the shape. When it turns into a small pen with a plus sign, click, and an additional editing point appears.[image: How to do it...]

	Move the new editing point towards the center of the shape by pressing the keyboard Up arrow.[image: How to do it...]

	Double-click on the editing point to make it angular.
	Rotate the propellers of each of the editing points to achieve the desired look.
	If you want a stronger inward curve, add two more editing points to the sides and curve the outline of the heart inwards.[image: How to do it...]

	To delete the added points, if you change your mind and decide that you prefer it as it was before, click on the editing point to select it and hit either the Backspace or the Delete key.
	Rotate the heart to turn it the other way up. Click away from the shape and then click once again on it, to select without activating the editing points. Press Command and drag one of the handles to rotate. You can rotate in 45 degree increments by pressing Command + Shift while dragging. Stop when the shape is vertical, or don't press Shift and deliberately leave it slightly tilted.



There's more...



We can also draw the 
heart with the draw tool, the last icon in the Shapes menu.
Choose the draw tool and click in an iWork document. Each new click creates a dot linked by a line to the previous dot. Four connected dots will make an angular shape. Make it editable, thus: Format
|
Shape
|
Make Editable. Then, curve the line where needed, by double-clicking the editing points.
If you want two hearts in the logo, you don't need to create a new shape from scratch. Select the heart and copy it—type Command + D. Rotate each shape slightly to create a "meeting hearts" effect.
There are a number of heart symbols in the character palette that can be used for logos or clip art.
To open the character palette, go to Edit
|
Special Characters.
[image: There's more...]
Heart symbols are in 

Character Palette
|
Symbols
|
Miscellaneous. Click on a symbol and drag it into an iWork document. To use one of these as a graphic image, enlarge the symbol as you would enlarge text; give it a color, make a screenshot or export the document to PDF or iPhoto, and then crop.
To give the shape more substance, we can use the Gradient or Advanced Gradient fills in Graphic Inspector. Gradient Fill blends two colors within a shape. Advanced Gradient Fill allows blending of more than two colors. Click on the color well  and choose the blending colors in the Colors Viewer. In this example, (the following image) there are two different shades of red on the sides and white in the middle.
[image: There's more...]

See also



	The Making symbols from Character palette into clip art—where to find clip art for iWork recipe in Chapter 6, Graphic Design—Working with Clip Art and Making Your Own




Drawing logos with the free draw tool: Picasso's dog



What is 
more catchy than an animal shape? Stylized shapes of cats, dogs, parrots, roosters, horses, and cows are often used as logos.
When the famous artist Picasso was going through a period of experimentation with minimalist drawings, he drew a shape of his dog, a Dachshund.
[image: Drawing logos with the free draw tool: Picasso's dog]
This is a copy of Picasso's drawing, The Dog. It is not a copy as in copy-paste, but as in a re-drawing of someone else's drawing, by hand. In other words, it is an original artwork. As such, it can serve as your own original logo.
Getting ready



The draw tool works by connecting dots created by clicking with a small pen-like cursor.
In the Shapes menu, choose the last option (or go to Insert
|
Shape
|
Draw a Shape). When the cursor turns into a pen tip, click in an iWork document and click again. The two dots will be connected by a line. Several dots will create a shape that takes the color fill and line style preset for the template you are using. We can change it as the work progresses. When you make a full circuit, and after several clicks with the pen, click on the first dot again, the shape closes. It can then be edited further. If you double-click on the last dot instead of, clicking once on the first, the first, the shape remains open. Remove the color fill, and only a line will remain.

How to do it...



Let's draw 
Picasso's dog using this tool.
	Draw the rough outline with connecting dots.[image: How to do it...]

	Remove the Color Fill effect by choosing None under Fill in the Graphic Inspector. 
	Make the shape rounded by going to Format|Shape|Smooth Path.
	Double-click on the two editing points at the top of the front and back paw to make them angled.
	Add thickness to the body. In the Graphic Inspector, click on the up arrow under the Stroke and Line options.
	Click on each editing point and rotate curved handles to adjust the curves of the body.
	Move the editing points by dragging or pressing on the keyboard left, right, up, and down arrows to make final adjustments to the shape of the body, for example, to extend the tail or make the ear bigger. The shape should look similar to the following image. Here, it shows the (red) editing points and a "propeller" at the top of the ear.[image: How to do it...]

	Change line styles to create different looks for the dog. Click away from the shape and then click on it again to select it. Go to the Graphic Inspector, and under Stroke, click on the line styles drop-down menu to choose one. There is a choice of lines.[image: How to do it...]

	Add color to the image (optional). With the image selected, go to Graphic Inspector and choose Color Fill from the Fill drop-down menu. Click in the color well and choose a color when the Colors Viewer opens.



How it works...



Changing line styles changes the picture dramatically. Here is what the dog looks like if we choose the fourth from top, fluffy line style:
[image: How it works...]
And here's a 
Chinese calligraphy-style image:
[image: How it works...]
The last line style in the drop-down menu turns the Dachshund from short-haired to wire-haired. Add color fill to "flesh" its body. In this example, the color is Mocha from the Crayon box.
[image: How it works...]
The drawing, when you look at it closely, is one continuous line representing the contours of the dog. We can start with the lower right-hand side of the dog's muzzle or with the front paw. Click once to start the shape, and then keep clicking, putting dots where you see that the line changes direction. We don't need too many dots. And anyway, if we see that an additional one is needed, we can always add it later.
Angular and curved points



When designing a custom shape, if we simply click with the pen, the shape will turn out angular. The lines coming to each new point form an angle. If we slightly drag the mouse around after clicking, the line becomes curved and the dot shows two curved handles that look like propellers.
When you begin
 creating an image with the draw tool, more often than not you can immediately see where you will need curves and where there should be angles. With the dog shape, however, it's probably easier to make the rough outline first and then tackle curves and angles, because there are so many points. After the rough outline is finished, make it rounded—Format
|
Shape
|
Smooth Path—or go through each red dot (editing point) and double-click where you want it to curve.
By default, propellers point in opposite directions. When we drag one, the other also moves. For more difficult curves, you may need to move the propellers independently of each other. Press Command while dragging, and the propeller blades will move separately. The nose, for example, even though it looks pointed, is in fact a curved point. So is the end of the tail. The sharp angle is created by rotating the propellers back towards the body.
[image: Angular and curved points]


There's more...



This logo uses an image of the Dachshund. Of course, if we are fans of Spaniels or Setters, we can edit the shape further. We can shorten the body or make the legs longer and the muzzle shorter, to make it look like our favorite breed. If you like Huskies, edit the ear from droopy to pointed upwards, and get a different original shape.


Rectangle, oval, and arrow: stacking, editing, and finding the right color



We can create a simple logo that is memorable and clearly visible from a distance by stacking pre-drawn shapes from iWork's standard menu.
Getting ready



This simple logo consists of three shapes included in iWork's Shapes menu—an arrow, an oval, and a rectangle.
The oval and arrow resemble the letter Q for "question". The logo could be used for a questions-and-answers section in a publication or on an internet page or a consultancy or civic group.
[image: Getting ready]

How to do it... 



Shapes are in the Toolbar under Insert
|
Shape. In this design, they are stacked, edited, and colored. The following steps describe how to design the logo.
	Insert an oval into the blank iWork document.
	In the Metrics Inspector, uncheck the Constrain Proportions box, and under Size, type in the dimensions 2.85 x 3.24 in (7.23 x 8.22 cm).
	In the Graphic Inspector, under Fill, choose None in the drop-down menu.
	Set the thickness of the oval outline at 28 points. Type in the size in the width window under Stroke|Line.[image: How to do it...]

	Give the outline of the oval a blue color. Under Stroke| Line, click in the color well, which turns dark gray, and in a few moments the ColorsViewer opens. Click on a blue color in the Crayon box or create your own shade by dragging the small editing dot in the color wheel. [image: How to do it...]

	Add an arrow from the Shapes menu. Choose the thick arrow with one arrowhead. 
	Resize and reshape the arrow by dragging the shape's handles and the round editing handle at the base of the arrowhead.
	To color the arrow red, go to the Graphics Inspector, and under Fill, choose Color Fill and click in the color well. Its frame turns dark gray. When the ColorsViewer opens, click on a red color in the Crayons Box, or create your own shade by dragging the small editing dot in the color wheel.
	Stack to combine the oval and the arrow—click on the arrow and drag it over the oval. 
	Next, rotate the arrow to a diagonal position. To rotate, press Command and drag one of the handles. 
	Resize the arrow so that it resembles the stroke in a capital Q.


We can stop here or we can do more. 
	Add a rectangle from the Shapes menu; give it a white color fill and its outline a thickness that is slightly less than the thickness of the oval. Here, the color of the outline is the same as the color of the oval. 
	Move the rectangle behind the oval and the arrow, thus: Arrange|Send to Back.
	When you are satisfied with the result, select all three shapes and group them, thus: Arrange|Group.



How it works



By default, the oval will in fact be a circle when we insert it. Shaping it into an oval resembling the letter O evokes a range of positive associations: O for open, for agreement, discussion at the round table, for harmony and solutions.
The shape can be in any dimensions that you feel comfortable working with, but remember that at the end of the process it will have to be converted to an image that can be used in various file formats and sizes. To make it work well with whatever dimensions it will finally appear in, it is best to work on the original design in the largest dimensions possible.
There are several different styles of arrows in the Shapes menu. The thick arrow with one "arrowhead" has an additional feature: a round editing handle at the base of the arrowhead. Dragging it changes the thickness of the arrow's stem, while leaving the head as it is.
[image: How it works]
Because we added the arrow after the oval, it will go over the latter. Each new shape we add to an iWork document, including Text Boxes, goes over the previous one, much like paper documents that we pile on our desk. 
In this example, the oval's outline is 28 points thick and the Arrow is 102 x 45 points with a 1-point black outline. You can set dimensions by eye, by simply dragging the shapes' handles or by typing your chosen measurements in the Graphic Inspector and, for the arrow, in the Metrics Inspector.
A rectangle combined with an oval may remind one of the "squaring the circle" idiom (which means solving a seemingly unsolvable problem). The rectangle needn't be square; its height may be slightly more than its width. In this example, it is 274 points wide and 281 points high.

There's more...



You can store the finished logo as an 
iWork document and also export it to PDF. For other formats, to crop and reduce size, use Preview options and tools. The Save as... option in Preview also gives a selection of file formats, including TIFF, PNG, and .amd; you can save your logo in these. You can also remove the white background from around the logo and inside it, too. To do this, use the Alpha tool, included in Preview in the current Mac OS.
Once you've publicized your logo—put it on marketing material, on stationery, registered it as a trademark and put it on the Internet—it's better not to change it, at least for some time. Customers quickly get used to recognizable logos and look out for favorite brands in internet searches, in magazines, brochures, and catalogs.
But, it is safe to turn it into a black-and-white image, for example, to use on black-ink-only printouts. Ungroup the three shapes under the Arrange menu, select shapes one-by-one, and change the Color Fill of the arrow and the color of the stroke in the oval and the rectangle to black.
[image: There's more...]
If you want to use your logo as a watermark—the semi-transparent symbol or logo that appears as a "wash" in the background of your documents—choose Send to Back or Send Object to Background, under the Arrange menu. You may want to reduce the logo's opacity to about 30 percent. To do this, drag the Opacity slider in the Graphic Inspector. If your logo consists of grouped iWork shapes, you will have to ungroup them and reduce the opacity of each. If it is a PDF or JPEG image re-imported into an iWork document, you can reduce its opacity in one step.


Drawing a human shape and turning it into a logo



This is a logo with two
 human shapes, that of a man and a woman. It could be a logo for a fitness club or a dancing class.
[image: Drawing a human shape and turning it into a logo]
We see stylized human shapes in logos for organizations and businesses working in the service industry, in communications, and in health care. 
In this recipe, we will see how to design a logo with human shapes.
Getting ready



Open a blank 
iWork document and insert an oval shape from the Shapes menu.

How to do it...



Follow these steps to create the logo.
	Make the oval editable by going to Format|Shape|Make Editable. 
	Change the color. In the Graphic Inspector, click on the color well and choose a "human body" color in the Colors Viewer.[image: How to do it...]

	Rotate the curved handles—the "propellers"—to give your shape the silhouette of a body. Click on one of the red editing points in the lower part of the shape to select it. To form the legs, click on the gray tip of the propeller pointing towards the middle of the lower part of the shape, press Command, and drag up towards the center. The curve will bend upwards.[image: How to do it...]

	Repeat with the second leg. Adjust the curves to give the legs a more "natural looking" width. The shape now looks "fat", but we will deal with this later.
	For the shoulders, at the top of the shape, press Command and rotate one of the handles that is pointing towards the middle of the shape down towards its center. The curve will bend downward.[image: How to do it...]

	Repeat for the second shoulder.
	For the waist, at the top of the shape, press Command and rotate the outward-pointing handle down and towards the center of the shape.[image: How to do it...]

	Repeat on the other side of the shape. This way we create a "waist". 
	At the bottom of the shape, rotate the propeller blades, which are pointing outward, up and to the center to finish forming the "waist". Repeat with the upper and lower parts of the shape.[image: How to do it...]

	For the head, insert another oval shape. Without making it editable, resize the oval so that it is in proportion with the body. Move it to the top of the shape.
	To have two figures in the logo, select the body and the head, and duplicate (Command + D). In the Metrics Inspector, flip the second shape horizontally so that it looks as though two people are coming towards each other.[image: How to do it...]




How it works...



There are two ways in which shapes behave when we make them editable. They are either angular, with sharp points, or rounded, with contours smoothly curved around each editing point. You'll find the Sharpen Path and Smooth Path options under Format
|
Shape.
When we choose a 
shape with which to start a design, we need to look at what we are trying to achieve at the end. If the result is going to be angular, it may be better to start with a rectangle, because when you make it editable it takes the Sharpen Path option automatically.
If the end result is to be rounded, start with an oval. When you make the oval editable, it takes the Smooth Path contours.
The shape that has been made editable will show red dots—editing points. When we click on an editing point, it turns white and shows two rotating handles that look like a propeller. Click on the tip of the propeller and drag to change the curves of the oval shape. Propellers can be pulled to extend them or pushed in to shorten. This changes the curves of the shape.
The two blades of the propeller move simultaneously—when you drag one, the other one moves too. To mold the shape into a human body, giving it arms and legs, we need to move the blades independently. To do this, press Command (or Option) while dragging the handle.
When resizing the oval for the head, press Shift and drag the handles. If we don't press Shift, the oval will lose its proportions and become a squashed ellipse. Another way to keep proportions is to go to the 
Metrics Inspector and check the box named Constrain Proportions.

There's more...



If we want to show that the two shapes are a man and a woman, we can give the man's shape broader shoulders and the woman's a thinner waist by adjusting the curves. If this is not enough, add a fun touch.
[image: There's more...]
For the man's head, use a rectangle instead of an oval, and for the woman's, use a quote bubble from the shapes menu. Drag the spike of the quote bubble to the top so that it looks like a pony-tail. 


Making your own images by tracing photos and other images: drawing a Robin



This is a photo of an 
English Robin, a bird often seen on Christmas decorations and cards, and next to it a logo created by tracing the photo in an iWork document.
[image: Making your own images by tracing photos and other images: drawing a Robin]
When designing a 

logo based on a real life object, it is much easier to use the "tracing paper" technique. Tracing paper is what tailors and engineers used to use to make copies of paper patterns and blueprints. Thin, semi-transparent paper was put over an image, which showed through the paper. Contours of the image were then traced with pen and ink. 
The same method can be used in iWork with the draw tool.
Getting ready



Find and import a picture of a robin (this photo is by Diamonddavedj).

How to do it...



The following steps describe how to make the image.
	Choose the draw tool—last option in the Shapes menu.
	Trace the outline of the bird's body by clicking over the photo with the draw tool. Drag the mouse around slightly after each click, to make the line curve. 
	After going round the full circle, click again on the first dot. The shape will close. 
	Adjust the shape so that its editing points are positioned over the edges of the bird's body.
	Adjust the curves of the shape by rotating the curved handles of the editing points.
	In the Graphic Inspector, choose Fill|Gradient Fill.
	Click on the top color well and when the Colors Viewer opens, choose Iron for the top mixing color.
	Click on the bottom color well and choose Aluminum for the bottom mixing color.
	Rotate the gradient Angle wheel to around 220 degrees.
	Under Stroke|Line, click on the Line styles drop-down menu and choose the style that gives the shape a ruffled look.
	Set the thickness of the outline at 2 points in the width window under Stroke|Line.[image: How to do it...]

	Click in the color well next to the lines menu, and choose Cayenne from the box of crayons in the Colors Viewer.
	Move the body shape aside and use the same tracing technique to recreate the shape of the robin's breast. Trace the contours of the patch with the clicks of the draw tool.
	When the shape is closed, adjust its curves, choose Gradient Color Fill, and pick its colors with the color picker. Move the photo of the robin aside and click in the color well of the first gradient color. When the Colors Viewer opens, click on the magnifying glass icon next to the color well and click on the top of the orange-colored patch on the bird. Repeat for the bottom of the patch. Rotate the gradient angle wheel in the Graphic Inspector.
	To give the patch a smudged effect, under Stroke, choose a Picture Frame with blurred edges.
	To create the bird's eye, import an oval from the Shapes menu. In the Graphic Inspector, give it a black color and reshape to a vertically stretched oval by dragging its handles.
	Duplicate the oval and give the new oval a white color. Press Shift to constrain proportions, and drag the handles to make it smaller. Move it over the black oval.
	Select both ovals and group them by using Arrange|Group or hitting Command + Option + G.
	Press Shift and drag a handle to make the oval smaller than the bird's eye.[image: How to do it...]

	Move the main body shape, the breast, and the eye to form the shape of the bird.
	To create the robin's beak, wings, and tail, import triangles for the beak and wings and a rectangle for the tail, from the Shapes menu.
	Make these shapes editable under Format|Shape|Make Editable. Put the shapes over the photo of the bird and move the editing points to make the shapes look like parts of the bird's body.
	To draw the legs, choose the draw tool from the Shapes menu and click over the bird's legs in the photo. To finish the line, double-click on the second dot. Each leg consists of three lines.
	 Give the lines a color—in the Graphic Inspector, click on the color well under Line and choose Mocha from the box of crayons.[image: How to do it...]
Tip
Don't overwork the finer elements of the image; remember, you are creating a logo, not a piece of fine art. A logo should be instantly recognizable, even from a distance.





How it works



We can draw 

custom shapes with the draw tool by clicking in the document several times. Each click creates a dot that is connected to the previous one by a line. 
The draw tool creates either an angular or a curved line. As the robin's body is rounded, we need a curved line. To draw a curved line, drag the mouse around slightly after each click—the line will curve. 
We don't need too many dots to create an outline; just click on the edge of the body in the photo. To make our line follow the contours of the body, move the red dots—the editing points. They are moved by dragging the cursor or by using the keyboard arrows.
Each editing point, when selected, shows two propeller-like handles. Click on the tip of the propeller to rotate and extend it. This changes the curves of the shape. Make them follow the curves of the robin's body.
When resizing

 the bird's eye, if you find it difficult to make the shape very small by dragging, consider using dimension arrows in the Metrics Inspector. The second white oval is the real gem; without it, the robin's eye would look dull, but adding the white gives it the twinkle that makes the whole image come alive.

There's more...



Make two shapes for the robin's tail—full and clipped. We may need a clipped tail to make it look as if it's hidden behind a tree stump. If the image is to be used without the stump, we can give it a full tail.
Creating an image like this can also be done with a mask that is made editable. Put a mask over the photo and go to Format
|
Shape
|
Make Editable. Then add more editing points and make them curved.

See also



	The Making cutouts with edited masks recipe in Chapter 5, Working with Photos: Tips and Tricks




Writing letters for your logo with the draw tool: the principles of a good logo



A good logo 
has to be simple, visible from a distance, recognizable, and easily differentiable from other logos and trademarks.
If we bear these principles in mind, what comes immediately to mind? Initials, of course!
To use our own initials or the name of our business for a logo, we can choose an existing font. But, with iWork tools we can also draw our own letters. There is nothing better than original lettering to fit the principles of a good logo.
Getting ready



It's easy to see that we have two main types of letters in the alphabet—the ones that can be represented by straight strokes, such as A, and the ones that have rounded elements, such as B. The O is an oval shape.

How to do it...



Here are a few steps to 
writing, or rather drawing, the letters A, B and O, in iWork. The same technique can be used for the rest of the alphabet.
To create an A:
	Click on the Shapes menu in the Toolbar and slide down to choose the draw tool.
	Click to create the starting point of letter A.
	Move up and click again to create the second point. It will be connected to the first one with a line.
	Move down and away from the first point, and click again. The three dots now make an angular line.
	Double-click on the last point to finish the line.[image: How to do it...]

	Remove color fill in the Graphic Inspector. Under Fill, choose None.
	Next, with only two clicks, create the horizontal bar in the letter A.
	Change the thickness and color of the letter. In the Graphic Inspector, click in the color well and choose a color. Click on line thickness arrows to increase its thickness. Here, the thickness is 28 points. The color is Midnight (from the box of crayons).
	Edit each shape to make the A higher or wider. Make the horizontal bar longer, so that it extends beyond the vertical strokes. To edit a shape, drag the white square handles that show when it is selected. Make the letter as unique as you can—it is going to be your logo.[image: How to do it...]



Creating an O:
	To create the letter O, choose the draw tool.
	Click once with the pen and drag the mouse around slightly. The red dot will show curved  handles that look like a propeller.
	Click again and drag the mouse. The connecting line will be curved, not straight.
	Click on the first point again. At this point, we will have a closed circular line.[image: How to do it...]

	Click on the tip of the curved  handles—the propellers—and drag to rotate. This changes the curves of the shape. With a few drags, make the shape look like the letter O.[image: How to do it...]

	In the Graphic Inspector, change the thickness and color of the line. For additional effect, choose one of the striking line styles in the line drop-down menu. Here, the thickness is 24 points, the color is Fern, and it has a style that gives a smudged, brush-stroke look.


Creating a B (and letters with rounded elements):
	For a rounded letter use the same technique as for the letter O: Drag the mouse after clicking with the pen.[image: How to do it...]

	Click again and drag the mouse.
	After this, double click on the second dot, to finish a curved line. We don't close the shape.
	Each point shows propeller-handles when it is selected. Click on the tip of the propeller and drag to adjust the curve.[image: How to do it...]

	Duplicate the first line using Command + D. Enlarge and move to form the right-hand part of B.
	Add a vertical line with two or three clicks of the pen, change the thickness of the lines, their styles, and colors in Graphic Inspector, and get an eye-catching B for a logo.



How it works...



When you select the draw tool (among designers, this is also called the Bezier tool or Bezier pen), the cursor turns into a little pen. Click to create the starting point of your letter. It will be marked by a small red circle. 
The color of the 
line and its thickness are set for each template in iWork. If you've started with a blank template it will be black with a thickness of one point. When the line is curved, it shows a color fill that is set as default for the template. Remove it in the Graphic Inspector: under Fill, choose None.
To create the letter O, we can choose an oval from the Shapes menu, and then edit it by adding colors and styles. Or, we can draw it with the draw tool. A drawn O will have a connecting point that can serve as an attractive feature in a logo.

There's more...



The curved lines that make up the right-hand side of the capital letter B can also represent number 3. The vertical stroke in our example actually has three points. The draw tool can be used to create numbers as well as letters and your own original clip art.
The vertical stroke in B, when used separately, can serve as a number 1, popular in logos and trademarks for obvious reasons. But if you don't like it, you can make a simpler one with two points.
Letters consisting of straight lines can be rounded. Double-click on the point that you want to make rounded. Instead of being an angle it becomes a curve. The red editing point shows a curved propeller. Drag its blades to adjust the curve.
Here is the letter A that we created earlier but with its top point rounded. 
[image: There's more...]
In fact, we can create the whole alphabet and all the numbers from 0 till 9, in our own unique style and use them to compose headings and slogans in our documents.
Create and keep a folder with the letters and numbers that you've created.


Chapter 8. PDFs and Professional Printing



In this chapter we will cover:
	Producing a CMYK-separated PDF for a professional print shop
	Setting PDFs for professional print shops, and a few tips
	Understanding the elements of a print-shop-ready document
	Finding the right print shop


Introduction



Despite the rapid development in electronic publishing, printed matter—books, magazines, and brochures—still represents a huge proportion of publishing activities around the world. Over 45 trillion pages of documents are printed every year. In the USA alone, there are over 30 thousand printing companies, and print business conducted over the Internet accounts for only just over 10 percent of the entire print market.
Mastering PDF production is an essential element in using iWork for professional print purposes. Commercial, professional print shops will ask for your project to be delivered in PDF format, press-ready with CMYK color separation.
This may sound intimidating. Indeed, comments on Internet forums show that many iWork users believe that since CMYK PDF production is not supported in iWork, it is not possible to create a press-ready PDF in iWork. It is true that there is precious little information on how to deal with press-ready PDF production in iWork user manuals. However, a few additional steps allow any iWork user with a basic understanding of what is required for a PDF processed for high-end printing to prepare print-ready PDFs.
This chapter offers a few tips and solutions for meeting the requirements of professional print shops.


Producing a CMYK-separated PDF for a professional print shop



iWork documents look elegant and professional on screen. To make them look equally impressive in a professional or commercial printed version, we need to convert them to a press-quality PDF format. Dealing with PDF production is one obstacle that many iWork users find difficult to overcome once they move beyond home or office printing.
Getting ready



Apple Macs have their own PDF-making application—Preview. You can also navigate to File | Export... | PDF to produce PDFs. These are sufficient for on-screen use or for printing out on desktop printers.
However, most 
professional printers or print-to-order websites can't—or won't—convert them from the computer screen, three-color mode (RGB) to the four-color print mode (CMYK). To produce commercially printable PDFs in CMYK mode, we need to add a 
PostScript (PS) stage and use Adobe Acrobat Distiller. Using the PostScript stage appears to be the only path by which CMYK color separation is possible for PDFs produced in iWork.
In current versions of Mac OS, you don't always have to export a file as PostScript and then open Acrobat to create your press-ready PDF. If you have Acrobat Professional, you can also set it up so that you can export the appropriate PDF from within iWork without going through the PS stage.
This recipe describes the process with the PS stage.

How to do it...



Follow these steps to create a press-ready PDF:
	Print a file to PS.Under the File menu, click on Print, or type Command + P. When the Print dialog window opens, click on the PDF drop-down menu and choose Save as PostScript. As this will be your temporary work file, save it to the desktop. These files will have a .ps extension.

	Launch Acrobat and open the PS file.Adobe Acrobat has several options to create PDFs, including using the Create PDF option from the File menu. But rather than looking for PDF options under the Acrobat menus, drag the application icon to the Dock and then drag the 
PostScript  (PS) file onto the Acrobat icon. Acrobat Distiller launches automatically, and after a few seconds produces an Adobe Acrobat PDF file. Distiller, which comes as part of the full professional Adobe Acrobat suite, can also be put in the Dock. You can drop PostScript files onto either Acrobat or Distiller icons.

	Save your new PDF document.


Now you have a CMYK press-ready PDF file.
Distiller has several preset settings depending on your required quality. These settings can be changed. Most printers will be happy to go through their requirements so that there are no hiccups during the printing process.

How it works...



CMYK stands for Cyan (blue), Magenta (pink), Yellow, and Key (black). In printing presses, text and color images are created by mixing these four colors. Each color is spread in tiny dots 
on four separate plates—first cyan, then magenta, next yellow, and finally black. The black plate is the key plate—all the others are aligned with it. That's why black is called key in the CMYK acronym.
On our computer screens, colors are mixed automatically. The on-screen color mode is called 
RGB—red, green, and blue.
When professional printers prepare your work for printing, they use the CMYK color separation process. This
is
a
highly
specialized
area
where
you
don't
need
to
venture.
However, understanding the basic principles of CMYK can be useful at the design stage. For example, when you are looking for a particular color, you can look up its CMYK reading in an existing iWork document. Click on the colored object, open Graphic Inspector and click on the color well. When the Colors viewer opens, click on the sliders and choose CMYK Sliders in the drop-down menu. It will show the CMYK reading. The following screenshot gives the CMYK description of the color called Cayenne in the crayons box.
[image: How it works...]
You can give a co-worker the 
CMYK reading of a color that you mixed yourself, or if several people are working on a joint project where the colors have to be uniform, ask for the reading of a given color.
Some colors, for example, gold, have CMYK descriptions on Wikipedia. 
PostScript is a computer language that defines text and images, their characteristics, and the layout of the document. Its concept and development go back to the early days of computer design. In fact, it was Steve Jobs who urged Adobe engineers to adapt PostScript to be used as the language for laser printers. And when, in 1985, Apple introduced the LaserWriter, the first printer with PostScript, it sparked the desktop publishing revolution, which today allows us to produce high-quality projects on our home computers. PostScript is also the bridge between computers and large-scale commercial presses where 
CMYK color separation is needed.

There's more...



This simple and efficient method works not only with iWork, but also with most other applications, including MS Word.
What if you don't have Acrobat Distiller?
If you need CMYK PDFs for a one-off project, save your iWork document to PostScript, put it on a USB stick, CD, or similar, and take the PS files to a friend with the full Acrobat Pro suite, which includes Distiller. Or, a computer service shop or a small professional printer may do the distilling and color separation from PS files for a reasonable fee.
However, if your project is of a continuous, long-term nature—periodical print publication, posters, cards, and so on—my advice would be to acquire the full professional Adobe Acrobat suite. Do a careful calculation, and you should find that even after buying/acquiring Acrobat you are still able to produce print-ready CMYK PDFs cost-efficiently.

See also



	The MakingagoodPDFfromaniWorkdocument,andCMYKPDFsforprofessionalprinting recipe in Chapter 3, WorkingAcrossPlatformsandApplications




Setting PDFs for professional print shops, and a few tips



This recipe gives settings that 
should give consistently good results for a glossy magazine quality in the standard A4 format (209.9 mm x 297.0 mm or 8.26 inches x 11.69 inches) or in the similar North American Letter format (215.9 mm x 279.4 mm or 8.5 inches x 11 inches).
Getting ready



Acrobat Distiller has several settings for different levels of PDF quality.
To display your documents on the Internet, it may be preferable to choose a lower definition. This way, web pages load faster.
For high-quality printing, you need to choose Press Quality or Prepress, whichever settings are available in your version of Adobe Acrobat.
The settings can be customized. For a high-end printed product, it is best to fine-tune the settings. Take advice from an experienced printer or computer specialist.

How to do it...



The key to 
producing a good quality PDF from iWork documents is to use the PostScript stage when converting them. Simple Export to PDF or Save as PDF will not work with professional printers who require CMYK (four-color) separation.
	Print a Pages document to PS.Type Command + P, and when the printing dialog opens, click on the PDF button and choose Save as PostScript.

	Launch Acrobat Distiller and process your PS files through Distiller.Adobe gives a choice of Press Quality or Prepress presets.



For customized settings, you may need to follow the following example, which is based on the settings used for The
Rendezvous, an English-language glossy magazine that was published in France. Content, design, and layout were done in iWork. CMYK PDFs were produced from iWork Pages in Acrobat Professional (versions 6.0, 7.0, and 8.0) by using the PostScript stage. The magazine was successfully printed, with equally good results, by three different commercial printing companies—a small local print shop, medium-sized printers, and by one of the largest printing companies in Europe.
	Under General, set the Resolution to 2400 dots per inch.
	Under Images, set Sampling to off, and set the resolution for color and grayscale to 300 pixels per inch and 1200 pixels per inch for monochrome.
	Under Color, set the Settings File to None. The Color Management Policies are set to ConvertAllColorsToCMYK.
	Under Fonts, check the Embedallfonts checkbox.


These should give 
you a CMYK-ready PDF and keep your print shop happy.

There's more...



In addition to Adobe Acrobat, the Enfocus PitStop software is also good for producing high-quality PDFs. It works like an extended set of Adobe Acrobat tools, allowing you to convert PDFs to CMYK in one go and thoroughly check the prepress quality of PDFs.
Additional tips



If you are planning to use a professional (commercial) print shop for your project, arrange a visit to them to synchronize your settings. If you regularly use the same printers, arrange a session with them. It's easy to overlook a minor difference in settings, which can result in serious problems at a later stage in the printing process.
If this is not practical, send them a test sample of your PDF to check that it runs okay.
Always ask for press-ready proofs, especially for larger projects such as books or magazines—preferably on paper—so that you can check the end quality. When this is not practical, the printers should send you their final PDFs ready to go onto printing press plates.
Most printers use specialist computer service companies to fine-tune their machines and processes. Find out which companies they use, get in touch with them, and ask them to run through your workflow and settings.
It is not difficult to produce press-quality PDFs from iWork documents, but avoid getting into too much technical detail. Decide at what stage your work will be finished and you will hand over to others. You may find a printer who will take iWork Pages documents and convert them for you. Otherwise, print your Pages project to PostScript and take the PostScript files (with the .ps extension) to the printer. Printing is a highly specialized area, and if your main field of expertise is design, leave the final adjustments to the printers.
Avoid those who tell you iWork cannot be used for professional printing. It can.


See also



	The MakingagoodPDFfromaniWorkdocument,andCMYKPDFsforprofessionalprinting recipe in Chapter 3, WorkingAcrossPlatformsandApplications




Understanding the elements of a print-shop-ready document




Desktop

publishing (DTP), started to develop in the early 1980s but really took off with the introduction of Apple's LaserWriter, in 1985. High-quality, large print-run publishing became accessible to small and home-based businesses and organizations.
Because computer operations replicated the techniques used in printing, the terminology adopted by DTP developers also came from the publishing industry.
These days, the competition is so fierce that many printers will themselves take on the final preparation of PDFs for print—so long as the files are of decent quality. Still, it makes good sense at least to understand the methods and terminologies used in printing.
This recipe will show a few basic techniques required when designing and preparing documents for professional print shops.
How to do it...



The following techniques and steps describe how to prepare your document for professional printing.
Adding 3 mm (0.12 inch) as trim all around



iWork documents have dozens of preset paper formats that are widely used in printing. What you need to take into account when preparing your project for professional printers is trim. When large sheets of paper are fed into printing presses, there is an extra area that remains empty or is used for technical information. At the final stage of printing, when the publication is folded, bound, and sorted into bundles, this extra paper is trimmed—cut off with heavy guillotines.
To take this process into account, add 3 mm (1/8 inch) all around your document. This means adding 6 mm (1/4 inch) to each of its dimensions.
[image: Adding 3 mm (0.12 inch) as trim all around]
To set dimensions in the Document Inspector:
	In Document Inspector, click on Page Setup.
	In the Page Setup dialog, click on the Paper Size drop-down menu and choose Manage Custom Sizes...:[image: Adding 3 mm (0.12 inch) as trim all around]

	In the next window, click on the plus sign in the bottom-left corner and type the name of your project over the highlighted Untitled:[image: Adding 3 mm (0.12 inch) as trim all around]

	Next, type the new dimensions in the Width and Height fields.
	Remember to save the new dimensions and set the document size to them.


An A4 document would now be 213 mm x 30 mm (8.38 inches x 11.8 inches).

Alignment elements



In a multi-page 
document, make sure that there is at least one repeated design element against which all PDFs can be aligned by the printers. It must be a simple geometrical shape—a square, a triangle, or a line. It could be the small vertical stroke next to the page number like the one you see in the PDF version of iWork's User's Guides.
Set the coordinates in Metrics Inspector. Position this design element on a page and copy its co-ordinates from Metrics Inspector, or make a screenshot of the Metrics Inspector window with the co-ordinates and keep it as a reference. For opposite pages, the co-ordinates will be different horizontally, but the same vertically. When printers assemble the PDFs, they will be able to align all the pages exactly. If it isn't obvious from the design, remember to 
point out to the printers the element against which the pages should be aligned.
[image: Alignment elements]
Bleeds



A bleed is a design feature that takes your printed image right up to—and beyond—the edges of the printed page so that there is no white margin around the text or image.
It can be the colored background of the page, an image in the background, colored boxes, or lines. Often, front or back covers of magazines and full-page advertisements are designed this way in order to fill the space right up to the edges of the page.
When using bleeds, make sure that no essential details fall into the dead zone of the trim.

Colors



It is worth avoiding vibrant or very dark colors when preparing documents for print. What looks bright and catchy on screen may look dull on paper. You can often notice this once you have converted your document to a CMYK PDF. Modern printing techniques allow us to add special effects, for example UV (ultra-violet) spotlights on coated paper that make text and images very shiny. Talk to your printers about what is available and how to achieve the desired effect.



There's more...



All the elements 
discussed in this section can be added with Adobe Acrobat tools. However, you may find that these are no longer seen as necessary by many printers. Still, if your printer mentions them, you should at least understand what he/she is talking about. It also means you won't feel intimidated when you see these elements on artwork sent to you. And if you are not sure what your printer is talking about, ask! Rather than thinking that you are stupid, they are more likely to be flattered by being able to help.
[image: There's more...]
Registration marks



The 

fat dot with a crosshair through it is printed for each color in the CMYK sequence. If the process goes properly, the dots overlap precisely and the mark is black at the end. If any plates are offset, the colors are visible and the printer knows that something has gone awry. On modern presses, this is often controlled automatically, but operators still check the registration marks.

Trim marks



These are also called crop marks.
The thin angled lines in the corners show exactly where the finished page will be cut by the guillotine. They indicate the margins of the actual page or design element.

Color bar



Sometimes you see the color bars on the edges of daily newspapers. They are cut off when producing higher quality publications, magazines, and brochures. These bars are used by the printer for quality control. The press operator looks at them to check color density and consistency. This is also automated on modern presses, but operators are there to watch over the process.
Sometimes there
 is an additional grayscale bar.

Slugs



These are lines of information about the publication, with its title, client name, and date. They are cut off at the final stage. The word slug comes from the pieces of metal that were used to separate blocks of print in the pre-computer era.
iWork documents don't have tools to add all these elements to the final press-ready PDF. They can be added with Acrobat tools. But again, as long as the quality of the PDF is acceptable, printers may not even ask you to add them.
Finally, another general piece of advice. Avoid those who bombard you with scary technical terms that you don't understand—in business dealings or on Internet forums. Seek out those who are helpful and ready to explain what you don't know—and may not need to know anyway.



Finding the right print shop



The majority of iWork users are probably individuals or small businesses. You may live and work on your own deep in the countryside or on the outskirts of a big city without recourse to co-workers or the technical department of a big organization.
When we work on our own, we tend to develop all-round skills—from creating content to design and production. Still, it is simply not possible to master all the technical elements. If we try, our end product suffers. Many of us have to learn the hard way that even in the age of the Internet and web-based service providers, we can't sort out all our technical needs on our own. So, you should build a support network—physical, not just virtual—a network of professional people geographically close to you.
How to do it...



The following are general tips on how to build such a network with professional print shops:
	For printing services, find a small or medium size professional print shop that is close to you geographically and preferably not part of a huge chain.You need to be able to deal with the same people face-to-face, get them interested in your project and excited about breaking new ground with an unfamiliar program or new creative possibilities. If you deal with a large printing business with massive print-runs, you often can't get personal attention—you can end up dealing with a different person each time you take your work for printing. The same applies to web-based printing companies. They are there for a quick turnover and while they may offer lower prices, they may not give you customized technical support. 

	Make sure your printers use the same or a compatible version of the software you use.Each new version of Acrobat adds functionality, and even minor differences can affect the quality of the final printed product. The current version of Adobe Acrobat is 10.0 (released in 2010), but previous versions 7.0, 8.0, and 9.0 perform well with iWork.

	Synchronize Acrobat settings with your printers.Arrange a meeting with them, bring your iWork, PostScript, and PDF documents, and write down the settings or make screenshots.

	Find a good computer service company.This should preferably be a small, specialized business, so that you can get to know the technicians you are working with. Develop a good working and personal relationship with them, so that when a crisis looms they will go out of their way to help you. Smaller Apple retailers often have strong service departments. Check what service plans Apple itself offers in your area.

	Have technicians to check your workflow, system, and settings.They may find something that you've missed or suggest a more efficient workflow. This is especially advisable when you have one or two recurring problems with press-ready PDFs. Let better-qualified technical people help you spot and eliminate any problems, then stick to the process that works.
If you are happy with your computer technicians, sign up for a long-term support or service contract, so that you can call them on the phone or have them come round and fine-tune your machine.

	Ask them to prepare a set of prepress Acrobat settings.Explain what level of quality you want to achieve, ask the technicians to prepare the settings for you, and set your Distiller to use them as default. Save settings separately for backup.

	Take notes describing your problem step-by-step.For a technician to see where the stumbling point is and find a solution, they need to recreate what you've been doing step by step. Simple adjustments can often make a big difference, for example making the font slightly bigger or removing shadows.

	Take notes when you find a solution.Some problems occur less frequently and you may find a solution yourself. As soon as you do, make a note describing the solution, step by step, and set up a special folder with technical documents and keep such notes there. When the same problem strikes again, you may find that you've already solved it but have forgotten how you dealt with it. This is when your notes will prove invaluable.




See also



	The MakingagoodPDFfromaniWorkdocument,andCMYKPDFsforprofessionalprinting recipe in Chapter 3, WorkingAcrossPlatformsandApplications
	Chapter 9, PlanningLarge,Long-termProjects




Chapter 9. Planning Large, Long-term Projects



In this chapter we will cover:
	Preparing a full set of promotional literature
	Creating a custom bulleted list when planning a brochure
	Designing the title in print or electronic format
	Using iWork templates to create your own media placeholder
	Using styles to create a company brand look
	Setting the document size—what to keep in mind when preparing a book in iWork


Introduction



Recipes in this chapter offer tips and suggestions on pursuing large professional projects that are beyond the scope of what we normally expect to accomplish with a home computer.
With iWork, we can build a full set of company promotional materials, create beautiful brochures and logos, and produce books. Projects like these require an understanding of the principles of planning and organizing long-term projects.
Here, we will describe the basic operations necessary to accomplish your dream projects, including creating and replicating logos, working with and modifying templates, designing an eye-catching title for your publication, and planning and preparing a book.


Preparing a full set of promotional literature



In this recipe, we will see how one carefully designed graphic image can be transformed into different file formats, modified, and transferred to all the documents that you may need for your business or group.
Getting ready



As an example, let's take this simple logo, of a company called Advantage Services. The logo consists of a triangle from the Shapes menu, with blue color fill (change color in Graphic Inspector), and a white letter A. The letter is in a Text Box put over the triangle. Now, we will transfer the logo to other company materials, adapting it for different documents and media.
[image: Getting ready]

How to do it...



First, we need to create a high-definition master logo or trademark that will be used in all other promotional materials. Then, we will modify it for different purposes. The following steps describe how one master logo can be converted from one format to another:
	Open a large-format iWork document, for example, A3 paper size—11.69 inches x 16.54 inches (297 mm x 420 mm). Large musical, cinema, and BBQ posters in iWork Pages come in this format.
	Create the logo in the largest dimensions the format allows. In this example, the triangle shape is 11.4 inches x 15 inches (29 cm x 38 cm).
	Convert the finished logo to a high-resolution PDF. Use the Print | Save as PostScript path, then create the PDF in Acrobat or Preview. Save and store the master document in a dedicated folder.[image: How to do it...]

	Turn the colored master logo into black-and-white, to use it on mail-shots and for less expensive packaging.	Open the PDF in Preview.
	Save it as a JPEG. Navigate to File | Save as and choose JPEG from the Format menu.
	Import to iPhoto. Navigate to Edit | Effects | B&W and click on Done.



	To use the logo as a watermark or background in your documents, select Send Object to Background under the Arrange menu, or select In Background under Wrap Inspector. With the logo selected, go to Graphic Inspector and drag the Opacity slider to 50% or below, to avoid it interfering with the document content:[image: How to do it...]

	For using the logo on the Internet, including social networking sites, open the PDF of the logo in Preview and go to Tools | Adjust size. Reduce the resolution to 72 pixels per inch. Then, go to File | Save As, click on the Format drop-down menu, choose JPEG or PNG, and reduce the file size to 100 KB or below, by dragging the Quality slider:[image: How to do it...]

	For using the logo as a favicon—the small logo that appears next to your internet URL address—you may need to create a very light, perfectly square image. Setting square dimensions in iWork Preview doesn't always work. Instead, you can perform the following steps:	Select the image in iPhoto.
	Click on Edit in the iPhoto toolbar.
	Then, click on Crop.
	When the Constrain menu appears, click on the drop-down menu and choose Square.
	Make sure the whole logo is inside the square, click on Apply, and then click on Done.
	If you need to decrease the file size further, do it in Preview, as discussed in step 4.



	Add a few details to the simple logo, so that it has a more impressive look on more important documents. Here, we've added a small triangle above the letter A, and the name of the company in a Text Box below the main graphic image. Addresses and other details can be added below the Text Box, in a smaller font.[image: How to do it...]

	Give all the different graphic files names that make it clear which one is suited for what purpose. Click on the name of the file, under its icon, once, then click on it again to highlight it. Type it over with the new name.
	Create cards, brochures, letters, spreadsheets, posters, presentations, and other types of company documents by using iWork templates. Add the master logo to all these documents, dragging it from the folder you've created for storing them. If you are creating a company document from a blank document, insert the image by pressing Command + Shift + V. When the dialog opens, find the folder, select the appropriate file, and click on Open. Save your new documents as your own custom templates, by selecting Save as Template under the File menu.


Here is how a company letter with a watermark can look:
[image: How to do it...]

How it works...



Large dimensions for 
the original image allow you to use the logo on trucks and work-site billboards. Commercial print shops also need at least 300 DPI resolution. The resolution is set in the PDF-making program.
We start with the high-resolution version, because we can scale down the size and quality of the image but we can't build it up from a lower resolution to a higher one. 
Always use Preview to change the file format—this is a powerful program on Macs, but it is still undervalued. It also has an Alpha tool for removing the white background from an image. This allows more graphic possibilities, for example, when using the image on a colored background in iWork documents or on the Internet.
Reducing the resolution of the image to 72 pixels per inch allows your Internet pages to load faster.
When you are planning to put objects in the background, start your iWork document in Word Processing mode, not in Page Layout. In Page Layout, you can't move objects to the background.

There's more...



This recipe shows how different programs that are already installed on our Macs work together to complete the task. We should always keep it in mind when using iWork. Powerful as it is, iWork only complements other programs; don't expect it to do everything.

See also



	The Writing letters for your logo with the Draw tool—the principles of a good logo  recipe in Chapter 7, Graphic Design: Making Your Own Logo
	The Producing a CMYK-separated PDF for a professional print shop recipe in Chapter 8, PDFs and Professional Printing




Creating a custom bulleted list when planning a brochure



A company or organization's brochure is used to give an outline of its services or activities, as well as to create a memorable image that clients will recognize. 
Important elements of brochure design include:
	Title: Usually the name of the company, in large type
	Logo: An eye-catching cover image
	Some descriptive photos with text


Brochures usually have limited space, which is why it is important to present the company's profile in a concise, bulleted list. It can look like it does in the following screenshot:
[image: Creating a custom bulleted list when planning a brochure]
A bulleted list 
makes the outline of your services easier to read and more attractive to look at, compared to a solid body of text. This recipe describes how to use the company's logo or other representative image as a custom bullet in such a list.
Getting ready



Design a brochure based on any of the iWork templates. Choose a page or a panel that you will use for the list outlining your services. As an example, we shall use a simple logo—a white letter A inside a green oval.
[image: Getting ready]

How to do it...



The following steps 
describe how to add a custom image—the company logo—to a list in the brochure:
	Type—or copy and paste—your text into the iWork document. Select all paragraphs that will have bullets.
	In Text Inspector, click on the List tab and then click on the Bullets & Numbering drop-down menu.
	In the drop-down menu, click on Choose Image.... When the dialog opens, find the image that you have created for the bullets and click on Open. All paragraphs in the selected text will use the image as bullets:[image: How to do it...]

	To change the size of the bullet, click on the up or down arrows in the Size window, or type in a size, for example, 150%.[image: How to do it...]

	To move the bullet up or down, so that it is aligned with the text, click on the up or down arrows in the Align window.
	If you have a body of text above or below your list, you may want to indent the list. To indent just the text, click on the up or down arrow in the Text Indent window. The bullets will stay where they are.
	To indent the bullets too, click on the up and down arrows in the Bullet Indent window.
	When you are satisfied with the look of your list, you can save it as a list style to use in other company literature:	Select a paragraph with the custom image bullet.
	Open Styles Drawer under the View menu—or from the View drop-down menu—in the document. You can also use the shortcut key Command + Shift + T.
	In the List Styles window, click on the black arrow to open the drop-down menu, and choose Create New List Style from Selection.... Type in a name for the list, for example, Brochure list example.
	The next time you want to use this bulleted style, select the text, open Styles Drawer, and click on the Brochure list example list style.


[image: How to do it...]

	To change the bullet image, click in the paragraph with the bullet, open Text Inspector, and click on List. The Choose window will be shown under Custom Image. Drag the new image into the Custom Image window. When it shows a plus sign, let go. The image will be replaced.



How it works...



Adding a 
custom bullet to just one paragraph is enough. After this, when you hit Return, the next paragraph will automatically be formatted in the same way as the preceding paragraph.
If you've finished with the list and want to return to the usual text format, press Shift and then hit Return. The next paragraph will not have the list format, but will still have the indents. Remove the indent by using Text Inspector. Select the List tab. Then, click on the down arrow next to the Text Indent window.
You can also choose No Bullets for the paragraph where you want to return to your usual text format.

There's more...



Instead of your company logo, you can add photos that are related to your services. Drag the photo to the Custom Image well and it will replace any image that is already there. You can replace the company logo with the picture views of Paris.
[image: There's more...](Photos by Benh Lieu Song and Sanchezn)


There is a choice of attractive Image Bullets, including a selection of checkboxes that can also be used for questionnaires.

See also



	The Creating drop caps with the Custom Image bullets recipe in Chapter 2, Working with Text




Designing the title in print or electronic format



A magazine is different from other types of periodic publications in that it puts high emphasis on graphic presentation. Elements that together form the distinct style of a magazine include its title, fonts, and the graphic headers of the contents page, sections, and columns. The design of the magazine cover, including its title and colors, can be used for headers and footers on each page. Fonts should ideally be consistent throughout a publication.
Of all these elements, the title is arguably the most important. This recipe describes how it is designed.
Getting ready



As an example of a magazine title, we will use the Rendezvous. This design has typical features for such work—a distinct and recognizable style, a compact composition, and elements that can be used separately or built throughout the publication as logos, brand colors, and design elements. The font used in this example is Optima ExtraBlack, which comes pre-installed on Macs.
[image: Getting ready]

How to do it...



The following steps describe how to create a magazine title:
	Open a blank iWork Pages document and import a Text Box. In Wrap Inspector, uncheck Object causes wrap.
	Change the font of the highlighted default text—Type to enter text—to Optima ExtraBlack. Type in the word "the".
	Import another Text Box, change the default font to Optima ExtraBlack, and type in "endezvous". Uncheck Object causes wrap in Wrap Inspector.
	Import a third Text Box, change the font to Optima ExtraBlack, and type the capital letter "R". It can also serve as the logo of the magazine. Uncheck Object causes wrap.
	Change the color of the "R" to a shade of red. Open the Colors Viewer by pressing Command + Shift + C (or by clicking on the color tab in Text Inspector). To change the color, click on the color mixing wheel—the icon at top left of the Colors Viewer. Drag the small white square. Then, drag the darkness slider to achieve the desired shade.[image: How to do it...]

	Enlarge the "R" to a size proportionate to the dimensions of the magazine. Here, it is 134 points. If the letter doesn't fit in the box, make the box bigger.
	Select the box with "endezvous". Move the box with "R" aside while you work on this element of the title.
	Double-click on "endezvous" to highlight it, open Text Inspector, and under Spacing | Character, reduce the character spacing to -7%. The letters now sit much closer together.
	Go to the Text Box containing "the", select the word, and set character spacing to -7%.
	With "the" highlighted, click on the color tab in Text Inspector and set Opacity to 50% by dragging the slider under Opacity in the Colors Viewer. The color of both "endezvous" and "the" should be the same. In our example it is black. But with opacity reduced, "the" will look muted next to the other two elements of the title.
	Move the three boxes to form a tight, visually appealing composition. "R" stands out, "endezvous" fits snugly in front of the middle portion of "R", and "the" is positioned on top in the nest between "R" and "d". This also saves space, allowing you to make the title bigger.[image: How to do it...]

	You can also select all three boxes and group them, using Command + Option + G or choosing Arrange | Group.



How it works...



In this recipe, we discussed the following properties regarding the title.
Brand color



When you are satisfied with the red color, save it in the palette at the bottom of the Colors Viewer. Click on the color well displaying the red color and drag it to a cell in the palette. Click on the Sliders icon, choose CMYK from the drop-down menu, and note the CMYK breakdown. It will help when you work with professional printers to ensure quality reproduction. Then, use the color of "R" stored in the palette, for other graphic elements in the magazine—headings, lines, column dividers, box frames or color fills, page numbers, and so on—to give your magazine a distinct and consistent look.

Title as image



You can leave the title as grouped text boxes, or you can convert it into an image and use it as a logo. For this, export your document to PDF and crop it to the desired dimensions. In Preview, you can remove the white background. It makes sense to have the title stored as an image in a project folder, to use as the company logo on stationery and on the web.

Character spacing



This allows us to use a font size that is bigger than the font size that would normally fit into a given space on the page. It also increases the impression of the title being one visual entity, not just a word put on the cover.

Deactivate wrap



Unchecking 
Object causes wrap in Wrap Inspector allows us to move Text Boxes freely, in order to create the title composition. With wrap activated, boxes would have interfered with one another, making the text disappear.


There's more...



Use just the letter "R" or "the R" as a logo or trademark for your project. For example, like this:
[image: There's more...]
The distinct gray word "the" can be used to graphically accentuate section and column headers in the publication; for example, "the Advice" or "the Classifieds". Repeated use of the graphic elements from the title helps you in creating a company or house style.
[image: There's more...]
If, for design purposes, you want to use the title on a dark background elsewhere in your project, think of inverting the colors. Create a box filled with the red color used for "R" and change the color of the title to white or light gray.

See also



	The Designing repeating elements such as footer and object coordinates, and creating sections recipe in Chapter 10, Designing from Scratch: Beyond Templates
	The Changing font (typeface) using toolbar, menus, or Font Panel—when to use which recipe in Chapter 2, Working with Text




Using iWork templates to create your own media placeholder



iWork has 
dozens of templates. Choose one when opening a new document by pressing Command + Shift + N or navigate to File | New from Template Chooser.
Each template has finished pages, which we can adapt for our own publishing projects. We just have to add new images and text to replace the ones in the template, to create our own customized version. This allows us to create beautiful documents with astonishing speed. We can add just a few elements of our own—a photo or a logo—or create a completely different look by modifying the template.
Even when we design our project from scratch, that is, from a blank document, we can make selected elements of our document behave like templates.
This recipe shows how to set a graphic object in an iWork document as a media placeholder. It's called media because it can be used not only for photos, but also for sound and video clips.
How to do it...



The following steps 
describe how to create a media placeholder in your publication:
	Import an image as a floating object (refer Chapter 5, Working with Photos: Tips and Tricks for more information):
	Mask it. Navigate to Format | Mask (or use the keyboard shortcut Command + Shift + M). Mask function can also be activated via the toolbar—or the Format bar under the main iWork toolbar—by selecting the image and clicking on the Mask icon:[image: How to do it...]

	Give the mask your desired dimensions by dragging its handles or setting dimensions in Metrics Inspector. Uncheck Constrain proportions in the Metrics Inspector if you want to set width and height separately.
	To move the image around inside the mask, click on the Edit Mask button and move the cursor over the image. When the cursor turns into a small white hand, click on the image and hold. The small white hand will make a grabbing movement. Drag the image around inside the mask. This allows us to focus on a detail of the image, and hide the rest with the mask.
	To change the size of the image within the mask, click on Edit Mask and click on the image. The part of the image that is hidden by the mask will be shown as a grayed area. The image will show small white squares—editing handles. Drag them to increase the size of the image. As you do this, smaller details will be shown inside the mask. Alternatively, drag the slider in the Edit Mask control panel:[image: How to do it...]

	To save the result, click on the Edit Mask button when you have finished with the image. Move or additionally resize the masked image as you would do with an ordinary object.
	Define this image as a media placeholder by navigating to Format | Advanced | Define as Media Placeholder, or by using a keyboard shortcut—Command + Option + Control + I.



How it works...



In addition to defining an object as a media placeholder, adding a mask allows us to keep the dimensions and the position of the image exactly as we first defined them.
We can simply apply 
the Define as Media Placeholder function to an image. However, this is not enough if you want to keep the same dimensions and position of a graphic object from one document to the next, for example, in a periodic publication. If you put a landscape (horizontal) photo onto a media placeholder with a portrait (vertical) composition, it may push surrounding text off the page or out of the layout margins. The following screenshot shows what happens when we put a horizontal photo above a media placeholder, which is the butterfly in the Redwood Newsletter template in iWork Pages. The plus sign below the photo in the following screenshot shows that part of the text, including the page number, has been pushed off the page:
[image: How it works...]
With mask 
added, the new image will always fit inside the set dimensions.

There's more...



Having a media placeholder in your document is only one element of a template. Once we have finished one design, we can re-use it by creating copies of it, by duplicating or creating new versions.
If you are particularly proud of your design, you can turn it into a template of your own. To save a document as a template, choose Save as Template under the File menu. Give it a name and save it.
Next time you open a new document, Template Chooser will have a new folder called My Templates with the document you saved. It keeps all design attributes and opens just as you left it when saving—invisible characters and layout grid will be shown or hidden, page thumbnails will be shown or hidden, and the same for other elements of the document.
On the computer, templates are stored in your home folder (click on the small house icon in the side panel of any open folder) in Library/Application Support/iWork/Keynote-Pages-Numbers/Templates/My Templates.
We don't have to follow templates exactly as defined, they are included with iWork to give us ideas for our own designs. Preset elements of iWork templates include page layout and section formatting, margins, page numbering, backgrounds and watermarks, text and paragraph styles, bullets and numbering styles, and color fills and line styles for objects. Graphic objects in templates can be used as clip art and many of them are editable.

See also



	The Placing, cropping, editing, moving, and resizing photos recipe in Chapter 5, Working with Photos: Tips and Tricks




Using styles to create a company brand look



We express house or company style through trademarks and logos or brand colors and images. But we also need to have a distinct style in our text documents. This includes a consistent use of fonts, line and paragraph spacing, and lists and bullets.
The
 iWork tools allow us to create a selection of text styles. This recipe shows how to do this. Once styles have been created, we can change our text to house style with one click.
Getting ready



Create a document that includes a title, headings for chapters, articles, sections and subheadings for smaller pieces of text and captions, as well as words or groups of words that you want to highlight within the text. Next, create a consistent style for all of them.

How to do it...



The following steps show how to create a consistent text style for all your company literature. Follow them when creating a periodic publication, such as a newsletter or magazine.
	Open Styles Drawer by pressing Command + Shift + T, or by choosing Show Styles Drawer from the View screen-top menu or from the View drop-down menu in the toolbar.
	Start with the title or the main heading style of the document. Modify the text by choosing your preferred font, font variation (regular, bold, italic, or other), size, and bullet, character, line, and paragraph spacing.
	When you are satisfied with the look, click on the arrow next to the style that is currently in use. A dialog will open. Choose Create New Paragraph Style from Selection...:[image: How to do it...]

	In the next dialog, type the name of the new style—for example, Magazine main heading—over the highlighted default style name.
	Repeat steps 2 to 4 for each element of the document's formatting, from the title to the main body of text.
	Repeat steps 2 to 4 for character styles and for list styles, if you use any.
	Next time you open the document, all the styles will be in the Styles Drawer. Click anywhere on the text and then click on the required style. It will change all its attributes, as defined in your saved house style.



How it works...



Your new styles can be modified later. First make the new changes you want in your text. To save these changes into your house styles, look in the Styles Drawer. You will see that the black arrow against the style you are using has turned red. Click on the arrow, and the previously grayed-out options Redefine Style from Selection and Revert to Defined Style will be accessible. Choose Redefine Style from Selection to save the changes you've made.

Paragraph styles
 keep attributes of paragraphs, such as font, size, text color, character and line spacing, shadows and background colors, and indentation and tabs. Paragraph styles are useful for quick formatting of headings, main text, callouts and captions, and also for headers and footers.

Character styles
 are mostly to emphasize certain words or lines of text within a paragraph. These styles include font variations, for example, italics. When you apply a character style to the selected text, a word or group of words for example, only this part of the text changes. This is useful, for instance, when you want the title of a book or the name of an organization to stand out within your main text.

List styles
 include indentation and style of numbering and bullets. If you have used custom image bullets, they will also be saved.
The following 
 screenshot shows how the appearance of text can quickly be changed by applying a style:
[image: How it works...]

There's more...



Don't rush to create styles, and don't create too many. Make sure you have achieved the desired look before saving styles, otherwise it is easy to lose track of which style you use for what purpose. When you open a new document in iWork, it already has a set of styles in the Styles Drawer. Modify them gradually or create new ones, using the Style Drawer tools.
Create a distinct style and follow it throughout the document. Usually, no more than one or two fonts should be used. This gives the impression of a distinct, consistent style. If too many different fonts and variations are used, and too many different colors are applied, it creates an untidy, messy look.
For a large project with graphic images and charts, choose a font family with a large selection of variations, so that you can use one font but different variations. Besides the usual regular, bold, and italic, you could also choose semi-bold, light, condensed, black, and so on.
To create another document by using this same house style, you can duplicate your original (Command + D), then change the name of the copy, and type your new text over it. Or, once you are satisfied with your created style, you can save the document as a template.

See also



	Chapter 2, Working with Text
	The Using the color picker to create a custom color palette recipe in Chapter 10, Designing from Scratch: Beyond Templates




Setting the document size—what to keep in mind when preparing a book in iWork



While iWork is primarily an office productivity suite, its tools make it perfectly possible for us to accomplish large projects, including electronic and printed books.
iWork documents have a number of preset dimensions for popular stationery formats. They are meant to be used for home desktop printers. When you prepare a project for professional printing elsewhere, it is likely that you will have to set custom dimensions for your document. This recipe describes how to do it.
Getting ready



Check the dimensions of your publication with the print shop or web-based publishing service that you are going to use. Usually, paper sizes for various types of books are given in their Help or FAQ sections. While there are a number of standard formats, they vary from country to country and from service to service. A standard paperback can have dimensions of 5 inches x 8 inches or 5 inches x 7.75 inches.

How to do it...



To set the paper size 

and orientation, perform these steps:
	Open the Page Setup dialog. Use the keyboard shortcut Command + Shift + P or click on the Page Setup button in Document Inspector. You can also navigate to File | Page Setup.
	Click on the Format for drop-down menu in the Page Setup dialog and choose Any Printer or Adobe PDF.
	Click on the Paper Size drop-down menu and choose Manage Custom Sizes.... This opens the Custom Page Sizes dialog:[image: How to do it...]

	Click on the plus sign (+) in the bottom-left corner of the dialog to add a new document format. In Page Size, type in the required dimensions. Under Printer Margins, click on the drop-down menu and choose User defined. In the Top, Bottom, Left, and Right windows type 0 (zero).
	In the left hand panel, double-click on Untitled to select it and type over the name of your project, for example, Book:[image: How to do it...]

	To save the new dimensions and add them to the paper size menu, click on OK. The Custom Page Sizes dialog will close.
	In the Page Setup dialog, which is still open, click on the Paper Size drop-down menu again and make sure that the new format is chosen. The selected new format will be shown between two thin gray lines below the preset paper dimensions.
	In Scale, make sure that 100% is shown, otherwise the final document will have dimensions that are different from the ones you have set.



How it works...



In this recipe, we discussed the following properties.
Margins



When we set the value for Printer Margins, it does not correspondingly change the value of Document Margins. They are for the final PDF. That's why we set them to 0. Document 

margins, the empty white area around the body of text and graphics in our document, are set in Document Inspector. Type the value for it under Document Margins. If you are planning to use a web-based service for printing your book, for example, CafePress, follow the instructions for setting dimensions on their website. If you work with a professional print shop, consult them about margins. They may want you to add a 3 mm margin all around your PDF for printers' trim.

Truncating



One problem that iWork users encounter with PDFs is when the document comes out truncated, that is, only part of the original document is in PDF. To avoid this, in the Print dialog, make sure that Adobe Printer is chosen and under Presets | Current | Paper Handling | Destination Paper Size your chosen paper size is shown.


There's more...



When preparing a book with iWork, there are many other
 technical considerations. Here is a checklist of what to take into account:
	Start by deciding on the format. A4 or A5? Or a custom size? Portrait or landscape? Check dimensions with the printing service that will be printing your book professionally. Remember, usually you add 3 mm all around to allow for printers' edge cutting (trimming). Calculate margins carefully, allowing more space if the book is going to be bound. Set dimensions in the iWork document and save it, in order to duplicate it for all other pages of the book.
	Make a map of your book. Design a spreadsheet in Numbers, showing all the chapters and pages. Or design a one- or two-page document with chapters and sections shown as Text Boxes, and write down what goes where. Print the map out, keep the file in the Dock, or put it in the side panel of a folder window, so that you have quick access to it. Mark finished pages as you go—this will save a lot of hassle later. The following screenshot shows the map of a 64-page publication. It is a table designed in Numbers. Colored cells show the front and back cover. Bold vertical strokes separate facing pages. Print it out and mark with a pencil or type the page information on the computer.[image: There's more...]

	Make sure all files/pages are clearly named (for example, page number, what's on it) and don't change them until the work is finished. It's very easy to lose track of where you are when you work on a large project.
	Make folders for each stage of the work (for example, 1st draft, 2nd draft, 1st proof, 2nd proof, printer's proofs, and so on), and move the finished parts of the book from one folder to the next only when the work is finished.
	Break all work into manageable chunks—front page/cover, back page/cover, contents, index, and sections. Don't work with large files. It is best to work page by page, or with two facing pages. However, for proofing and editing, put everything together in one big document. This is especially important if your book is one continuous body of text, for example, a novel. You can use iWork's powerful proofing tools for cross-checking and referencing.
	Begin designing with two facing pages of the main body of the book and then use them as templates for the rest. Pay special attention to small design elements—lines, clip art, page headers, and footers. They should have the same style and be placed in exactly the same position on the page, throughout the book. Metrics Inspector allows you to fix co-ordinates down to a fraction of a millimeter or inch. Remember that repeating lines, boxes, and clip art are used to align pages when the finished work is assembled for the printing presses.
	Use one or maximum two fonts throughout the book. For headings, sub-headings, and notes, use font variations rather than different fonts, to avoid the whole document looking messy.
	Decide how you are going to deliver finished pages to the printers. Most accept PDFs, and many printers are happy to assemble the pages themselves, but some will ask you to do it. Make sure you have the software to convert iWork documents to press-quality PDFs (for example, Adobe Acrobat) and check the settings with your printers. It is best to establish physical, face-to-face contact with the printers you are going to work with. But if this is not practical, test run sending large files via File Transfer Protocol (FTP) programs, such as Zipper or SendIt.
	Calculate production costs, including packaging and delivery. The weight of paper and type of binding (stapled, ring, or hard spine) affect the final cost and quality. Heavy paper allows for better quality, but can make your publication more expensive and put it into a higher postal tariff bracket. Lighter paper saves on cost, but images may show through on the reverse side of the page, which can upset artists or advertisers. Check with the printers, ask for estimates, and look at samples. Don't be afraid to ask unprofessional-sounding questions. Nobody knows everything.
	Don't rush. Check finished work at least three times for typos and other mistakes, such as wrong page numbers. Invest in professional proofreaders and involve your friends and family. Contents and index pages are especially important—the page number in contents must correspond to the page in the body of the book or magazine. It may seem obvious, but that's where mistakes often occur. It's worth checking the whole finished work for just one element—for instance, page numbers. Go through the whole book to make sure you haven't lost any pages or repeated page numbers. Then take another element, for instance font size of headings, and check that it is the same throughout the book. Then, check co-ordinates of lines, logos, or clip art in headers or footers. They must be the same throughout the book too. This may seem unimportant, but if the style is not consistent, it gives the impression of a sloppy, unprofessional product.
	Make sure you know and understand certain rules that are used in particular types of publications. For example, if you work on an art catalog, you should know that the descriptions of the works of art follow a particular set of rules. Look at the catalog of a reputable fine arts firm and follow their pattern. For example: first, the name of the artist (bold), then the title (regular, in capitals), the date of the work and position of author's signature (italics), media, for example, "oil on canvas" (regular or semi-bold), dimensions (italics), notes (light, smaller font size), provenance (regular font, but indented), suggested price/deposit, and so on.



See also



	The Making a good PDF from an iWork document, and CMYK PDFs for professional printing recipe in Chapter 3, Working Across Platforms and Applications
	The Finding the right print shop recipe in Chapter 8, PDFs and Professional Printing




Chapter 10. Designing from Scratch: Beyond Templates



In this chapter we will cover:
	Editing a shape to create a graphic design element
	Drawing curved lines to enhance the graphic detail in a design
	Using flowing colors for graphic headings
	Using a color picker to create a custom color palette
	Fading an image from side to side with an overlapping object
	Setting custom document dimensions
	Using columns and Text Boxes to lay out text
	Designing repeating elements such as footer and object coordinates, and creating sections


Templates included with iWork applications provide instant design solutions. They have all the beauty and elegance we associate with Apple.
Nevertheless, no template can fit all our requirements, and there comes a point when we want to create our own distinct style and a design tailored specifically to our project.
This is when we have to start designing from scratch.
Recipes in this chapter describe the main elements of a publishing project. They will fit both print and electronic publications, such as a downloadable newsletter or physical magazine.
Use them as building blocks to assemble your unique design.
Editing a shape to create a graphic design element



The first task in creating your own unique design will probably be drawing your title. Its style and colors are key to the rest of the project, where design of the title serves as the basis of other design features, such as headings, lines, backgrounds, boxes, and bullets.
This recipe describes how to 
create a simple edited shape that can serve as a graphic panel for placing the title.
Getting ready



We need to have a clear idea of what sort of panel we want to design. Think this through and perhaps make a rough sketch on paper. Here, we will design a panel that is rectangular at the top and has a curved bottom edge.
[image: Getting ready]

How to do it...



Follow these steps to create your panel:
	Insert a rectangle from the Shapes drop-down menu.
	Resize it to a size that suits your title by dragging the handles or setting the dimensions in Metrics Inspector.
	In Graphic Inspector, under Fill, click on Color Fill and choose your color.
	Under Format, select Shape | Make Editable. The corners of the rectangle will show red dots—editing points.
	Click on the bottom-right editing point and drag it slightly upwards.
	Double-click on this editing point to make the line curved. It will show two propellers—curving handles.
	Click on the right curving handle, press Command, and move it into a vertical position, flush with the right-hand side of the shape.
	Click on the other curving handle, press Command, and move it towards the center of the shape to give the bottom line an inward curve.[image: How to do it...]

	Next, double-click inside the shape and type the title of your project. Depending on how we plan to use the created design, we can leave it in the iWork document or export to PDF or another graphic format and use it elsewhere, for example, on the Internet.



How it works...



The size of the panel depends on your ideas for the project's design. It can be placed in the right-hand side corner, for example, or it can cover the full width of the document. Another common way of placing the heading is at the center with the borders of the graphic panel flush with the margins of the document—the text is aligned with them.
Editable shapes



When the shape is made editable, its red editing points can be moved by dragging, but also by clicking on the keyboard arrows. If the Snap to Grid function (refer to the Alignment Guides) makes it difficult, press Command after you start dragging the editing points. This disables Snap to Grid.
Curved handles appear when we change an editing point from angled to curved. The handles move together, pointing in opposite directions—drag one, and the other one moves too. To move them independently of one another, press Command while dragging.
To extend a handle, click on it and pull out. To make it shorter, click on it and push in. This changes the way the line curves.
Some 
predesigned shapes already have editing tools. For example, the double arrow has a slider that changes the way the arrow looks. Resize the arrow by dragging its handles and reshape the points by dragging the slider. This allows you to turn it into a stretched shape, which can be used as graphic background for titles or headings.
[image: Editable shapes]


There's more...



Remember that different Line and Picture Frame styles in Graphic Inspector can give the shape an even more striking look. Here, the same shape has a colored outline and a dark gray shadow that lifts it off the page.
We can double-click inside the newly created shape to type the text in it. If you feel that there is not enough room inside it, create a Text Box, resize it as needed, give the required style and color to the text, and then move the Text Box over the shape. This way, you don't need to worry how much space the shape allows for text inside it.
[image: There's more...]

See also



	The Drawing curved lines to enhance the graphic detail in a design recipe





Drawing curved lines to enhance the graphic detail in a design



In this recipe, we will create a set of curved lines and put them together in a bundle. This technique has many purposes in design—it brightens a page and makes headings, photographs, and other graphic details in our design stand out.
To see how this 
technique works, we will pick up from where we left off in the previous recipe—we will add curved lines to the panel with a curved bottom line.
Getting ready



Create a panel similar to the one described in the Editing a shape to create a graphic design element recipe discussed earlier in this chapter, and place it in your iWork document as a floating object.
[image: Getting ready]

How to do it...



Follow these steps to create a bundle of colorful curving lines and add them to the panel:
	Click on Shapes in the toolbar to open the drop-down menu and slide down to choose the Draw tool.
	When the Draw tool is selected, the cursor turns into a small pen tip. Click to create the starting point of the line.[image: How to do it...]

	Move away and click again to create the second point of the line.
	At this point the line is straight. To make it curve, click on the second point again and drag the mouse around slightly—the line curves.
	Two gray handles that look like a propeller appear, extending from the second point as we drag the mouse. Click on the tip of one and drag it around, in a rotating movement, to change the curve.[image: How to do it...]

	When you are satisfied with the curve, either press Escape or double-click on the second point.
	Go to Graphic Inspector, and under Fill, choose None.
	Under Stroke, click in the color well, and when the Colors Viewer (Inspector) opens, choose a color for the line that is similar to, but slightly darker than, the color of the panel. Again, under Stroke, set the width (thickness) of the line by clicking on the up and down arrows or by typing the size.
	Duplicate the line twice—press Command + D and then press it again. In Graphic Inspector, choose a color that is darker than the first one, and for the third line, another color, which is still darker.
	Move the lines to position them one under another to create a bundle.
	Select all three. Click on each one while pressing Shift. Move the bundle under the curving bottom edge of the panel, so that together they form one design.
	Press Shift and click on the panel to select all four elements. Then, choose Arrange | Group. Now, the resulting design can be moved around the document or copied and pasted into another project.


The result should look something like this:
[image: How to do it...]

How it works...



Shapes created by the Draw tool take the default styles—line thickness and color fill—of the template we are using. If we start with the Blank template, the Color Fill field shows a green color and the Stroke field shows a black line with 1 point thickness (width). We can change both parameters in Graphic Inspector. To remove the color fill and leave just the line itself, we set Color Fill to None and change the thickness and color of the curved line to fit our design.
If the curved lines you design are too short or have not curved the way you want them to, don't worry. Under the Arrange menu, select Ungroup, select the line you want to edit further, and change its length and the curve. It usually takes several adjustments before the design is finished.
Colors Viewer is like an
 additional Inspector. Whenever you click in a color well, Colors Viewer opens as a separate palette, offering a range of tools for selecting and designing colors. When creating an original design, use co-ordinated colors, picking and copying them off templates provided with your iWork installation or from a photograph you are using in your project. The colors should complement, not clash with, one another. You can even use the same color for different design purposes, but make it look different by reducing its opacity. This option is at the bottom of Graphic Inspector. Select a shape or an object and drag the Opacity slider to make it less opaque. The same color will look different but will remain in harmony with your project, as you have only adjusted its transparency.

Curving handles
 look like a propeller sticking out of an editing point on a curved line. They appear when we double-click on an editing point to make the line curved. Click on the tip of the propeller blade and drag it as though you were starting up the Wright brothers' airplane. This rotating movement changes the curves of the line.

There's more...



The Draw tool can also be used to create your own clip art—letters and numbers—as described in the Writing letters of the logo with the Draw tool—principles of a good logo recipe in Chapter 7, Graphic Design: Making Your Own Logo.

See also



	The Editing a shape to create a graphic design element recipe




Using flowing colors for graphic headings



Headings of sections and columns can be designed as graphic images. Adding gradient color (flowing, changing from one to another) to such headings can make them very attractive. This recipe 


describes how to fill letters with flowing colors.
Getting ready



In this recipe, we will use the letters F and G to create the heading for a Financial Guide column in glowing, golden yellow colors.
[image: Getting ready]

How to do it...



The following steps 


describe the technique:
	Open a new iWork document. Choose a horizontal (landscape) page layout, when opening the document.
	Type FG as usual—black letters on white background.
	Highlight the text and choose a thick and bold font variation from the font drop-down menu in the Format bar. Here, it is Hoefler Text Black.
	Increase the size as much as possible, so that the two letters fill most of the page.
	Turn the text into an image—make a screenshot of the text by pressing Command + Shift + 4. The image should appear on your desktop as a PNG file. You can also navigate to File | Export | PDF. Leave the image where it is; we will need it in step 10.[image: How to do it...]

	Create (import) a shape from the Shapes menu. Here, we will import a rectangle, but you could choose any shape.
	In Graphic Inspector, under Fill, choose Gradient Fill.
	Now, we need to choose our colors. Click on the first color tab, and when the Colors Viewer opens, click on your first color choice. Click on the second tab and choose your second color. In our example, the colors are Tangerine and Banana, from the crayons box.
	Click and rotate the Angle wheel to change the direction of the flow.
	Import the graphic image of the text and slide it over the shape. The image, in PNG, PDF, or JPEG format, has black letters on a white background.
	Resize both the image and the shape with Gradient Color Fill. The shape should be larger than the graphic image of the text.
	Remove black text with Instant Alpha. The letters will now be transparent, and the flowing color of our shape will be visible through the letters, filling them.[image: How to do it...]

	For a glowing effect, add a shadow to the image of the letters. To add a shadow, check the box against Shadow in Graphic Inspector and give it one of the colors of the gradient combination. In this example, it is Tangerine.[image: How to do it...]

	When finished, group the screenshot and the shape behind it, export to PDF, PNG, or JPEG, and use it in your project or document (resize, crop, or mask as needed).



How it works...



We have used a variety of techniques and tools in this recipe. This section gives a brief explanation of how each of them works.
Text



When choosing the font, we go for one that has thick variations, such as Black or Condensed, because these fonts provide more space inside the letters, to be filled with color. This is why we've chosen Hoefler Text Black.
It may look better if we bring the two letters closer before turning them into an image. Select them, and in Text Inspector use the Spacing arrows to reduce the default distance between the letters. Here, it is set at -9 %. This technique is also called 
 kerning.
We increase the size as much as possible, so that the two letters fill most of the page, because we want to work with a high resolution image (high resolution images can be scaled down later, whereas low resolution images cannot be scaled up). In our example, the font size is 470 points. To increase the text size, select it, press Command, and type (press) the + (plus) key continuously. Also, we can open Font Panel and type our desired size in the font size window.

Creating an image



Taking a screenshot is one of the easiest ways of making an image. We can also convert our iWork document to PDF. Open the print dialog (Command + P), click on the PDF tab, and choose Save as PDF. Which format to choose depends on how you intend to use the graphic image. PDFs are suitable for high-quality printing and PNG files are better for the Internet.

Gradient Fill



This 
option blends two colors inside a shape, giving the color a flowing effect—one changes into the other from side to side. The arrows to the right of the Angle wheel can be used to change the flow from horizontal to vertical.
The current version of iWork also has the 
Advanced Gradient Fill option, by which you can blend more than two colors. They can flow from side to side or in a circular way, like ripples on water.

Alpha tool



As the 
letters of the heading are now a graphic image, we can use graphic tools on them. Click on Instant Alpha in the toolbar (or choose it from the Format menu) and rub out the black letters. Drag the cross that appears when you activate Instant Alpha several times, for cleaner removal. Hit Return when you are finished with Instant Alpha.

Shadow



Because we've rubbed out the letters, they are now like holes in a piece of paper. They behave like edges of an object, and the shadow comes off these edges, that is, inside the letters. The colored shadow inside the graphic image gives the whole design an additional glowing effect. Experiment with different offset and blur settings for the shadow, and with its direction, by changing them under 
Shadow. In this example, the shadow is offset at 15 points and blurred to 22 points.


There's more...



The background can be removed, if you prefer to use only the two letters as a heading. Crop it out from the graphic image in iPhoto or Preview. Preview also has the Alpha tool under the Select drop-down menu. If we remove the white background around the letters, we will be left with just the glowing letters for our design.
[image: There's more...]
Before converting the final iWork document into a graphic image, consider stretching up the FG design.
To do this, select the image, uncheck the Constrain
proportions checkbox in Metrics Inspector, click on the handle in the middle of the top of the image, and pull it upwards. Its width will remain the same, but it will become taller.
You may have used a widely available font, but changing the way it looks as a graphic image will give your image a unique look—just what is needed for a good design.
[image: There's more...]

See also



	The Putting images inside letters—filling letters with photos and other graphic images recipe in Chapter 6, Graphic Design—Working with Clip Art and Making Your Own




Using the color picker to create a custom color palette




Color picker
 is a tool in Colors Viewer (Inspector) that can copy colors off any spot in a photo. This function lets us replicate and use unique shades of natural colors. This recipe describes how to use the color picker to give the design elements in your projects the colors that are already present in the photo you are using. This trick gives a 
harmonious co-ordinated color sequence to your project.
In addition, we will also look at how to create a custom color palette for your project.
Getting ready



To see how color picker works, we will use this photo of a seafood dish in a French restaurant (photo by Miranda Ingram):
[image: Getting ready]

How to do it...



Follow the ensuing steps to 
pick up the color of the wine to use for column dividers (lines):
	Import the photo into an iWork document.
	Import a line from the Shapes menu. Leave the line selected.
	Open Graphic Inspector.
	Under Stroke, click on the color well for the line. Colors Viewer (Inspector) will open.
	Click on the magnifying glass icon next to the color well in Colors Viewer. The cursor turns into a small magnifying glass with crosshairs inside it. This is the color picker.[image: How to do it...]

	Move the magnifying glass over the photo to find the color you like, then click on it. Here, it is the lighter shade of wine in the glass. The color of the line takes the color from the photo.
	The new color will be shown in the color well of the Colors Viewer. Click in the well and drag the color to the palette (gridded rectangle) at the bottom of the Colors Viewer to store it for future use.



How it works...



Color picker tracks the colors of the photo pixel by pixel. If you find it difficult to catch the color you want, enlarge the photo—color picker will be able to distinguish more shades of color in a larger photo.
When you open a new
 iWork document, the color will be stored in the palette, and you will be able to use it again.

There's more...



We can simply store our custom colors in the palette at the bottom of the Colors Viewer. A point may come when we feel we need to organize our colors better and give them names to remind us where we can use them. The following steps describe how to create a custom colors palette for your 
iWork project.
	Click on the palettes icon in the Colors Viewer.[image: There's more...]

	Click on the action wheel to the right of the Palette drop-down menu and choose New.
	Double-click on untitled, and type in the name of the palette, for example, Magazine. Store all colors created for the magazine in this palette.
	To store, click on a color that is already stored in the palette grid at the bottom of the Colors Viewer and drag it to the Magazine palette window as shown in the following screenshot:[image: There's more...]

	In theMagazine palette window, the newly added color will, by default, have the name of the palette and a number, for example, Magazine 1. Click on the name Magazine 1, to highlight it, and type in the name you want to give the color, for example, Food and Wine col divider.


When you next work on the Food and Wine section, you can open the palette and give this color to column dividers. Have two or three co-ordinated colors to use for box frames, headings, captions, text, and other design elements in each section of the magazine, to give each section a distinct style.
To remove a color from the 

Magazine palette, simply click on it to select it, and then click on the minus sign below the palette window. The color will be removed from the Magazine palette but will remain in the grid with your previously stored colors.
You can add colors 
to your project palette straight from the photo. Choose a color with the color picker, and drag it from the color well at the top to the palette window. Give it a name.
A complete set of custom colors will give your publication a professional, branded look.

See also



	The Using flowing colors for graphic headings recipe




Fading an image from side to side with an overlapping object



A page, an article, or a section in a publication looks better with one strong graphic image, which pulls together the rest of the material. One way of designing such an image is to take a mood-creating picture and partially mask it, so that it appears to be disappearing into a soft haze, from transparency to opaque. The haze can go from side to side, or from top to bottom.
This recipe describes how to design such an element for your publication.
Getting ready



This photo by Miranda Ingram might illustrate an article or column on fine wine or a romantic outing. Let's see how fading part of it enhances its role in our design.
[image: Getting ready]

How to do it...



The following steps describe how to fade an image from side to side, with a white shape:
	Import the photo into your iWork document.
	Import a rectangle from the Shapes menu.
	In Graphic Inspector, under Fill, select Color Fill, click in the color well, and choose Snow (white) in the Colors Viewer.
	In Graphic Inspector, the next option below the Fill section is Stroke. Click on the drop-down menu and choose Picture Frame:[image: How to do it...]

	Click on the Picture Frame pop-up menu and select a frame with blurred edges. Drag the Scale slider to set it at 50 %.
	Position this object to cover the photo, and resize it so that it looks as though the photo itself is fading from right to left or left to right. The rectangle should be bigger than the photo. At this stage, it already looks as though part of the photo has faded.
	The third option in Graphic Inspector is Shadow. Click in the checkbox to apply a shadow.
	Click in the color well under Shadow and choose Snow (white) from the crayons box in the Colors Viewer. 
	Still under Shadow, set Offset at 50 pt (points), Blur at 72 pt, and use the Angle wheel to set shadow's direction at 0º.[image: How to do it...]

	Move the rectangle around to cover more or less of the photo until you are satisfied with the result. When you've achieved the desired effect, group the rectangle and the photo under the Arrange menu.


This is how the finished design may look:
[image: How to do it...]

How it works...



First, import the photo so that when we insert the rectangle that is going to be used for fading, the shape goes on top of the photo. When we insert objects in iWork documents, they are positioned in layers with each new one on top of the previous one like stacking papers on our desks.
Clicking in the color well in Graphic Inspector opens the Colors Viewer, which looks like another Inspector. It has a choice of preset colors in the crayons box. We can create our own custom color by choosing Colors | Color Wheel instead of using crayons. Drag the colors editing point to mix colors, and the darkness slider to make them darker or lighter.
We can also pick up a color from the photo. Click on color picker, the small magnifying glass icon next to the color window, and when the cursor turns into a magnifying glass, move it over the photo to copy a color from the photo to use as the fill color for the fading rectangle.

Picture Frames under Stroke has a Scale slider. Drag it from left to right to make the frame wider or narrower.
The Shadow option includes a separate color well. Shadow will have a default color, depending on the template you use. In the Blank template, it is black. Click in the color well under Shadow, and in Colors Viewer, choose the color you want for the shadow. In our example, it is white, but you can use the color picker to copy a color from the original photo. In this picture, the photo is faded from left to right with a beige color that is picked from the colors of the wine.
[image: How it works...]
Under Shadow, the 
Offset setting controls how far the shadow is set from the photo. The Blur setting changes the width of the mist effect. The Opacity slider makes the shadow more or less opaque. The Angle wheel controls the direction of the shadow. You can change the settings that we have used here to suit your own design.

There's more...



Having faded the photo, we can add Text Boxes and other design elements to our page. If you have created a custom color for the fade, consider using the same color for column dividers, Text Box frames, or headings. This will create a color style for the whole page or section.
The photo will have a wrap effect, pushing away the text around it. To deactivate this function, uncheck the Object causes wrap option in Wrap Inspector, or under Object Placement, choose In background.
To use the same faded photo on other pages or iWork projects, we can copy and paste it or make a screenshot (Command + Shift + 4). For using it in other applications, convert the iWork document with the photo to PDF, edit or crop it in Preview or iPhoto, and then import into any other document format.

See also



	The Using the color picker to create a custom color palette recipe




Setting custom document dimensions



Dimensions of documents come in a variety of printing formats. Beside the standard office sizes, for example, US Legal or A4, iWork documents have a number of preset formats, each with their own dimensions in inches or centimeters. Templates included with iWork—from cards to posters—come in these formats.
However, when you venture beyond the usual formats, you may soon be requested to set your project in dimensions that are not in the menu of preset formats. Commercial print shops and web-based printing companies, including highly automatized print-on-demand sites, often have their own formats.
This recipe describes how to set custom dimensions for your project, either to meet your own design needs or the technical requirements set by a printing service.
Getting ready



Get the precise 
dimensions that you need for your document from the print shop or web-based printing company that you've decided to use. They are usually happy to give advice or already have detailed instructions on their websites.

How to do it...



Follow these steps to set custom dimensions:
	Navigate to File | Page Setup or select Page Setup from the Document Inspector.
	In the Page Setup dialog, click on Paper Size and go all the way down to Manage Custom Sizes.... A new dialog for custom sizes will open:[image: How to do it...]

	In this new dialog, click on the plus sign on the left and type in new dimensions in dimension windows.
	Double-click on untitled and type over with the name of the custom format that you have created, for example, BLONDES.
	Click on OK to save the new format. The dialog for custom sizes will close, while the Page Setup dialog will still be open.
	In the Page Setup dialog, choose the new format, BLONDES, from the Paper Size menu.[image: How to do it...]

	Open the Print dialog and make sure your new format is shown at Presets | Current | Paper Handling | Destination Paper Size.
	If you are converting your iWork project to a CMYK PDF to send to a commercial printer, make sure that Adobe Acrobat printer is chosen under Printer in the Print dialog. This is not a real, physical printer but a converting option.



How it works...



Dimensions can be set in iWork down to one hundredth of an inch or centimeter. Some printers may ask for an even more exact setting. Depending on the project, it shouldn't be a problem, but make sure to check with the print company.
Following these steps should also help you avoid a situation where an iWork document is not converted to PDF properly. Sometimes PDFs come out with a band of white empty space around the document, and occasionally, they are truncated with only part of the document showing in the PDF (see Chapter 8, PDFs and Professional Printing).

There's more...



Even when one of your preset sizes is to be used, your printer may ask you to add printer trim to the dimensions. When printing, some space is left around the actual page of the document. It is used for technical information and is cut off (trimmed) at the final stages of the printing process.
This is usually 3 mm
 (0.12 inches), all around the document, but may differ depending on the use. It means adding 6 mm to the width and height of the document. Before sending over your whole project, make sure to send a sample PDF (proof) to your printers, to check that the dimensions you've set answer their requirements.

See also



	Chapter 8, PDFs and Professional Printing




Using columns and Text Boxes to lay out text



Projects in iWork organize text in Text Boxes. In Pages, we can also use Word Processing mode. Documents opened in Word Processing allow us to type text straight onto the pages, without creating Text Boxes. This recipe explains how to organize text in a document by 


using layout options in Word Processing mode and how to use Text Boxes to give the appearance of columns.
Getting ready



Prepare a sample text of about 400 words and a few photos. Photos can be on the desktop or in an events cluster in iPhoto. We will use these to create a simple one-page design.
Before starting, practice the shortcut for showing and hiding the layout grid and invisible formatting characters—Command + Shift + L for layout and Command + Shift + I for invisibles.

How to do it...



The following screenshots show two similar pages. One is laid out with Text Boxes (first) and the other with Layout options.
[image: How to do it...]
[image: How to do it...]
Follow these steps to lay out a page with Text Boxes:
	Open a blank Pages document in either Word Processing or Page Layout mode. Type Command + Shift + L to show layout.
	Click on the Text Box icon in the toolbar to insert a Text Box. When a Text Box is created, it has a highlighted Type to enter text prompt inside it. Type the title (heading) over the prompt, click away, and click on the Text Box again to select it. Resize the Text Box by stretching it horizontally and move it to the top of the page.
	Double-click on the heading inside the Text Box, enlarge it, change the font variation to bold, or change the color until you have your desired look.[image: How to do it...]

	Add two more Text Boxes. In Metrics Inspector, make them 2.8 inches wide and 8.7 inches high (7 cm x 22.2 cm). We don't need to create the two boxes separately. Create the first, and then type Command + D to make a copy of the first box.
	Position the two new boxes under the first one with the heading. The left side of the box with the heading should be aligned with the left-hand side box underneath. The upper sides of the two vertical boxes should be aligned to one another. Alignment guides help to do this with their Snap to Grid function.
	Copy and paste your sample text into the Text Box on the left. Part of it will not fit, and the overflow sign—a white square with a plus sign inside it—will appear.
	The first Text Box will have a blue square on its right-hand side, towards the bottom. Click on it to activate linking, and then click anywhere in the second box. A diagonal blue line connecting the two boxes will appear, and the remaining text will flow into the second box.
	Add photos inline to the text. Click on the photo we have waiting on the desktop and copy it (Command + C). Then, click in the text where you want to place the photo and paste (Command + V) it. The photos are automatically resized to fit the width of the box. Drag a photo's handles to make it smaller.
	Next, add subheadings and format the text, for example, setting indents and space after paragraphs. Text will flow from one box to another as the first box fills.
	We can add a large photo as a floating object and make space for it by dragging down the handle in the middle of the upper side of the second Text Box. Under the photo, add another Text Box for a caption. Resize the photo and the caption box to align with the Text Box.Tip
If there is an empty space left in the second Text Box, increase the spacing before or after paragraphs. Do this, preferably, before or after your headings so that it is less noticeable. Ideally, the last line in both boxes should be aligned so that the design looks tidy.




This completes the basic design with Text Boxes.
To design a 
page with columns, follow these steps:
	Open a new Pages document in Word Processing mode. Type Command + Shift + L to show layout and Command + Shift + I to show invisible characters.
	Type the title (heading) in a bold variation of your font (here it is Helvetica Neue) at 28 points size.
	The cursor should be right after the last letter of the title. Go to Insert | Layout Break.
	In Inspector, click on Layout, and under Columns, set the number at 3. Double-click in the window and type 3 or click on the up arrow next to the window. Tick the checkbox for equal column width.
	Set Gutter at 0.2 in (0.5 mm). The column width will adjust automatically.
	Type in or copy and paste your text. It will flow into the columns.
	Add photos inline—click on a place in the text where you want to place the photo, and then go to Insert | Choose (Command + Shift + V). When the dialog opens, find the photo on the desktop and click on Open. If the photos are in iPhoto, click on the media icon in the toolbar. In Media Browser, click on Photos, choose iPhoto, click on Events, and click on the photo thumbnail. The selected photo will show a blue border. Copy (Command + C), click in the body of text, and paste (Command + V). Photos are resized automatically to fit the column width. By dragging the black square handles, we can make them smaller, but we cannot make them bigger than the width of the column.
	Click on the space immediately after the last character at the end of your text, for example, the period, and go to Insert | Layout break. All three columns will level out—they will now have the same length. At this stage, we can add subheadings, give the opening paragraph of the article a different style (color or font variation), set the space between paragraphs, and adjust the size and position of photos.
	Go to Layout Inspector and set the number of columns for the remaining part of the page. Set the number to 1 and type in the next title (heading).
	Insert a layout break after the title and set the number of columns for the next body of text.


This completes the basic design of a page, using the Layout options to organize it.

How it works...



The advantage of laying out a document with Text Boxes is that you can position blocks of text anywhere you like on the page, as though they are graphic objects. It allows more freedom when the graphic elements, photos, charts, and graphs are more important in your document and the text is there to explain them. Here, we've used two boxes, but more can be used.
There is no Word Processing mode in Keynote and Numbers, so text in these applications has to be laid out in Text Boxes.
In Pages, Word Processing mode has the advantage for text-rich projects such as newsletters, magazines, or books. Layout tools allow us to work more quickly with text in projects.
Decide which method to use when planning your project.
The gutter (space between columns) is often too wide when we use the default settings. We can reduce it manually in Layout Inspector. Columns can also have different widths—uncheck the Equal column width box and set the widths manually.
As you work, you will want to check how the finished document will look, but the layout grid and invisible formatting characters may make it difficult to visualize this. Press Command + Shift + L to hide the grid and Command + Shift + I to hide the invisibles. These shortcuts are easy to remember—L for layout and I for invisibles.
Layout Inspector has windows for setting layout margins in the Layout Margins field. The settings done before and after creating layout are especially useful when we want more space, say between the heading and the main body of text.
When placing inline 


photos, we may want them to sit to the right or to the left, with text flowing around them. Click on the photo and go to Wrap Inspector, and put a tick in the Object causes wrap box. Below this box, select left or right, or another option. To set the text further from or nearer to the photo, click on the up and down arrows next to the Extra Space window.

There's more...



Text Boxes in Pages, Keynote, and Numbers can also be linked via Format | Text Box | Link Selected Text Boxes. If you select more than two boxes, they will be linked in the order you've selected them. Under Format | Text Box, there are options that allow us to break the link or add more boxes.
Use the Column Break option to end a text item within one column and move to the next column. Click on the space at the end of the text and go to Insert | Column Break. This is handy, for example, when you want a row of columns with text of varying lengths in each column.
You can have a multi-column layout within Text Boxes. Double-click a box, so that the cursor blinks within the text inside, go to Layout Inspector, and choose the number of columns.

See also



	The Using tabs to stop text sticking to the edges of colored background recipe in Chapter 2, Working with Text
	The Placing, cropping, editing, moving, and resizing photos recipe in Chapter 5, Working with Photos: Tips and Tricks




Designing repeating elements such as footer and object co-ordinates, and creating sections



An ongoing project, such as a periodic publication, should have recognizable design elements on every page. Headers and footers are typically used to include information that identifies the publication and guides the user through it.
In this recipe, we will look at how to create a footer that contains a graphic object, a page number, and information about the publication—its name, issue number, and date.
Getting ready



We will be using a standard A4 format with 210 mm × 297 mm (8.27 inches × 11.69 inches) dimensions.
For style, we will take the title example from Chapter 9, Planning Large, Long-term Projects. The font that we will use here is Optima Bold.
[image: Getting ready]

How to do it...



Follow these steps to 
create a repeating footer:
	Import a simple line from the Shapes menu. We don't have to set its dimensions at this point.[image: How to do it...]

	In Wrap Inspector, uncheck the Object causes wrap checkbox to disable wrapping.
	In Graphic Inspector, navigate to Stroke | Line and set the line width at 3 points.
	Click on the color well next to the width window and the Colors Viewer opens. Click on the color picker and copy the color of the R in the title.
	Rotate the line to a vertical position. Press Command + Shift, and drag the right point to 270 degrees. Pressing Shift in addition to Command rotates objects by exactly 45 degrees.
	Move the line to the bottom-left corner of the page, so that the lower part of the line goes beyond the edges of the page.
	Note the line's starting point co-ordinates in Line under Metrics Inspector. In our example, they are 0,77 in for X and 10,92 in for Y. We only need coordinates for the top point of the line (Start). The End of the line also has X and Y co-ordinates.
	Under Arrange, choose Lock to fix the vertical line in its position, so that it won't move accidentally as the work progresses.
	Click in the footer of the document and navigate to Insert | Page Number. Page numbers will change automatically as you add more pages to the document.[image: How to do it...]

	The vertical line and the page number may be too close to one another. To set the page number further away, go to Text Inspector and select Tabs. Set First Line at 0.2 in. The number will be set away from the line.
	Highlight the page number and change the default font to the one you've chosen as the house font for your project. In our example, it is Optima Bold. Set the size of the font; here it is 14 points.
	Next, type in the title of your project, issue number, and date. Don't overload the footer with information—it shouldn't distract from the contents of the page.
	Select all (Command + A) and change the color to one of the colors that you've chosen for your house style. Here, we will change it to black.
	Select the title in the footer, and change the color to another house color. Here, it is the gray for "the" in the title:[image: How to do it...]

	Select just the "R" from the title, which you can also use as the logo of your project, and give it the same red color as in the title. To copy colors, you can use the color picker in Colors Viewer, or click on the house color in the colors palette, if you have stored it there while preparing the project design. (see the Using the color picker to create a custom color palette recipe discussed earlier in this chapter).
	Save the document.


In a multi-page project, especially if it is going to be printed and bound, you may want to have left- and right-hand pages. In this case, the right-hand pages will need the footer on the right side. These steps describe what to do:
	Go to the page that has to be on the right-hand side. Then, go to Layout Inspector.
	Click on the Section tab.
	Under Configuration, put a check mark next to Left and right pages are different.
	Uncheck Use previous headers & footers.
	On a right-hand side page, click in the footer, go to Text Inspector, click on the Text tab, and under Color & Alignment, click on the icon for aligning text to the right. All the text in the footer will move to the right:[image: How to do it...]

	While still in Text Inspector, click on Tabs, and under Paragraph Indents, in the Right window, set the value at 0.2 inches. The text in the footer will be set off the right margin at the same distance as it is set off the left margin on the left-hand side pages.
	Highlight and cut the page number and paste it to the right of the rest of the text. Now, it will sit closer to the outer edge of the page.[image: How to do it...]

	Move the red vertical line to the right margin of the page, making sure that its Y co-ordinate stays exactly the same as on the left-hand side page.
	Save the right-hand page as a section—navigate to Format | Advanced | Capture Pages. When the dialog opens, type in the page description, noting that it is a right-hand page, and click on OK.



How it works...



Each new object, including Text Boxes and lines, has a default wrap count when we insert them into our document. It is set at 12 points. Wrap pushes text away from the object, making words flow around it. As the line at the bottom of the page is a repeating graphic element of our design, we remove the wrap so that it won't distort text placed on the page.
In Metrics Inspector, the position of lines is described with co-ordinates X and Y. The X co-ordinate gives the position measured from the left edge and the Y co-ordinate gives the position measured 
from the top. The starting and finishing points of a line both have X and Y co-ordinates. So, the two sets of X and Y co-ordinates give the exact position of the line in the document. Make a note of the co-ordinates of the line when you need to place it in a new document. Note that copying and pasting it into another document may not necessarily put it in exactly the same position.
The position of other floating graphic objects, not just lines, can be described with co-ordinates.
The vertical red stroke at the bottom of the page is a simple design element. But, it may also be used as a guide for commercial printers to align PDFs of the pages in your document, especially if you are not using other typographical guides.

There's more...



If you want more flexibility on where you put the repeating elements on a page, you can put the page number, title, and other information into a Text Box and group them with the vertical line, by navigating to Arrange | Group. But you will have to enter each page number manually.
We can save the document with the finished footer as a template. Navigate to File | Save as Template. It will be saved in the My Templates folder and available to use from File | New from Template Chooser | My Templates.
A number of pages and sections in your project will have a distinct composition that will be repeated from issue to issue, for example the contents page. At this point, consider using Format | Advanced | Capture Pages. When the dialog opens, type in a description of the section and click on OK to save it with the new name.
This option adds new pages to your template. Next time you want to add a particular page to your project when you update it, click on Sections in the toolbar and choose the saved (captured) page. It will be added as a new section to your document. Use the Format | Advanced | Manage Pages option to rename or delete your template sections.
Use Format | Advanced options only when you are completely satisfied with the design and want to re-use it as it is in new projects.

See also



	The Designing the title in print or electronic format recipe in Chapter 9, Planning Large, Long-term Projects
	The Using the color picker to create a custom color palette recipe




Chapter 11. Mastering Numbers: Tips, Techniques, and Fun



In this chapter we will cover:
	Rearranging rows and columns
	Hiding columns instead of deleting them
	Adding up selected cells
	Setting and using formulas in financial documents
	Making documents secure and private
	Adding pictures to cells
	Using color coding—changing table row colors and setting cells to change color automatically
	Using clip art and photos in charts—the unbeatable visual effect of Numbers documents


Introduction



Numbers is a spreadsheet application in iWork. If you are familiar with Excel or other spreadsheet applications, you will be able to open a Numbers document and start working in it without any difficulty. Even if you aren't comfortable with spreadsheets, it's likely that you have already used tables in word processing applications, such as Pages. Numbers isn't that different from navigating tables.
Once you have started using Numbers, you will see that the application is not only easy to use, but is also handy—and fun—for many practical tasks that have little or nothing to do with calculations.
Recipes in this chapter are primarily for occasional users of spreadsheets. But experienced users will also find the techniques described here useful, especially the recipes for how to use photos and graphics in Numbers documents.


Rearranging rows and columns



If you 


mostly use word processing, you may be expecting that you will have to learn a new set of techniques when you try Numbers. However, many operations with cells, rows, and columns are very similar to what you are already accustomed to when working with text.
This recipe describes how to change the order of columns and rows in a simple table by dragging—similar to how we drag selected chunks of text from one position to another.
Getting ready



Let's prepare a sample invoice, which includes several items. We can use the Numbers invoice template, which has rows for merchandise and other chargeable items, and columns for quantity, unit price, and cost. The template automatically calculates the subtotal, VAT (if applicable), and the total sum to invoice. The example shown in the following screenshot shows money in Euros, but other world currencies are available in Numbers. Highlight cell(s) and open Inspector. Then, choose Cells Inspector, and pick the appropriate currency symbol.
You may have listed labor costs first, but have now decided to put them at the end of the final invoice.
[image: Getting ready]

How to do it...



Follow these steps to rearrange the rows:
	Click on the table showing the prices to select it. The table shows numbered rows, with numbering starting at the row with the column headers. Columns are referenced in alphabetical order.
	Click on number 2—on the digit (the reference tab) itself. This selects the row. Let go of the mouse button.
	Click on it again, hold, and drag the row to the new position, for example, to the row after all other items. As you drag, the insertion point for the row gets highlighted as a thick blue line. Let go, and the row takes the new position. The numbering of the rows adjusts automatically.


Use the same steps to rearrange columns, for example, if you want to put total cost first and break down the unit price and quantity afterwards.

How it works...



The numbers and letters that index the rows and columns are called 
reference tabs. They only appear when we work on the table and stay invisible on printouts and PDFs.
If you click on the row number (reference tab) and immediately start dragging, you will not move the row or column but select adjacent rows or columns. This may feel annoying at first, but it only takes a short time to remember to make a slight pause before clicking again on the number or letter (reference tab) before beginning to drag.

There's more...



We can copy and paste columns, rows, and cells. Click inside a cell, for example, the one showing the labor costs, and type Command + C. In a different invoice, where the labor cost cell is empty or shows a different sum, click on that cell and type Command + V to paste. The sum will change to the one you have pasted.
We can copy and paste the contents of several cells at a time. Select the cells to copy, type Command + C, select the destination cells, and type Command + V. Options to cut, copy, and paste are also available under the Edit menu.
If you want to paste cells, columns, or rows without replacing the existing ones, you can add copied cells, columns or rows via the Insert menu. Choose Insert | Copied Columns or Insert | Copied Rows, and a new row or column will be added.


Hiding columns instead of deleting them



There are several 


reasons why you may want to hide information in your spreadsheets. Hiding parts of a large table that has hundreds of columns and rows of secondary details allows a better overall understanding of the data. You may also want to keep the names and addresses of your customers private. If you are negotiating a deal, you may not want the other side to see your bargaining positions, such as estimated costs, prices, and valuations.
Note
In certain cases, for example, when you put spreadsheet documents in promotional literature and on your website, you may be required by law to hide private information. Check data protection legislation and rules for your country.

This recipe describes how to hide columns and rows in Numbers documents.
Getting ready



Open the Home Inventory template in Numbers and select the Inventory table. You can click on the table itself or on the table icon in the side panel of the document.
[image: Getting ready]

How to do it...



Follow these 
steps to hide columns:
	In the Numbers document, click on the table to select it.
	To hide a column—for example, column H, Original Cost (of your home possessions)—move the cursor over the H tab and click on the small black arrow to open a drop-down menu:[image: How to do it...]

	Select Hide Column. The column won't be shown now, but all the data it contains will still be preserved in the document.


To hide several adjacent columns, for example, F to I, select F, press Shift, and click on the reference tab I. All four columns will be selected. Choose Hide Selected Columns from the drop-down menu in column I, to hide all selected columns.
To select and hide several columns that are not adjacent, with one or more in between, select them while pressing Command. Each will be selected separately while the ones in between will stay unselected. Then, hide columns as discussed in the preceding steps, by choosing Hide Selected Columns.

How it works...



In Numbers templates, each spreadsheet is placed on an empty space called the canvas
 or 
Sheet canvas. You can move tables, charts, and other objects around to arrange them, but you can't write on the canvas as this is done in a word processing document. To add text, you must insert a Text Box and type in it.
When you 
click on a table in Numbers, the rows show numbers from top to bottom and the columns show letters from left to right, like in the game Battleships. These are called 
reference tabs. When you move the cursor over a reference tab, it shows an arrow, which when clicked, opens a menu with available options.
When you want to show the hidden rows or columns, you can click on the Table screen-top menu and choose Unhide All Columns or Unhide All Rows.
Alternatively, you can unhide columns and rows from the drop-down menus of rows and columns.
To check if there are hidden columns or rows, check if there's a break in the referencing sequence. When numbers or letters are missing, it means there are columns or rows hidden. Select the rows or columns on each side of the missing ones and choose Unhide Selected Columns or Unhide Selected Rows from the drop-down menu.

There's more...



When we want to send out our Numbers spreadsheet, we can export it to PDF or Excel. The hidden columns will be removed. To choose an export format, go to File | Export or Share | Export and choose a format—PDF or Excel—from the dialog.


Adding up selected cells



When you have a 
large spreadsheet with dozens or even hundreds of entries, you will, from time to time, want to check what's going on with certain groups of cells.
For example, you may want to see how much of your revenue comes from small advertisements. Or you've set your document to show overdue invoices in red. This data may not be grouped together in your spreadsheet, but you can quickly look up the information you need by selecting a range of cells and checking results at the bottom of the side pane in the Numbers document, where a number of common calculations are displayed. As you select cells, the results are instantly displayed.
This recipe describes how this useful technique works.
Getting ready



The following 
screenshot shows column K from a large spreadsheet with customer information—billing details and sums to be invoiced. Total sums are at the bottom of the table. Here, let's see how only data from some of the cells can be added up.

How to do it...



To add up a continuous range of cells, perform the following steps:
	Click on the first cell in the K column (Total for invoice) to select it:[image: How to do it...]

	Press Shiftand then press the down arrow key on the keyboard. If you press the arrow once and let go, the cell below the first one will be added to selection. If you press the arrow and hold, subsequent cells will also be selected.
	Stop when you reach the last cell in the range.[image: How to do it...]

	In the bottom-left corner of the document, below the main side pane, several common calculations are done automatically, showing instant results. For example, the sum of selected cells is shown here. Select and add more cells, and the result will change.[image: How to do it...]



To add up non-adjacent, separate cells for an instant calculation, for example, only cells in red (unpaid invoices that have to be chased), do this:
	Click on the first cell you want to select.
	Press Command and click on the next one, then the third, and so on. Only the cells you click on will be selected, and their sum will be shown in the bottom-left corner:[image: How to do it...]




There's more...



If you want to 
track the calculation for a selection of cells in your document, for example, a running total, click on the instant calculation icon in the bottom-left corner and drag it to a free cell in the table. The formula and the cell range will be put in that cell and it will show the result in your Numbers document. If you change data in any of the cells, the result will change too.


Setting and using formulas in financial documents



This recipe shows how 


formulas work to make automatic calculations in common financial documents.
Numbers include formulas for advanced accounting and scientific calculations. However, in common daily use, we are more likely to do straightforward sums and calculate percentages to manage our home budgets or small businesses.
Let's see how to apply Numbers formulas to calculate VAT as a percentage of the sum of goods and services. Mastering this type of calculation will be useful when dealing with income tax, interest, trade discounts, and so on.
Getting ready



We will be using the Numbers Invoice template. Open it from File | New from Template Chooser.
The template


 has an invoice table that is already formatted for adding up items and calculating VAT. Click on it to select the table and enter approximate costs for the job of installing a local computer network in a client's office. The table can look like the one shown in the following screenshot.
To show how this works, let's assume that the cells do not already have formulae and formatting that are contained in templates. To gain more confidence, try repeating the steps described here for blank cells.
[image: Getting ready]

How to do it...



These steps explain how to set automatic percentage calculations in your financial document:
	Click on a cell where you want to enter the percentage figure (value). In our example, it's 8.25 % VAT in cell C12.
	Open the Cells Inspector.[image: How to do it...]

	Under Cell Format, click on the drop-down menu and choose Percentage.
	Set Decimals to 2 by typing the number 2 in the window or clicking on the up and down arrows.
	Click on the cell where you want to show the sum representing 8.25 % of the Subtotal. In our example, it is D12. In the Cells Inspector, under Cell Format, choose Currency, and then set 2 for decimal points in Decimals.
	When a cell is selected, you can type in it straightaway. First, type the equals sign (=). This activates the Formula Editor and a black frame shows around the cell:[image: How to do it...]

	After equals (=), type in the cell references—D11 (Subtotal) and C12 (Percentage)—separated by the multiplication symbol (*). The formula will look like this:
=D11*C12


	Click on the green check (tick) mark to enter the formula for cell D12. The Formula Editor window will close and the cell will show the sum of VAT values to be added to the subtotal.
	The cell for Total (D13) must show the sum of Subtotal (D11) and Tax (D12). Click on D13 and type =SUM(D11:D12):[image: How to do it...]

	Click on the green check mark to save the formula, and close the Formula Editor.


Now our invoice is ready for instant automatic calculations.

How it works...



Cells in a spreadsheet may look like Text Boxes, but they work in a slightly different way. Just like with a Text Box, you can click in a cell, and then double-click to select a word or a number or triple-click to select all of the cell's content, including formulas. Then you can cut or copy it. But you can also simply click once in a cell and straight after this cut, copy, or type over it.
We usually don't need decimals beyond two digits after the decimal point. Numbers automatically round up the result to two digits where, in fact, it may be longer. In a project where more digits have to be shown, set the number of digits in the Decimals window in the Cells Inspector.
There is also a choice of options for displaying negative numbers. Click on the tab and choose to display negative numbers with a minus sign, in brackets or in red color.
Setting Cell
Format to Percentage automatically inserts the formula for calculating percentages into a cell. When we set the format for cell C12 as Percentage, it displays 8.25 %, but in calculations, treats it as multiplying by 0.825. Simply typing 8.25 % in the cell isn't enough—without setting the format to Percentage, Numbers will treat it as multiplying by 8.25 and give the wrong result.
Likewise, for cells 


where sums of money are entered, we must set the format for Currency and choose the one we want to use from the Symbol drop-down menu under Cell Format | Currency. The drop-down menu displays a choice of common international currencies.
After SUM, we open brackets and put a colon between the first and the last referenced cells. The colon indicates a range of cells. For example, if cells from D2 to D9 are to be added up, the formula should be =SUM(D2:D9), as in the cell for Subtotal. If only two cells are to be added up, type D11:D12, as in the cell for Total.
If you type something you don't want in the formula, click on the red button with a white cross to cancel formula changes. If you put the wrong sign in a formula, don't panic, undo your last move (Command + Z), check what the correct sign is, and type it again.

There's more...



When a cell is formatted to have a formula, the Format Bar appears under the main application toolbar at the top of the Numbers document. If you click on the ƒx sign, it opens a menu with a wide selection of formulas. You can choose the formula and then type cell references in the Format Bar. Click on the green button to enter it for the selected cell(s).
[image: There's more...]
Column headings in the header row can be used for referencing cells. Here, we have column B with the header Quantity and column C with the header Unit Price. In this template, cells in column D (Cost) are automatically set to multiply quantity by unit price, which is described in the formula as Quantity*Unit Price:
[image: There's more...]


Making documents secure and private



Computer security is an increasing concern as Wi-Fi and high-speed Internet access have become widely available. If we mostly use our machine at home and don't share it with anybody, we tend not to think about making our documents secure. Or, we don't worry much about someone breaking into our accounts, simply because we don't have much money!
But Internet security is not just about preventing hackers from dipping into our bank accounts. Identity theft is an increasingly worrying issue.
In the current version of iWork, all documents can be protected by secure passwords—whether Numbers, Pages, or Keynote documents. Of these, Numbers spreadsheets are more likely to contain private financial and other information. In this recipe, we will see how to set password protection for such documents.
There is always a fine balance between security and practicality. If you have a very strong password, you may find that it is also difficult to memorize. If you store it written down somewhere, you may lose your notes and access to your own documents. Or someone may get access to your notes. If your password isn't strong enough, someone may break it. Don't get paranoid—before setting up password access to your documents, decide what you really do need to protect.
Getting ready



Open the Budget template to have a Numbers document at hand. We will not need its content, only menus and Inspectors.

How to do it...



Here are 
ways to manage password-protection in a Numbers spreadsheet:
	To add a password to the spreadsheet, open Document Inspector and check the Require password to open checkbox in the Document pane:[image: How to do it...]

	Type the password you want to use in the Password and Verify fields, and then click on Set Password. A lock icon will appear next to the document title to indicate that your document is password-protected:


That's it! Your document is now private and secure. In the title bar of the file, a lock icon will be shown, as shown in the following screenshot:
[image: How to do it...]
Next time you try to open this document, you will be asked to type in your password.
If you, or someone else, tries to disable password protection by unchecking the Require password to open option in Document Inspector, you will see the window asking you to type in the password. The same will happen if you want to change the password.
If you use the keychain for your passwords, click to select Remember this password in my keychain, in the password prompt.

How it works...



Note that there wasn't a password option for iWork versions before '09.

Passwords
 can be a
 combination of numbers and letters, in lowercase or capital. Special keyboard characters can also be used. Passwords where letters, numbers, and other characters are mixed are generally stronger.

There's more...



You can set a very strong password, if you have very sensitive documents or simply for fun.
In the Password dialog window, click on the key icon to open the Password
Assistant window. Choose Memorable from the first drop-down menu. This option automatically generates password suggestions, and the green Quality bar shows password strength. Drag the Length slider to increase or decrease the number of characters in your password—the longer the stronger.
[image: There's more...]
Copy and paste the 
combination you like into the password dialog windows—Password and Verify. Then, click on Set Password to save. But make sure that you remember your password, otherwise you may not be able to open your own spreadsheet!
[image: There's more...]
If you export your Numbers documents to PDF, you can set password security for the PDF files too.
In the screen-top menu, choose Share | Export and click on PDF. The PDF Export dialog has Security Options. Click on the arrow to open the options and check the Open Document checkbox to make the document password-protected from an unauthorized person opening it. Check the Print document checkbox to ask for a password when printing. Check the Copy content from the document checkbox to stop anyone from copying the PDF without a password. Click on Next... to finish exporting the PDF.
[image: There's more...]

See also



	The Hiding columns instead of deleting them recipe
	The Opening the Excel documents in Numbers, editing them, and exporting them back into Excel recipe in Chapter 3, Working Across Platforms and Applications




Adding pictures to cells



We can import photos to Numbers documents in the same way as into other iWork applications. The tools for editing photos and other graphic images are also the same.
In this recipe, we will see how to 

add pictures to cells in tables. Photos in cells not only enliven Numbers documents, they also serve practical purposes. You may want to include portraits of your team members when you put together a document with their addresses and phone numbers, for example. If you compile a home inventory, you can dedicate a column to photos of the items in your house, including valuable paintings and antiques, or even book covers and disc jackets. In fact, insurance and art agents often insist that photos should be included in such documents, to help identify the items in case of loss, accident, or theft.
Getting ready



Open the Home 

Inventory template in Numbers and go to the Insurance
Inventory sheet (click on it in the side pane of the Numbers document). We will be using the Inventory table in this demonstration.
[image: Getting ready]

How to do it...



To add photos to cells in a Numbers table, follow these steps:
	Click on the photo you want to add to the table and hold.
	Drag it to the Numbers document and slide it over the cell where you want to place it.
	When the cell shows a blue outline, let go; the photo will be placed inside the cell.
	To switch from Finder (desktop) or iPhoto, or from wherever your photo is, to Numbers, click in the Numbers document, and then go to Graphic Inspector.
	In Graphic Inspector, set how you want the photo to be displayed in the cell. Under Image Fill, choose Scale to Fill, if you want the whole of the cell to be filled (but with parts of the photo cropped) or Scale to Fit to display all of the photo, in which case parts of the cell may be left blank.[image: How to do it...]




How it works...



When you drag 

the photo over the Numbers document, the cursor will show a green button with a white cross. This means that the document is ready to import the photo. Drag the photo to the table and over the target cell. When the cell shows a blue outline, it is ready to import the photo.
To change the photo in a cell, simply drag the new one onto it. The new photo will replace the existing one.
[image: How it works...]
To scale your 

image, you can also select Image Fill in the Cell Background drop-down menu under Table Inspector and select Scale to Fill or Scale to Fit under the drop-down menu below Image Fill.

There's more...



There are several ways in which a photo can be imported to iWork documents and placed within the document. You can navigate to Media Browser | Photos. This shows images in iPhoto and Photo Booth. Photos inside any folder, including desktop, can be added to Media Browser.
If you want one, several, or all of your photos to be displayed larger, increase the size of one or more cells.
To increase the size of one cell, click in the table so that it shows the reference tabs. Slide the cursor over the line separating the tabs. When the cursor turns from an arrow into a horizontal bar crossed with a double-headed arrow (see the following screenshot), click, hold, and drag it down. The cell will grow vertically when you click between the row tabs and horizontally when you drag on the column tabs.
[image: There's more...]
To increase the size of all cells, go to Cells Inspector and increase the value in the Row Height and Column Width fields by clicking on the arrows:
[image: There's more...]

See also



	The Placing, cropping, editing, moving, and resizing photos recipe in Chapter 5, Working with Photos: Tips and tricks




Using color coding—changing table row colors and setting cells to change color automatically



A good 

spreadsheet must be easy to navigate. Spreadsheets may contain hundreds, or even thousands, of entries. We don't want to get lost in numerous columns and rows when we need to find information quickly. Using color coding is one way of making spreadsheets easier to read.
Numbers has numerous tools to add colors to table grids. We can set colors for cells, columns, rows, table borders, and of course, text.
This recipe describes, first, how to set alternating colors for table rows and columns. This makes tables more reader-friendly because you are less likely to veer off the row or column you are following, this way.
Then, we will look at how to set a strong color for a row or a column that is different from other colors in the table. This can be used for an alert or a reminder concerning data in that row.
And finally, we will see how to use a clever tool that makes cells automatically change the color of text and background, in a selected group of cells, at a set date.
Getting ready



We will be 

using the Event Planner (Sally's Wedding) template for demonstration purposes. Open it from File | New for Template Chooser. It has several tables—Guest List, Budget, and Task List—which will help us to demonstrate the techniques described.

How to do it...



Follow these steps to give the table grid alternating colors:
	Select the Guest List table. Click on it while pressing Shift. It will show square handles like any selected object in iWork:[image: How to do it...]

	Go to Table Inspector. Under Cell Background, select Color Fill from the drop-down menu. Check the Alternating Row Color checkbox:[image: How to do it...]

	Click on the large rectangular color well to select the color for the first row in the table grid. When the Colors Viewer opens, click on the Cantaloupe color in the crayons box.
	For the second color, click on the smaller color well that looks like a tab and choose Banana in the crayons box.


Now the table has bright alternating colors.
Next, select the Budget table.
[image: How to do it...]
To add a 

color to one or several rows in the table, follow these steps:
	Click anywhere in the table. This will show reference tabs—numbers for rows and letters for columns.
	Select rows 5 and 8. Click on reference tab 5, press Command, and click on reference tab 8.
	Go to Table Inspector, and under Cell Background | Color Fill, click in the large color well (window).
	When the Colors Viewer opens, click on the pink crayon (Salmon) in the box of crayons. Both row 5 and 8 will turn pink.


Keep the rows colored as a reminder to finish the task—confirm the costs, add a name or address, fill in blank cells, and so on. In this example, organizers may want to check or renegotiate the costs of the highlighted items. Change back to how it was when the task was finished.
Setting cell colors to change on a certain day can help in drawing attention to or quickly identifying areas in our documents that correspond to tasks that need urgent action or special attention. We can use this technique, for example, to remember to send out reminders to clients to pay bills after 30 days or to remind us to pay our own. We can enter a date to submit tax returns, renew a license or passport, take the car for servicing, and so on.
Now, we will use the Task List table from the Event Planner template. In this example, we assume (for demonstration purposes) that today is May 10, 2012. However, you need to use current dates when you follow the steps discussed here, as your spreadsheet is synchronized with your computer's clock.
To set cell colors to change, do this:
	Click on the Task List table. It will show reference tabs.
	Click on reference tab B to select column B.
	Go to Cells Inspector, click to open the drop-down menu under Cell Format, and choose Date and Time.
	Click on the Date tab to open the drop-down menu and choose a date display format, for example, 05/08/12 for day, month, and year. For Time, choose None.[image: How to do it...]

	For column B, in rows 2 to 7, type in the following dates: 	B2: March 3, 2012
	B3: June 7, 2012
	B4: May 9, 2012
	B5: April 12, 2012
	B6: March 20, 2012
	B7: February 14, 2012


In the template, this column already has dates. Type anything inside the cell to see the effect of the rule applied to cells with dates.

	In Cells Inspector, click on the Show Rules button to open the Conditional Format control panel:[image: How to do it...]

	In the Conditional Format panel, click on the first tab and choose With dates from the drop-down menu to apply the rule to all cells that contain dates.
	Click on the second tab and choose before.
	In the window, type 30.
	From the drop-down menu to the right of the window, choose days.
	In the last drop-down menu, choose ago.
	To set a different color for text (dates) in cells with date and time format, click on the Edit button to open text and background options.
	Then, click in the color well (tab) next to Text and choose a shade of red from the color palette. Text will change to this color when 30 days from the date in the cell have expired.
	For the cell background, click in the color well next to Fill and choose a shade of blue. The background color will also change after 30 days.[image: How to do it...]



These rules will be applied automatically—cells in the table change as soon as you make your choices. We can see that dates older than 30 days from today's date have changed to red and the cells' background has changed to blue, which reminds us to take appropriate action, such as sending out reminders, paying bills, and so on.

How it works...



Depending on 

what you want to do with a table, you can select it without showing reference tabs for rows and columns. Press Shift and then click on a table. This selects the table without showing reference tabs. Small square handles will be shown as they are shown on any selected object in iWork. Drag them to resize the table. If you click on a table without pressing Shift, it will show reference tabs and you can start working with cells, rows, and columns.
To select a row or a column, click on the corresponding reference tab. To select several rows or columns, press Shift when clicking, but this will also select adjacent rows. For example, if you click on row 2, press Shift, and then click on row 5, all rows from 2 to 5 will be selected. To select only rows 2 and 5, press Command when clicking on the rows or columns that you want to select.
The Conditional Format control panel allows several different rules to be applied. Think through your tasks, decide what you want your spreadsheet to do for you, and then decide what rules to set up to help you with this task.


Using clip art and photos in charts—the unbeatable visual effect of Numbers documents



The visual power of Numbers documents has been much praised by both users and commentators since the application was added to the iWork suite.
In Numbers, we can place graphic images inside and alongside spreadsheet tables. When we use graphics, the basic principles of working with them—resizing, editing, cropping, masking, and so on—are the same as in other iWork applications.
Photos and other graphics can be added to cells and charts. This recipe describes how to build clip art and photos into 


Numbers charts.
Getting ready



Prepare two spreadsheets based on the Science Lab template. We will add clip art to one and use photos with the second.
[image: Getting ready]
[image: Getting ready]
Open the Science Lab 


template via File | New from Template Chooser. In the Sheets pane, on the left of the document, under Summary, double-click on the title of the table and type over it to change to Average Salary (US dollars), for this demonstration:
[image: Getting ready]
Click on table cells and 


change the headings of the columns and rows. The header row will show age groups, and the two rows below the header row will show data for men and women. Leave the data as it is in the template, as we are only using this for demonstration purposes. The chart below the table shows columns. Their height is linked to data in the table.
For our second demonstration, open another Science Lab template. Change the title of the table to Quarterly Sales (tons). Click on table cells, and in the header row, type VARIETY, QUARTER 1, QUARTER 2, QUARTER 3, and QUARTER 4. Type RED APPLES in the first row for data and GREEN REINETTE in the second. Replace the template photo above the table with one of your choice. Here, it is a photo of apple blossoms. Again, this is just for demonstration purposes.
[image: Getting ready]
Find simple clip-art


 images of a man and a woman, or draw them yourself with iWork's Draw tool (refer to Chapter 7, Graphic Design: Making Your Own Logo). They should have, roughly, the same dimensions and similar proportions, but they don't have to be exactly the same. Store the images on your desktop.
Find two photos of apples, green apples in one and red apples in the second (for example, McIntosh apples, after which Apple Macintosh computers were named). Store the photos on the desktop.
[image: Getting ready]

How to do it...



First, we will see how to put clip-art images into the chart with columns, and then we will put photos into a pie chart based on the same data.
First demonstration



To incorporate clip art images




 into a chart, follow these steps:
	Click on the chart to select it. It will show square handles.
	Click on any of the green columns in the chart. This will automatically select all columns in the chart. When selected, the columns will show two small circles at the top and bottom.
	Go to Graphic Inspector, click on the drop-down menu under Fill, and choose Image Fill.
	On the Desktop, click on the clip art image of the man and drag it to the image well (window) in Graphic Inspector. The image will appear in all columns of the chart.
	Click on the image-scaling tab below the Image Fill tab, and choose Scale to Fill from the drop-down menu. At this point, you will see that the size of the man in the chart proportionally corresponds to the data contained in the spreadsheet table.[image: First demonstration]

	Next, click on any of the beige columns to select all the beige columns in the chart.
	In Graphic Inspector, choose Image Fill under Fill. The image well will show the clip-art image of the man—the last imported image. Click on the clip-art image of the woman on the desktop, and drag it to the image well in Graphic Inspector. The image of the woman will appear in all the beige columns.
	Click on the image-scaling drop-down menu below Image Fill and choose Scale to Fill. Then save the settings.


Instead of color columns, the chart now presents the data as graphic images. The sizes of these images correspond to data in our spreadsheet, which creates a striking effect.
[image: First demonstration]

Second demonstration



To incorporate




 photos in a pie chart, we will use the second sheet that shows sales of green and red apples. Follow these steps to create a photographic pie chart:
	Click on the chart to select it.[image: Second demonstration]

	Go to Chart Inspector, click on the chart type chooser icon and select the 2D pie chart. The column chart in our document will be replaced by a pie chart. The chart will have two segments representing the share of each of the two types of apples, based on data in the last column of the table. Keep the chart selected before going on to the next step.
	Click on the photo of red apples on the desktop and drag it to the chart. When the chart is ready to import the photo, it will show a thick blue frame, and the arrow of the cursor will show a green button with a white plus sign. Drag the cursor to the corresponding segment in the chart and let go. The photo will fill the segment.
	The chart at this point is still selected in your document. Click on the segment that we have just filled with the photo, to select it, and go to Graphic Inspector to choose Scale to Fill from the drop-down menu below Image Fill.
	Repeat the procedure to place the photo of green apples in the second segment in the pie chart. Then, save the settings.[image: Second demonstration]



The 




document will now have a sheet with detailed figures of quarterly sales of the two types of apples and a chart that visually supports the data.


How it works...



When choosing charts for your project, bear in mind that the 2D option works better with clip-art images. While 3D charts look more attractive, they may not be as easy to fill with images. But it is always worth trying different types of charts and scaling options to see what works best for your project.
In our example, we used the Scale to Fill option for clip art and photos. Scale to Fill keeps the proportions of the image, but parts of the image may be lopped off where it represents smaller numbers. If you don't like this, you could use the Stretch option.
[image: How it works...]
All of the graphic image will show in the chart, but its proportions will be distorted—it will be squat when showing smaller numbers and stretched upwards for bigger numbers. The visual impression will still give a clear representation of the data.
Choose 


which option is better suited to your project. But remember that the scaling option must be the same for all images or photos in the chart, either Scale to Fill for all, or Stretch.
When filling the pie chart with photos, we don't need to select the segments where the photos go. It's enough to select the chart and then slide the cursor over the destination segment. But when we change image scaling, the segment must be selected, only then can we apply one of the options, for example Scale to Fill from the drop-down menu.

There's more...



When we use 2D Charts for additional visual impact, we can add a line to columns and segments. For this, navigate to Stroke | Line. The width of the line and its color can be changed in 


Graphic Inspector.
[image: There's more...]
3D charts have striking additional effects, such as multidimensional rotating. When you choose a 3D chart in Chart Inspector, the chart will show a black control panel in the document. The same control panel is also present in the Chart Inspector. Drag vertical and horizontal arrows to rotate the chart in three dimensions. In Chart Inspector, next to the 3D control panel, there is the Chart Depth slider. Drag it to make the pie look thicker or thinner.
Click on the Chart Colors tab in Chart Inspector to choose colors for 2D charts. For 3D Charts, Chart Colors has a spectacular collection of texture fills, which includes wood, metal, marble, and silk. Select a column or segment in the chart, then choose a texture fill, and click on Apply.
The Explode



option in Chart Inspector allows us to set apart one or several segments in the pie chart. Set the distance in percentage points. You can also select a segment and drag it out of the pie chart manually.
[image: There's more...]

See also



	The Placing, cropping, editing, moving, and resizing photos recipe in Chapter 5, Working with Photos: Tips and Tricks
	The Masking versus Image Fill—When Image Fill is easier than Masking recipe in Chapter 5, Working with Photos: Tricks and Tips
	The Drawing a human shape and turning it into a logo recipe in Chapter 7, Graphic Design: Making Your Own Logo
	The Copying and pasting from Numbers to Pages recipe in Chapter 1, Lateral Thinking




Chapter 12. Keynote Uncovered: a Few Techniques



In this chapter we will cover:
	Adding text to Keynote slides
	Placing and editing photos in Keynote slides
	Copying Keynote slides into Pages and Numbers
	Adding audio files to slideshows
	Making QuickTime movies from Keynote slideshows


Introduction



Keynote is a much-loved application with a huge number of fans throughout the world. Its main attraction is its striking graphics and animation effects.
This chapter is mainly for those who are unfamiliar with Keynote but may be using Pages or Numbers without realizing that some of their work may be better presented in Keynote, be it a condensed, bullet-point summary of a long academic work or a clear presentation, with charts and graphs from a complex spreadsheet.
If the main unit of a document is the page in Pages and the spreadsheet in Numbers, in Keynote, it is the slide. Each slide has a themed (graphically designed) canvas—the space where textboxes, shapes, and images are placed. It is enough to simply understand this, in order to start using Keynote. While we may have to spend some time learning to use animation effects, the main set of tools for working with text and images is the same as in other iWork applications.
Recipes in this chapter are designed for those who are reticent about giving Keynote a try and may even doubt that there is any point doing so. But once you've discovered the possibilities and fun of Keynote, you'll be hooked. Indeed, the restrictions of the slide—where text has to be presented in short clear chunks and graphics must be easy to grasp—may improve your efficiency when working in other applications.


Adding text to Keynote slides



In Keynote, we cannot type text straight into an open document, like we do in the Word Processing mode of Pages and other word processing applications. We need to create Text Boxes or type our text into predesigned boxes in master slides. In blank slides, we place textboxes on an empty space called
canvas. The technique is similar to the Page Layout mode in Pages and the canvas in Numbers.
If you are 
comfortable with writing your text in Keynote documents, that's fine. But, there's a good chance that you will be preparing a presentation based on a longer text that you or someone else has prepared in a word processing application.
In this recipe, we will look at techniques that make it easier to import chunks of text into a Keynote project.
Getting ready



Open a Keynote document and select the 
Blackboard theme. Choose "title" and "subtitle" from the Masters menu—it has two predesigned Text Boxes. Have a chunk of text ready to follow the steps in this recipe. It could be a modified extract from Cicero's Lorem ipsum that is often used for demonstration purposes.

How to do it...



Here are the steps to follow to add text to a Keynote document:
	To type in a Keynote Text Box, click on it and start typing. The default text in the box says Double-click to edit, but you don't have to double-click when you first type in your text. Double-click when the box is not selected and you want to go back to it and change what you've typed.[image: How to do it...]
As you type, your text will be in the font that is preset for the present theme. In our example, it is Regular Chalkboard, 36 points. The text also follows the preset formatting. Here, it is centered and aligned to the bottom of the box.
If you want to change the font or formatting, highlight your text and use the drop-down menus in the Format bar. This is shown under the main document toolbar when you are working with text. Some additional features are available in Text Inspector, for example, space between paragraphs and inset margin (the space between the text and the edge of the box).

	To paste text into a Text Box in Keynote, press Command and type V. This keyboard shortcut is the same as in other iWork applications. However, pasted text will retain the formatting it had in its original document.
	To paste text into a Text Box in Keynote and immediately change its format to the one set for the Keynote theme, use the Paste and Match Style option from the Edit menu or use the keyboard shortcut Command + Option + Shift + V. This may look like a lot of keys to press at the same time, but in fact, it's quite easy with the thumb, the ring finger, and the little finger.[image: How to do it...]

	To create a new Text Box and paste text into it in one go, click anywhere in the slide, away from any existing Text Boxes, and copy and paste (Command + V) the text. This will create a new box filled with copied text.



How it works...



Text Boxes in Keynote behave differently from Text Boxes in Pages. They automatically grow to accommodate more text as you type, whereas in Pages they don't—they only show that there is an overflow of text with a plus sign on the bottom handle.
When you delete text in a Keynote Text Box, the box becomes smaller.
This is handy when you write original text in Keynote Text Boxes. If you want to use your own formatting, especially if there is a lot of text to put into the slideshow, consider preparing text in Pages and then pasting in Keynote. If there is too much text, break it to spread over several slides.

See also



	Chapter 2, Working with Text




Placing and editing photos in Keynote slides



Keynote has a wide selection of attractive themes. Having chosen one, we add master slides—predesigned slides with Text Boxes and image placeholders. When you add your own image to the placeholder, Keynote automatically adjusts its size to the size of the placeholder. Frame style and color are also retained.
However, the 


preset design of slides is only the starting point. We can easily change the way our photos are displayed in the Keynote slideshow. This recipe describes how to add photos to placeholders and further edit them—resize, crop, and move them around.
Getting ready



Prepare a photo to place in your project. It could be in iPhoto or on the desktop. To get a better idea of how Keynote works, we will see an example of a photo with a vertical (portrait) composition and a horizontal (landscape) image placeholder in the slide.
In Keynote, open a new document by selecting New from Theme Chooser under the File menu. Choose the Linen Book theme, and from the Masters drop-down menu, choose the Photo-Horizontal master slide to add to your document. It has an image of euro coins that is set as a media placeholder. In iWork, media placeholders allow for adding and replacing new images and other media files without having to do additional work on style, size, or position in the document—that is, the imported image takes all the settings of the placeholder.
[image: Getting ready]

How to do it...



To place a photo into a 


Keynote slide, perform the following steps:
	Click on the photo you want to add to your project, and drag it to the Keynote slide. As you drag, the icon of the photo file will show as though hanging on the tip of the cursor.
	When you reach the Keynote slide, the cursor will change into a green button with a white plus sign and black arrow. Move the cursor over the placeholder in the slide. Its border will change color to blue. Let go and your photo will replace the placeholder image. Because the photo is vertical, parts of it will automatically be masked inside the horizontally composed placeholder.[image: How to do it...]

	To change which parts of the photo should be shown in the document, click on the black Edit Mask tab. Hidden parts of the photo will be shown as a semi-transparent image.
	Move the cursor to the photo. It will turn into a small white hand. Click and hold—the hand will make a grabbing movement. Now, we can move the photo around within the mask to show the details that we want displayed.
	To show just a small detail of the original photo, we can enlarge it by dragging its handles, which show after we've clicked on the Edit Mask tab. As we enlarge the photo, a smaller section of it remains visible inside the mask and the rest is hidden. If the detail you want displayed also disappears, click on the photo again. The grabbing hand will be shown; move it so that the detail you want displayed is within the mask.
	When finished, click on the Edit Mask tab again to hide the masked part of the image.
	If you want to resize the masked image, click on any of the white square handles and drag. If you want to move the image within the slide, click on it and drag to the desired position.



How it works...



Keynote takes the most popular graphic file formats, including JPEG, PDF, PNG, TIFF, and EPS. Note, however, that when the photo is larger than the slide in which you place it, Keynote is set automatically to reduce the image to fit the slide, which means it will have fewer pixels than the original photo. This may affect the quality of the image when the slideshow is shown on larger screens.
This image reduction is a default setting. You can change it in Keynote preferences. In your screen-top menu, go to Keynote | Preferences | General and uncheck the Reduce place images to fit on the slides option.
If you know that you will be changing the size of your images, you may want to convert them to PDFs so that they don't lose their quality when resized. Graphic files can be converted to PDF format in Preview. Open your file in Preview, type Command + P, and click on the PDF button at the bottom left of the Print dialog. Choose Save as PDF from the drop-down menu. If you have Adobe Acrobat installed on your computer, you will have more options, including Save as an Adobe PDF. Adobe Acrobat also gives additional options on the quality level the PDF can be saved at—straight from the menu.
[image: How it works...]

There's more...



In our example, the photo looks as though it is mounted within the linen fabric. In fact, the slightly bulging edges of the photo are the visual effect of iWork graphics. If you want to change the look of the photo, go to Graphic Inspector, and under Stroke, click on the Picture Frame tab to open frame style options and choose a different frame.

See also



	The Placing, cropping, editing, moving, and resizing photos recipe in Chapter 5, Working with Photos: Tips and Tricks
	The Masking photos, and the magnifying glass trick recipe in Chapter 5, Working with Photos: Tips and Tricks




Copying Keynote slides into Pages and Numbers



Text and 


graphics can be copied and pasted into Keynote slides from Pages and Numbers. But what can we take from Keynote to use in Pages and Numbers? One of the most attractive features of this application is its themes, which give slideshows beautifully designed backgrounds.
Background images are in high demand among Pages users and they can brighten up Numbers spreadsheets. But we cannot simply select a theme and copy it.
In this recipe, we will look at how to transfer Keynote themes to other iWork applications, for example Pages, as a PDF.
Getting ready



Open a Keynote document with the Notebook theme. Its background is a representation of a spring-bound notebook with a dark textured cover. Delete the Text Boxes or images if there are any.

How to do it...



To add the image of the notebook cover to a Pages document, perform the following steps:
	Type Command + P to open the Print dialog.[image: How to do it...]

	In the Printdialog, click on the PDF button in the bottom-left corner. This opens a drop-down menu with PDF options.
	Choose any of the PDF export options, for example, Save as PDF. The PDF will be saved to the desktop.[image: How to do it...]

	Drag the PDF to your Pages document.
	The Notebook theme has a horizontal composition, so the exported image is also horizontal. To position it vertically, press the Command key and drag one of the handles of the image to rotate it to a vertical position. Press the Command and Shift keys together to rotate in 45 degree increments. This will help to put the image in a precisely vertical position.
	The Notebook image has a black color band behind the spring. To remove it, click on the Alpha tool icon in the toolbar. When the Alpha tool is active, the cursor turns into a small cross. Drag it carefully over the black color to remove color, and then hit the Return key.
	Click on the Text Box icon in the toolbar, and type in the text you want to put on the notebook cover. 
	Move the Text Box over the cover and change the color of the text to white.



There's more...



The same technique can be used for importing not just backgrounds, but whole slides with images and text. You simply need to decide which application is easier for you to use when creating this part of your project.

See also



	The Copying and pasting from Numbers to Pages recipe in Chapter 1, Lateral Thinking




Adding audio files to slideshows



In Keynote, we can add audio files

 to our slideshows. These might be music or sounds of nature or city life, or our own commentary to go with our slides.
This option can make presentations more efficient and entertaining.
Keynote documents accept QuickTime and iTunes files, including the popular MP3 and MPEG4 formats.
This recipe describes how to add audio files to Keynote documents.
Getting ready



Prepare the audio file to be added to your Keynote project. This might be a single audio file or a playlist.
Note
If you are using audio clips produced by someone else, be sure you have ascertained their copyright status. Many popular melodies, even though we may hear them every day, are protected by copyright. Or we might have bought a CD or downloaded music to iTunes for our personal enjoyment, but copyright may not allow us to use them for public broadcasting or in commercial material.


How to do it...



To add an audio file to your Keynote presentation, follow these steps.
	In our Keynote document, open Inspector, and click on the document icon (first icon on the left).
	In Document Inspector, click on the Audio tab.
	To add an audio file from iTunes, click on the iTunesLibrary button. This opens the Media Inspector.
	In the Media Inspector, click on Audio, find the file you want to add to your document, click on it, and drag it to the Soundtrack well in Document Inspector. As you drag the file, its icon will appear as though hanging at the tip of the cursor. When you reach the Soundtrack well, a green button with a white cross will show on the cursor. This signals that Keynote is ready to take the audio file. Let go, and the file will sit in the Soundtrack window.[image: How to do it...]

	If your audio file is not in iTunes but on your desktop or in another folder, drag it from there. The process is the same, except that you don't need to go through the Media browser.
	In Document Inspector, click on the playing options tab and choose Play Once, if you want the audio to be played only once during the slideshow. Choose Loop to set the audio file to play continuously through the slideshow.
	Click on the play button under the Soundtrack window, and adjust the volume by dragging the Volume slider.
	Save the Keynote document.



There's more...



You can add an audio file to just one slide of the document instead of the whole slideshow. To do this, drag the audio file to the slide itself, and not to the Document Inspector window. The audio file will show in the document as the audio icon, but will not display when the slideshow is being played. To set the audio to play when the slide is displayed, click on the audio icon, go to Build Inspector, click on Build In, and from the Effect drop-down menu, choose Start Audio. Then, click on Build Out and choose Stop Audio from the drop-down menu. When the slideshow moves to the next slide, the audio will stop.
[image: There's more...]
For longer slideshows, we can add not one but several audio files—a playlist. Select several songs in your iTunes library and drag them all to the Soundtrack well in Document Inspector.
[image: There's more...]
Another option is to record yourself while you are working on a Keynote project. This is how to do it:
	Select the starting slide where you want to add your speech.
	In Document Inspector, click on Record under the Audio section.
	Keynote starts the slideshow, but in the top-left corner of the screen there will be a pulsating red button indicating that your Mac is recording your commentary with its built-in microphone. Click on the red button, if you want to pause the recording.
	Keynote automatically synchronizes your commentary with slides. When you are finished with the first slide, click on the current slide to advance to the next slide and continue your commentary.
	When finished, press Escape, which will stop the slideshow and save the document. Click on the Document tab in Document Inspector to check that the slideshow is now set to Recorded under the Presentation field. When you start recording, this option is set to Recorded, automatically.


You can speak for as long or as little as you want to at each slide. Keynote will display each slide with your commentary while the recording is played back. Remember, though, that when you play the slideshow next time, only the slides with recordings will be played; others are skipped. If you want to add recorded commentary only to some slides, record it as a separate audio file and then add to individual slides in the same way as you would add files from the iTunes library.


Making QuickTime movies from Keynote slideshows



A Keynote presentation can be displayed slide by slide (set On Click in the Start Transition field in Slide Inspector), which is perfect for when we speak in front of an audience, for example. Or it can be displayed as a continuous slideshow (set Automatically in the Start Transition field in Slide Inspector), which makes the presentation run like a movie.
To run a Keynote 
slideshow, we need a Mac with iWork installed. However, we can make movies in several popular cross-platform formats, including QuickTime format, from our Keynote documents. QuickTime format is well-established. Movies in QuickTime can be viewed on Mac and Windows computers, and uploaded to popular video sharing sites, such as YouTube.
This recipe describes how to make a QuickTime movie from a Keynote document.
Getting ready



Create a Keynote presentation with a series of graphics, for example, a step-by-step tutorial on drawing a human figure with the iWork Draw tool. In our example, the slides are blank. To create an animation effect in our movie, the Keynote document should have several dozens of slides showing the process in detail. Break sequences of several slides with one or two slides with a Text Box containing a short explanation of each step. Make sure that graphics are roughly the same size and positioned within the slide in such a way that images in adjacent slides superimpose.
[image: Getting ready]

How to do it...



Follow these steps to create a movie from your Keynote presentation:
	Under View, choose Navigator.
	Select all slides. Click on any of the thumbnails in the side pane or on the side pane heading Slides and then type Command + A. All the slides will be highlighted.
	In Slide Inspector, click on Effect and choose Dissolve. Set Duration to 2 seconds:[image: How to do it...]

	Under Start Transition, choose Automatically and set Delay to 3 seconds.
	Save the document.
	Under File, choose Export. When the dialog opens, choose QuickTime (you can choose QuickTime from the Share menu, too):[image: How to do it...]

	In the dialog, click on Playback Uses and choose Fixed Timing, if you want the movie to be played continuously. For fixed timing, set the time in Slide Duration, for example, to 2 seconds.
	Click on Next. This will start the export process to QuickTime. You can sit back and watch how each slide is processed in the Export to QuickTime viewer, or if your presentation is long and heavy in graphics, you can go and make yourself a cup of coffee—the process may take a few minutes.[image: How to do it...]

	After your Mac has done its work, you will have a QuickTime file on your desktop with the .mov file extension. It will have the same name as the Keynote presentation. If you want to change it, click on it once, and when the file name is highlighted, type over it with a new name.
	Test the movie to check if you want to skip some slides or add more. You may also want to resize or move images within slides, so that they superimpose better to create an animated effect. If you think that there isn't enough time for a viewer to read long chunks of text in Text Boxes, either set the duration to be longer in Slide Inspector or break the text into two or more separate sentences and spread it over two or more slides by using Text Boxes.
	You can store your QuickTime movie separately, upload it to your website or blog, or import it to iPhoto, iMovie, or iDVD for further editing with the editing features available in these applications.



How it works...



Keynote Slide Inspector has a number of 3D and 2D effects. Try different ones to find the one that suits your project best. Here, we have chosen Dissolve because it comes closest to creating an animated film (cartoon) effect.
When a Keynote slideshow is exported to QuickTime, the movie includes the animated transitions that you've set in Keynote.
When you choose between Fixed Timing and Manual Advance, think of how your film will be used. Choose Fixed Timing if you are going to play the film in your office reception, in the shop window, or at a trade fair stand. Under Fixed Timing, you can set None or Loop, under Repeat. With None, the slideshow plays once, with Loop, it starts again once it has finished.
Choose Manual Advance instead of Fixed Timing if you want to set your movie for interactive use. Viewers will change slides by clicking on the current slide or on the Play button in QuickTime player controls, or by hitting the Space bar. This will give users time to examine the slides and absorb your tips.
The Slide Duration setting is for determining how long each slide is displayed on the screen. Two to three seconds is usually enough, but play the slideshow to check for yourself, and adjust it if it's too quick or too long.

There's more...



In this example, we've used blank slides and some of the effects that have made Keynote so popular. We can choose a new theme each time we open a new Keynote project. But of course we can add these after finishing the presentation with blank slides.
Select one slide, click on the Themes icon in the toolbar, and choose one theme. It will be applied to just one slide. Select all slides and choose one of the themes, and it will be applied to all slides in the document. You will have to resize and reposition some of the images. You can also add one of the masters—slides that already have a layout with Text Boxes and placeholders for pictures. The pictures we've placed in the blank slides will not be incorporated in the layout. So, if you are thinking of using master layouts, consider choosing your themes and masters at the beginning of the project.
When you import your movie to other applications on your Mac, you can enhance it with additional features available in these applications. For example, in iPhoto, select the movie and then click on the Slideshow button at the bottom of the window.
When the slideshow starts, move the cursor over the lower part of the window and when the slideshow controls are shown, click on Themes to choose how slides have to be displayed. Click on Music to add a tune from your computer, for example, from iTunes. Click on Settings to adjust how the movie is to be played—in a continuous loop or just once, how long each slide is going to be displayed, and whether slide titles are shown or not.
[image: There's more...]
Having edited the slideshow, you can export it again as a QuickTime movie with all the new add-ons saved. In iPhoto, choose File | Export and click on QuickTime.
Under the Share menu, there is an option for uploading a Keynote slideshow straight to YouTube. Choose it, fill in the necessary information in the dialog, and click on Next. You will need a Google or YouTube account to use this option.
Note
When adding music or clips to a movie that is to be shown in public, for example, in your office reception hall, or on YouTube, make sure you comply with copyright laws and regulations.


See also



	The Keynote and PowerPoint—working together recipe in Chapter 3, Working Across Platforms and Applications
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